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1 EinfUhrung

Was ist HP Device Manager?

HP Device Manager (HPDM) ist eine serverbasierte Anwendung, die leistungsstarke zentrale
Verwaltungsfunktionen fir Thin Client-Gerate bereitstellt, auf denen HP-Software ausgefihrt wird. Zu
den Merkmalen von HPDM z&hlen:

e Zentralisiertes Management

e  Task-basierte Thin Client-Verwaltung

e  Unterstitzung fur alle Thin Client-Betriebssysteme von HP
e  Sichere Kommunikationskanale mit Datenverschlisselung

e  Unterstiitzung fir WAN-Umgebung

Ubersicht

HPDM ist als ein System ausgelegt, das auf dem arbeitsteiligen Zusammenwirken zwischen
Konsolen, einem Server und Gatewaykomponenten beruht.

Was ist HP Device Manager?



Abbildung 1-1 HPDM-Ubersicht
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[ HINWEIS: Die Bereitstellung des HPDM-Systems ist sehr flexibel. Weitere Einzelheiten finden Sie
im White Paper zum Thema Bereitstellung unter ftp://ftp.hp.com/pub/hpdm/Documentation/
WhitePapers/.

HPDM Console

Als HPDM Console (oder ,Konsole®) wird die Komponente bezeichnet, welche die
Benutzeroberflache von HPDM bereitstellt und auf einer beliebigen Anzahl von Computern installiert
werden kann. Mehrere HPDM Console-Instanzen kdnnen gleichzeitig mit einem HPDM Server
interagieren.

Die HPDM Console bietet Systemadministratoren folgende Moglichkeiten:
e Details zu jedem kontrollierten Gerat anzuzeigen

e  Gerate in hierarchischen Strukturen zu organisieren

e Remotejob-Definitionen zu erstellen und zu verwalten

e An Geréate Ubermittelte Tasks zu Uberwachen

2 Kapitel 1 Einfihrung


ftp://ftp.hp.com/pub/hpdm/Documentation/WhitePapers/
ftp://ftp.hp.com/pub/hpdm/Documentation/WhitePapers/

HPDM Server

Der HPDM Server ist die Serverkomponente von HPDM, die HPDM Agents (,Agenten*) iber das
zugeordnete HPDM Gateway (das ,Gateway*) steuert.

Als Task-Vorlagen auf dem HPDM Server gespeicherte Tasks kénnen ber das jeweils zugeordnete
HPDM Gateway an jeden HPDM Agent gesendet werden, um die gewlinschten Befehle von diesem
ausfiihren zu lassen.

299

l# WICHTIG: Es darf nur ein HPDM Server im System vorhanden sein.

HPDM Gateway

Ein HPDM Gateway dient als Verbindungsglied zwischen HPDM Agents und dem HPDM Server.
HPDM Agents registrieren sich wahrend des Starts bei dem zugeordneten HPDM Gateway.

Fir spezielle Netzwerkarchitekturen oder den Lastenausgleich kdnnen mehrere HPDM Gateways
erforderlich sein. Eine derartige Konfiguration ist jedoch nicht obligatorisch. In vielen Fallen genlgt es
auch, ein einziges HPDM Gateway zu installieren, um Tausende von Geraten in unterschiedlichen
Subnetzen zu verwalten. In einer einfachen, aus einem Netzwerk bestehenden Umgebung kdnnen
das HPDM Gateway und der HPDM Server auf demselben Computer installiert sein.

‘0> TIPP: Auf dem Computer, auf dem das HPDM Gateway installiert ist, befindet sich in der Regel
auch der von HPDM installierte PXE-Server.

HPDM Agent

HPDM Agent ist eine Softwarekomponente, die auf den Geraten installiert wird, sodass HPDM mit
diesen Geraten interagieren kann. HPDM Agents sind in das Betriebssystem eingebettet, damit
HPDM in der Lage ist, Geréte direkt ohne Andern oder Konfigurieren zu verwalten (HPDM Agents auf
alteren Geraten missen moglicherweise aktualisiert werden).

HDPM Agents empfangen Task-Befehle von einem HDPM Gateway, fihren die Befehle aus und
melden die Ergebnisse zuriick an das HDPM Gateway.
Repositorys

Repositorys dienen zur Speicherung von Task-Nutzlastdateien. Diese Dateien werden von HPDM
Agents entsprechend den vom HPDM Server empfangenen Tasks von Repositorys heruntergeladen
bzw. auf diese hochgeladen. Nutzlastdateien kdnnen unter anderem Folgendes enthalten:

e Gerate-Images

e Imaging-Tools

e HPDM Gateway- und HPDM Agent-Dateien

e  Softwarekomponenten (Add-Ons)

Das Repository-System umfasst folgende Komponenten:

e Master-Repository — Speichert sdmtliche Nutzlastdateien. Es darf nur ein Master-Repository im
System vorhanden sein.

e Kind-Repository — enthalt alle oder einige Nutzlastdateien. Es kdnnen mehrere Kind-Repositorys
vorhanden sein.

e Master-Repository-Controller — Verwaltet die Nutzlastdateien im Master-Repository und
synchronisiert diese mit den Kind-Repositorys gemall HPDM Server-Anforderung. Der Master-
Repository-Controller muss auf demselben Computer wie das Master-Repository installiert sein.
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Repositorys sind als standardmafige Dateiserver implementiert und unterstiitzen folgende Protokolle:
e  FTP (File Transfer Protocol)

e FTPS (FTP Secure)

e SFTP (Secure FTP)

e SMB (Server Message Block)

¢ TIPP: Das SMB-Protokoll dient dem netzwerkbasierten Filesharing. Seine Implementierung in
Windows wird als ,Freigegebene Ordner bezeichnet, die entsprechende Implementierung in
Linux hei3t Samba. Das Common Internet File System (CIFS)-Protokoll ist eine modifizierte
Variante von SMB.

Ein Repository kann entweder ein oder zwei Protokolle verwenden:

e Wenn es nur ein Protokoll verwendet, kann dies ein beliebiges der oben aufgefiihrten vier
Protokolle sein.

e Bei Verwendung von zwei Protokollen muss eines davon SMB sein. SMB ist fir die Image-
Erstellung ohne Zwischenspeicherung in Windows Embedded Standard (WES) erforderlich. Fir
die Erstellung von HP ThinPro- und HP Smart Zero Core-Images empfiehlt sich die Verwendung
eines der anderen drei Protokolle (FTP, FTPS, SFTP), da SMB fiir diese Betriebssysteme nicht
ausreichend unterstitzt wird. Fir alle anderen Tasks kann jedes der vier Protokolle verwendet
werden.

¢ TIPP:  Wenn fir ein Repository zwei Protokolle konfiguriert sind, wird fur die Ausfihrung eines
Tasks zuerst FTP, FTPS oder SFTP ausprobiert, sofern es sich nicht um eine Image-
Erstellungs-Task fur eine WES-Umgebung handelt.

Begriffe und Begriffsbestimmungen

Tabelle 1-1 Begriffe und Begriffsbestimmungen

Begriff Begriffsbestimmung
Gerat Ein Gerat ist ein von HPDM verwaltetes Gerat, zum Beispiel ein Thin Client.
Paket Ein Paket besteht aus einer Beschreibungsdatei und einem Ordner mit Nutzlastdateien. Der

Paketname ist identisch mit dem Verzeichnisnamen, wobei der Verzeichnisname eine beliebige
zulassige Zeichenfolge darstellen kann.

Der Name der Beschreibungsdatei folgt dem Muster Paketname-
Priifsummenzeichenfolge.desc. Die Prifsumme wird aus allen Nutzlastdateien in
alphabetischer Reihenfolge der Dateinamen oder Ordnernamen mit Tiefensuche berechnet.

PXE PXE (Preboot eXecution Environment) ist der Name eines Netzwerkprotokolls, das dazu
verwendet wird, Computer unabhangig von Datenspeichergeraten oder installierten
Betriebssystemen Uber eine Netzwerkschnittstelle zu starten.

HPDM benutzt PXE fir die Extrahierung und Verteilung von Gerate-Images. PXE ist ein
optionaler Mechanismus fiir die Imageerstellung, der optimalerweise bei der remotegesteuerten
Systemwiederherstellung verwendet wird.

Regel Eine Regel ermdglicht es lhnen, die Ausfiihrung von Tasks zu automatisieren. Jede Regel
besteht aus drei Teilen:

e  Filter — Legt fest, auf welche Gerate die Regel anzuwenden ist
e  Trigger — Bestimmt, wann die Regel auszufihren ist

e Vorlage - Legt fest, welcher Vorgang auf den Geraten ausgefiihrt werden soll
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Tabelle 1-1 Begriffe und Begriffsbestimmungen (Fortsetzung)

Begriff

Begriffsbestimmung

Task

Ein Task ist die geplante Aktion zur Ausfiihrung von Task-Vorlagen auf einem Gerat oder einer
Gruppe von Geraten. Ein Task besteht aus einer Vorlage, einem Ausfiihrungszeitplan und
einer Liste von Zielgeraten.

Task-Vorlage

Eine Task-Vorlage (oder Vorlage) ist eine XML-Datei, in der die Konfigurationsédnderungen
oder Software-Updates festgelegt sind, die auf den Geraten auf Veranlassung des
Administrators durchgefiihrt werden sollen. HPDM stellt eine Vielzahl von vordefinierten Task-
Vorlagen zur Verwaltung von Geréaten bereit.

Task-Vorlagen kdnnen mithilfe von HPDM Console-Tools importiert oder exportiert werden.
Neue Task-Vorlagen kdnnen von der HP FTP-Site heruntergeladen und anschlieRend in lhren
HPDM Server importiert werden.

Vorlagensequenz

Eine Vorlagensequenz (oder Sequenz) ist eine Task-Vorlage spezieller Art, die es lhnen
ermdglicht, mehrere Vorlagen zu einer Sequenz zu kombinieren und fir die Ausfiihrung in
einem einzigen Task zu versenden.

Schreibfilter

Ein Schreibfilter ermdglicht Schreibschutz fur ein Laufzeitimage. Indem durch den Schreibfilter
alle Schreibanforderungen an eine separate Festplattenpartition oder RAM umgeleitet werden,
kann der Anschein der Beschreibbarkeit fir das Laufzeitimage aufrechterhalten werden.
AuBerdem kann mithilfe eines Schreibfilters ein Laufzeitimage auf schreibgeschiitzten Medien
wie zum Beispiel einer CD-ROM bereitgestellt werden.

Nach den neuesten Updates suchen

So finden Sie die neuesten Updates fiir Dokumentation und Software:

A Navigieren Sie zur Website ftp://ftp.hp.com/pub/hpdm.

— oder —

Navigieren Sie zur Website http://www.hp.com/support und suchen Sie nach HP Device
Manager (nur Dokumentation).

Nach den neuesten Updates suchen
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2 Einfihrung in HPDM

In diesem Kapitel werden folgende Themen behandelt:

e Systemanforderungen

° Installieren von HPDM

e Verwenden der HPDM Console

° Erkennen von Gerétesystemen

e Anzeigen von Gerateeigenschaften

e Aktualisieren der HPDM Agent-Software auf Geratesystemen

Systemanforderungen

In den folgenden Abschnitten werden die Mindestsystemanforderungen fiir HPDM beschrieben.

Anforderungen far HPDM Server

Tabelle 2-1 HPDM Server — Anforderungen

Komponente Anforderungen

Betriebssystem Windows Server 2003 mit Service Pack 2 (64-Bit)
Windows Server 2003 R2 mit Service Pack 2 (32-Bit und 64-Bit)
Windows Server 2008 mit Service Pack 2 (32-Bit)
Windows Server 2008 R2 mit Service Pack 1 (64-Bit)
Windows Server 2012 (64 Bit)

Software anderer Hersteller ~ Java Runtime Environment Version 6 Update 45 (Paket mit Installationsprogramm)
Eines der folgenden Datenbank-Managementsysteme (DBMS):
e  Microsoft SQL Server 2005 oder hoher

e PostgreSQL 8.3 oder héher (Bestandteil des Installationspakets)

Hardware Pentium® IV oder ein schnellerer Prozessor
1 GB RAM

2 GB freier Festplattenspeicher

Anforderungen fur HPDM Gateway

Tabelle 2-2 HPDM Gateway — Anforderungen

Komponente Anforderungen

Betriebssystem Windows Server 2003 mit Service Pack 2 (64-Bit)
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Tabelle 2-2 HPDM Gateway — Anforderungen (Fortsetzung)

Komponente Anforderungen

Windows Server 2003 R2 mit Service Pack 2 (32-Bit und 64-Bit)
Windows Server 2008 mit Service Pack 2 (32-Bit)

Windows Server 2008 R2 mit Service Pack 1 (64-Bit)

Windows Server 2012 (64 Bit)

Hardware Pentium IV oder ein schnellerer Prozessor
1 GB RAM

2 GB freier Festplattenspeicher

Anforderungen fur HPDM Console

Tabelle 2-3 HPDM Console — Anforderungen

Komponente Anforderungen

Betriebssystem Windows Server 2003 mit Service Pack 2 (64-Bit)
Windows Server 2003 R2 mit Service Pack 2 (32-Bit und 64-Bit)
Windows Server 2008 mit Service Pack 2 (32-Bit)
Windows Server 2008 R2 mit Service Pack 1 (64-Bit)
Windows Server 2012 (64 Bit)
Windows XP Professional mit Service Pack 3 (32-Bit)

Windows 7 Enterprise mit Service Pack 1 (64-Bit)

Software anderer Hersteller ~ Java Runtime Environment Version 6 Update 45 (Paket mit Installationsprogramm)

Hardware Pentium IV oder ein schnellerer Prozessor
1 GB RAM

1 GB freier Festplattenspeicher

Anforderungen fir HPDM Agent

HPDM unterstitzt alle HP Thin Clients innerhalb der EOL + weitere 3 Jahre voll, und alle anderen HP
Thin Clients partiell. In nachstehender Tabelle finden Sie die unterstitzten Gerate.

In der nachstehenden Matrix sind die Geratetypen und Betriebssysteme aufgefiihrt, die von HPDM
4.6 unterstitzt werden. Volle Unterstitzung (Full support, F) bedeutet, dass alle bestehenden und
neuen Funktionen vom HPDM 4.6 unterstiitzt werden. Partielle Unterstiitzung (P) bedeutet, dass alle
bestehenden und neuen Funktionen, mit Ausnahme von Einstellungen und Verbindungen, unterstitzt
werden.

Systemanforderungen



Geratetyp Win XPe WES WES7E WES7P WESS8 WinCE HP HP HP Teradici
2009 (32-Bit)  (32-Bit) (64-Bit) 6.0 ThinPro ThinPro  Smart
4 3 Zero
Core

4320t F F

6360t F F

at7720 P

at7725 P

mt40 F

mt41 F

t310 F

410 F

t410 AiO F

t505 F F F

t510 F F F F F

t5145 P

T5325 =]

t5335 F

t5400 F

t5530 P

t5540 P

15545 P

t5550 F

t56565 F F

t6565z F

t6570 F

t56570e F

t5630 P

t5730 P

t5735 P

T5740 F F

t5740e F

t5745 F F

t610 F F F F F F

620 F F F F F
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Geratetyp Win XPe WES WES7E WES7P WES8 WinCE HP HP HP Teradici

2009 (32-Bit)  (32-Bit)  (64-Bit) 6.0 ThinPro  ThinPro Smart
4 3 Zero
Core
t820 F F F

HINWEIS: Client-Gerate sollten mindestens 10 MB freien Festplatten-Speicherplatz aufweisen.

Anforderungen fiir den Master-Repository-Controller

Tabelle 2-4 Master-Repository-Controller — Anforderungen

Komponente Anforderungen

Betriebssystem Windows Server 2003 R2 mit Service Pack 2 (64-Bit)
Windows Server 2008 R2 mit Service Pack 1 (64-Bit)
Windows Server 2012 (64 Bit)

Hardware Pentium Il oder schnellerer Prozessor
512 MB RAM
2 GB freier Festplattenspeicher
HINWEIS: Die oben genannte Hardware ist die Mindestanforderung fiir das
Master-Repository. Bei einem hohen Aufkommen von Vorgangen, die die
Imageerstellung oder das Kopieren von Dateien beinhalten, empfiehlt HP ein
leistungsfahigeres System mit mehr freiem Festplatten-Speicherplatz zu
verwenden.

Protokoll FTP, FTPS, SFTP oder SMB

Empfohlene FTP-Server anderer Filezilla

Anbieter
Microsoft Internet Information Server (1IS) 6.0 oder hdher
freeSSHd

Netzwerkanforderungen

Tabelle 2-5 Netzwerkanforderungen

Komponente

Anforderungen

Netzwerk

HPDM unterstitzt lediglich IPv4-Netzwerke.

HPDM kann Images von Geraten entweder mithilfe von PXE oder mit Methoden ohne Verwendung
von PXE (die bevorzugte Variante) erstellen. Stellen Sie sicher, dass, sofern eine PXE-basierte
Imageerstellung gewiinscht ist, im Netzwerk keine anderen PXE-Dienste ausgefiihrt werden.

Wenn Sie einen ISC DHCP-Server verwenden, muss dieser mindestens einen Versionsstand von 3.0
aufweisen.
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Anschlussanforderungen

Wenn Sie einen Server hinter einer Firewall verwenden, missen Sie die Ports 1099 und 40002 als
Port-Ausnahmen zu den Firewall-Einstellungen hinzufiigen.

Die Gerat/Server-Kommunikation bendtigt eine Reihe anderer verfigbarer UDP- und TCP-Ports.
Unter ,Portverweis® auf Seite 92 finden Sie eine Liste der erforderlichen Standardports und
benutzerdefinierten Ports.

Installieren von HPDM

So installieren Sie HPDM:

A Fuhren Sie den InstallShield-Assistenten fir HPDM aus, und folgen Sie den Anleitungen auf
dem Bildschirm.

B HINWEIS: Sofern bereits eine frilhere Version einer HPDM-Komponente auf dem lokalen
Computer installiert ist, wird sie vom Installationsprogramm erkannt. In diesem Fall versucht das
Programm, eine Produktaktualisierung durchzufiihren.

Weitere Einzelheiten finden Sie im White Paper zum Thema Installation unter ftp://ftp.hp.com/
pub/hpdm/Documentation/WhitePapers/.

Wenn Sie wahrend der Installation den Setup-Typ Benutzerdefiniert auswahlen, fihrt der HPDM-
Konfigurationsassistent Sie durch einige wichtige Konfigurationseinstellungen:

e  Spracheinstellungen — Wahlen Sie die gewlinschte Sprache fir die grafische
Benutzeroberflache von HPDM aus.

e Ports lberprifen — Bei diesem Schritt vergewissern Sie sich, dass alle Ports des Systems
korrekt konfiguriert sind und dass das System HPDM unterstitzen kann.

¥ TIPP: Wenn Sie den HPDM Server hinter einer Firewall installieren, figen Sie die Ports 1099
und 40002 als Port-Ausnahmen zu den Firewall-Einstellungen hinzu.

Weitere Informationen hierzu finden Sie unter .Portverweis” auf Seite 92.

=~ HINWEIS: Sie missen die Installation nicht stoppen und erneut starten, um Probleme mit
Ports zu I6sen.

e  DHCP-Einstellungen fiir PXE — Wahlen Sie hier aus, ob sich der DHCP-Server auf dem lokalen
Computer befindet oder nicht. Wenn sich der DHCP-Server nicht auf dem lokalen Computer
befindet, missen Sie die Optionen des DHCP-Servers wie auf dem Bildschirm des Assistenten
gezeigt konfigurieren.

e HPDM-Gateway-Konfiguration — Auf diesem Bildschirm sollten Sie folgende Optionen
konfigurieren:

° Server-Adresse — Legen Sie hier die Adresse fest, die von HPDM Gateway fur Meldungen
an HPDM Server. verwendet werden soll. Die Option 1ocalhost funktioniert, wenn sich
sowohl der HPDM Server als auch das HPDM Gateway auf demselben System befinden.
Es hat sich jedoch in der Praxis bewahrt, die tatsachliche Adresse zu verwenden.

° Lokale NIC — Legen Sie hier die NIC(s) fest, tber die das HPDM Gateway Berichte von
Agenten empfangt. Wenn das System nur mit einer NIC ausgestattet ist, muss dieses Feld
nicht ausgefillt werden.

° PXE-Dienst starten, wenn das Gateway gestartet wird — Sie sollten diese Einstellung fir die
meisten Situationen auf Ja festlegen, damit der PXE-Dienst immer dann gestartet oder
angehalten wird, wenn das HPDM Gateway gestartet oder angehalten wird.
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Sowohl bei Auswahl des Setup-Typs Vollstédndig als auch bei Auswahl des Setup-Typs
Benutzerdefiniert missen Sie angeben, ob Sie eine neue HPDM-Datenbank erstellen oder eine
vorhandene verwenden mdchten. Folgen Sie zum AbschlieRen des Vorgangs den Anleitungen auf
dem Bildschirm.

Bei erfolgreicher Installation werden die unten abgebildeten Symbole fir den HPDM Server und das
HPDM Gateway in der Taskleiste angezeigt:

Abbildung 2-1 Taskleistensymbole fir HPDM Server und HPDM Gateway

G0

Ein griines Symbol signalisiert, dass der Dienst ausgefiihrt wird, ein gelbes Symbol zeigt an, dass der
Dienst gerade gestartet oder angehalten wird, und ein rotes Symbol ist zu sehen, wenn der Dienst
angehalten wurde.

B HINWEIS: Mithilfe der Meniioptionen, die beim Klicken mit der rechten Maustaste auf die
Taskleistensymbole angezeigt werden, kénnen Sie die Ausfliihrung der Dienste starten und anhalten
sowie die HPDM Gateway-Einstellungen erneut konfigurieren.

Fir die HPDM Console wird ein Symbol auf dem Desktop angezeigt.

Installieren eines HPDM 4.6 Service Pack

Ein HPDM 4.6 Service Pack kann nur auf einem System installiert werden, auf dem bereits eine
HPDM 4.6 Basisinstallation oder eine vorherige Version eines HPDM 4.6 Service Pack installiert ist.
Wenn nur eine HPDM-Komponente (z. B. HPDM Console) auf einem System installiert ist, dann
aktualisiert ein HPDM 4.6 Service Pack nur die installierte Komponente.

Ein HPDM Service Pack ist kumulativ. Jedes Service Pack umfasst die neuesten Aktualisierungen,
sowie samtliche Updates von friiheren Service Packs. Zum Beispiel brauchen Sie bei einer HPDM
4.6 Basisinstallation nur SP2 anwenden, um die Updates von SP1 und SP2 zu erhalten.

So installieren Sie ein HPDM Service Pack:
A Doppelklicken Sie auf die Setup-Datei und befolgen Sie die eingeblendeten Anweisungen.

Nach erfolgreicher Installation eines HPDM Service Pack wird sich der Produktname in der Liste der
Programme und Funktionen in der Systemsteuerung dndern, um der neuen Service-Pack-Version zu
entsprechen.

Verwenden der HPDM Console

Anmelden bei der HPDM Console

So starten Sie die HPDM Console:

1. Entweder Sie doppelklicken auf dem Windows-Desktop auf das Symbol fir HPDM Console,
oder Sie wahlen Uber das Start-Menu die Optionsfolge Programme > Hewlett-Packard > HP
Device Manager > HP Device Management Console aus.

Das Dialogfeld Log in (Anmelden) wird angezeigt.

2. Geben Sie die Serveradresse fir den HPDM Server lhres Netzwerks ein. Die Adressinformation
kann als IP-Adresse oder Computername eingegeben werden. Wenn sich die HPDM Console
auf demselben Computer wie der HPDM Server befindet, geben Sie 1ocalhost ein.

3. Geben Sie Benutzername und Kennwort ein, und klicken Sie auf OK, um sich bei der HPDM
Console anzumelden.
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[’%’ HINWEIS: Hat die HPDM Console eine andere Version als der HPDM Server, erscheint beim
Starten der HPDM Console eine Warnung.

Ubersicht (iber die HPDM Console

Das Hauptfenster der HPDM Console besteht aus drei Bereichen und einem Satz von
Registerkarten, welche die aktuelle Ansicht bestimmen. Die genaue Anzahl der Registerkarten hangt

von der Anzahl der verschiedenen Betriebssystemtypen ab, die auf den Geratesystemen gefunden
wurden.

Es gibt jeweils eine Registerkarte fir jedes identifizierte Gerate-Betriebssystem, eine Registerkarte
fur nicht identifizierte Betriebssysteme sowie eine Registerkarte fir die HPDM Gateway-Ansicht.

Betriebssystem-Registerkarten

Die Ansicht einer Betriebssystem-Registerkarte weist jeweils folgende Elemente auf:

Abbildung 2-2 HPDM Console—Betriebssystem-Registerkarten
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1 Betriebssystem-Registerkarten — Diese Registerkarten gruppieren Gerate nach Betriebssystem. Es werden

nur Registerkarten fiir die Betriebssysteme angezeigt, die gegenwartig von HPDM verwaltet werden.

2 Gerate-Werkzeugleiste — Ermdglicht schnellen Zugriff auf folgende Funktionen:
e  Senden von Tasks
e  Erkennung von Geraten oder HPDM Gateways
e  Suchen nach einem Gerat

° Drucken von Gerateinformationen

12 Kapitel 2 Einfiihrung in HPDM



3 Geréte-Struktur — Hierarchische Liste aller Gerate, auf denen das ausgewahlte Betriebssystem lauft, sortiert
nach einem benutzerdefinierten Gruppierungsschema

4 Gerate-Bereich — Zeigt die Gerate der in der Geratestruktur ausgewahlten Gruppen (Verzeichnisse) an

5 Task-Bereich — enthélt die folgenden Komponenten:
e Task-Vorlagen, die fiir die im Gerate-Bereich aufgelisteten Gerate angewendet werden kdnnen

e  Ausflihrungsstatus fir manuelle Tasks und Regel-Tasks

6 Statusleiste — Zeigt die Gesamtzahl aktiver Gerate sowie weitere kontextabhangige Informationen an

Registerkarte ,HPDM-Gateway*

Durch Klicken auf die Registerkarte HPDM-Gateway werden Informationen zum aktuell ausgewahlten
HPDM Gateway angezeigt.

Abbildung 2-3 HPDM Console — Gateway-Registerkarte
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1 HPDM Gateway-Registerkarte — Wahlen Sie diese Registerkarte aus, um Informationen tiber HPDM
Gateways zu verwalten oder zu suchen

2 Gateway-Werkzeugleiste — Ermdglicht schnellen Zugriff auf folgende Funktionen:
e  Erkennung von Geraten oder HPDM Gateways
e  Aktualisierung eines HPDM Gateway

e  Konfiguration eines HPDM Gateway

3 Gateway-Struktur — Hierarchische Liste aller HPDM Gateways
4 Gateway-Bereich — Auflistung der HPDM Gateways
5 Ubersichtsbereich — Zeigt Einzelheiten zum gegenwartig ausgewahiten HPDM Gateway an
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6 Task-Bereich — Auflistung der fir den gegenwartig ausgewahlten HPDM Gateway spezifischen Task-Status

7 Statusleiste — Zeigt die Gesamtzahl aktiver HPDM Gateways an

Erkennen von Geratesystemen

In der Regel kann das HPDM Gateway die meisten Gerate erkennen, indem es den Netzwerkverkehr
auf Broadcast-Nachrichten Gberwacht, die von Geraten beim Starten versendet werden. Diese
L&sung setzt voraus, dass das HPDM Gateway bereits aktiv ist, wenn das Gerat gestartet wird.
Weitere Informationen zu diesem und anderen Verfahren fir das Hinzufiigen von Geraten zur HPDM-
Inventardatenbank finden Sie unter ,Gerateerkennung® auf Seite 17.

Anzeigen von Gerateeigenschaften

HPDM speichert die Inventardaten zu allen verwalteten Geraten. Wenn ein Geréat sich beim HPDM
Server registriert, gibt es nur die nétigsten grundlegenden Inventardaten weiter, so dass es individuell
erkannt werden kann und HPDM mit dem Gerat kommunizieren kann. Sie kénnen diese
Informationen anzeigen und exportieren.

Grundlegende Inventardaten

So zeigen Sie die grundlegenden Inventardaten eines Gerates an:

A Doppelklicken Sie auf ein Gerat im Gerate-Bereich, um das Fenster Device Properties
(Gerateeigenschaften) zu o6ffnen.

Dieses Fenster enthalt verschiedene Seiten, die unterschiedliche Kategorien von Inventardaten
enthalten. Wenn nur die grundlegenden Inventardaten verfiigbar sind, enthalten nur die Seiten
General (Allgemein), Agent und Grouping (Gruppieren) Informationen.

Grundlegende Inventardaten kénnen zum Filtern und Gruppieren lhrer Gerate verwendet werden. Sie
koénnen auf der Seite ,Grouping” (Gruppieren) benutzerdefinierte Gruppierungsinformationen
festlegen.

In den folgenden Tabellen sind die grundlegenden Inventardaten, die auf den Seiten ,General*
(Allgemein) und ,Agent” zur Verfigung stehen, aufgelistet.

Tabelle 2-6 Grundlegende Inventardaten (General (Allgemein))

Element Beschreibung

Gerate-ID Die individuelle ID, die HPDM dem Gerat zuteilt. Die Gerate-ID ist die erste MAC-Adresse, die auf
dem Gerat gefunden wird.

Hostname Der Hostname des Geréts.

Geratetyp Der Modellname des Geréts.

Seriennummer Die Seriennummer der Gerate-Hardware.

Betriebssystemtyp Der Name des Betriebssystems auf dem Gerat.

Gerateversion Die Image-Version des Betriebssystems auf dem Gerat.

BIOS-Version Die BIOS-Version des Geréts.

Bestandskennzeich- Die Inventar-Kennung des Geréts.

nung
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Tabelle 2-6 Grundlegende Inventardaten (General (Allgemein)) (Fortsetzung)

Element

Beschreibung

Sie haben TPM-
Module

Zeigt an, ob das Gerat ein Trusted Platform Module (TPM) hat. Ein TPM (Trusted Platform Module)
ist ein sicherer Krypto-Prozessor, der Kryptografieschliissel speichern kann, die Informationen
schutzen, und wird oft auch als ,TPM-Chip* oder ,TPM-Sicherheitsgerat* bezeichnet. Software
kann sich TPM zu Nutze machen, um Hardwaregerate zu erkennen. Aktuell haben einige HP Thin
Client-Modelle wie z. B. t610 einen TPM-Chip eingebaut.

Sie haben einen TPM-
Eigentimer

Zeigt die Besitzrechte des TPM an. Die Besitzrechte des TPM mussen vergeben sein, bevor TPM
dazu genutzt werden kann, einen Computer zu sichern. Der Besitz eines TPM wird festgelegt,
indem TPM ein Kennwort zugewiesen wird, so dass sichergestellt wird, dass ausschlieRlich der
autorisierte TPM-Besitzer auf das TPM zugreifen und es verwalten kann. Es gibt nur ein Kennwort
pro TPM, weshalb jeder, der das Kennwort kennt, der Besitzer des TPM ist. Sobald ein Besitzer
festgelegt wurde, kann kein anderer Benutzer oder eine andere Software die Besitzrechte lber das
TPM fiir sich beanspruchen.

Tabelle 2-7 Grundlegende Inventardaten (Agent)

Agent Version (Agent-
Version)

Die Version des HPDM Agent auf dem Gerat.

HPDM Gateway-ID

Die MAC-Adresse des HPDM Gateway-Systems, das zur Kommunikation mit dem Gerat
verwendet wird.

Agent Working Mode
(Arbeitsmodus des
Agent)

Zeigt an, ob das HPDM Gateway in der Lage ist, Tasks an das Gerat zu senden (Push-Modus),
oder ob es warten muss, bis der HPDM Agent Tasks vom Gateway abruft (Pull-Modus). In einigen
Umgebungen, beispielsweise Umgebungen, in denen Gerate durch eine NAT von ihrem HPDM
Gateway-System getrennt und daher flr dieses nicht adressierbar sind, muss der HPDM Agent
Tasks vom Gateway abrufen.

Agent Pull Interval
(Abruf-Intervall des
Agent)

Zeigt an, wie oft der HPDM Agent versucht, Tasks vom HPDM Gateway abzurufen.

First Contact Time
(Zeitpunkt des
Erstkontakts)

Datum und Uhrzeit der Registrierung des Gerats bei HPDM.

Last Time Online
(Zuletzt online)

Datum und Uhrzeit der letzten Kommunikation zwischen HPDM und dem HDPM Agent auf dem
Gerat.

Sammeln von zusatzlichen Ressourceninformationen

Um mehr Informationen zu einem Gerat zu sammeln, miissen Sie einen Task vom Typ Get Asset
Information (Inventardaten abrufen) ausfiihren.

So filhren Sie einen Task vom Typ Get Asset Information aus:

1. Klicken Sie mit der rechten Maustaste auf das Gerat, zu dem Daten gesammelt werden sollen
und wahlen Sie dann Get Device Asset Information (Inventardaten des Gerats abrufen) aus.

2.  Wenn das Fenster fir die Task-Erstellung angezeigt wird, klicken Sie auf OK.

3. Sobald der Task abgeschlossen ist, werden die zusatzlichen Inventardaten im Fenster
Properties (Eigenschaften) des Geréats angezeigt.

Anzeigen von Gerateeigenschaften
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Anzeigen aller Gerate-Inventardaten

Nach erfolgreicher Ausfiihrung des Tasks Get Asset Information (Inventardaten des Geréats abrufen)
werden die folgenden zusatzlichen Registerkarten im Fenster Device Properties (Eigenschaften des
Gerats) mit Inhalt gefullt:

e Software — Zeigt die auf dem Gerat installierten Softwarepakete an.
e Hardware — Zeigt detaillierte Informationen zu CPU, Hauptspeicher und Speichergeraten an.

e Network (Netzwerk) — Zeigt Konfigurationsdaten fiir jeden auf dem Gerat vorhandenen
Netzwerkadapter an.

e Configuration (Konfiguration) — Zeigt Einstellungen fiir die Zeitzone und die Anzeige an.

e Microsoft Hotfix — Zeigt Microsoft Hotfix-Informationen an (diese Seite ist nur fir das
Betriebssystem WES/XPe verfugbar).

e Extended Properties (Erweiterte Eigenschaften) — Zeigt die erweiterten Eigenschaften des
Gerats an.

Aktualisieren der HPDM Agent-Software auf Geratesystemen

Der HPDM Server verfiigt Giber vordefinierte Regeln zum automatischen Aktualisieren der auf
Geratesystemen installierten HPDM Agent-Software auf die neueste Version.

Fur jeden Betriebssystemtyp gibt es eine Systemregel mit einem Starttrigger. Sobald Gerate starten
und dies an den HPDM Server melden, vergleicht die Regel die Version der HPDM Agent-Software
auf dem Gerat mit der Version im Master-Repository. Wenn das Geréat eine altere Version aufweist,
sendet der HPDM Server einen Task zur Aktualisierung der HDPM Agent-Software an das Gerat.

2943

B HINWEIS: Diese Regel ist standardméaRig deaktiviert.
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3 Gerateerkennung

Geréate mussen von HPDM erkannt (d. h. zur HPDM-Inventardatenbank hinzugefiigt) werden, bevor
sie verwaltet werden kénnen. In den folgenden Abschnitten finden Sie Informationen zu
verschiedenen Verfahren zur Gerateerkennung:

Automatische Registrierung (normale Thin Clients)

Automatische Registrierung (PColP Zero Clients)

Suchen nach Geraten

Manuelle Reqistrierung eines Geréats

Manuelle Registrierung mehrerer Gerate

Automatische Registrierung (normale Thin Clients)

Wenn das Gerat mit lnrem Netzwerk verbunden ist, wird vom zugehérigen HPDM Agent mit
folgenden Methoden versucht, das Gerat automatisch beim HPDM Server zu registrieren. Der HPDM
Agent durchlauft diese Methoden in der angegebenen Reihenfolge und wird gestoppt, sobald die
Registrierung erfolgreich ist.

Wenn der Kontakt zwischen dem HPDM Agent und dem aktuell zugeordneten HDPM Gateway
verloren geht oder ein Neustart des Gerats erfolgt, wird der automatische Registrierungsprozess
erneut gestartet und in regelmafigen Intervallen ausgefuhrt, bis die Registrierung erfolgreich ist.

1.

Das Geréat Uberprift die eigene lokale Konfiguration auf Einstellungen bzgl. der Verwendung
eines voreingestellten primaren HPDM Gateways oder Sicherungsgateways. Diese
Einstellungen kdnnen mit den folgenden Schritten konfiguriert werden:

a. Wechseln Sie in den Administrator-Modus (eine Anleitung hierfur finden Sie in der
Dokumentation zum Betriebssystem lhres Geréats).

b. Offnen Sie das Applet HP Agent (HP-Agent) in der Systemsteuerung.
c. Geben Sie die IP-Adresse des HPDM Gateways in das Feld ,Aktuelles Gateway“ein.
d. Kilicken Sie auf OK.

Wenn ein primédres HPDM Gateway festgelegt ist, versucht der HPDM Agent, eine Verbindung
zu ihm herzustellen. Sollte dies fehlschlagen und ist aulRerdem ein HPDM-Sicherungsgateway
festgelegt, wird versucht, eine Verbindung zu diesem Gateway herzustellen. Sollte dies
ebenfalls fehlschlagen, wechselt der HPDM Agent zur n&chsten Methode.

Der HPDM Agent tberprift die DHCP-Lease-Datei des Geréats, um festzustellen, ob das Tag
202 definiert ist. Tag 202 wird als Darstellung der IP-Adresse des HDPM Servers in Form einer
Zeichenfolge gefolgt von einem Leerzeichen und der IP-Adresse des HPDM Gateway
interpretiert.

Wenn beispielsweise der nachfolgende Eintrag fiir das Tag 202 in der DHCP-Lease-Datei des
Geréts enthalten ist, wird der HPDM Agent versuchen, eine Verbindung zum HPDM Gateway
192.168.1.1 herzustellen:

192.168.1.5 192.168.1.1

Automatische Registrierung (normale Thin Clients)
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3. Sofern ein DNS-Server im lokalen Netzwerk des Gerats vorhanden ist, wird eine Anforderung an
das Gerat gesendet, eine DNS-Anfrage zur Auflésung des DNS-Namens hpdm-gateway
durchzufiihren, um die IP-Adresse des HPDM Gateway zu ermitteln.

4. Der HPDM Agent sendet eine Anforderung an die Broadcast-Adresse des zugehdrigen
Subnetzes. Ist ein HPDM Gateway im Subnetz vorhanden, antwortet dieses auf die Broadcast-
Anforderung, und vom HPDM Agent wird eine Verbindung zum Gateway hergestellt.

Automatische Registrierung (PColP Zero Clients)

Verwenden einer DNS Service-Aufzeichnung

HP PColP Zero Clients missen entweder einen statischen Doménennamen haben oder Zugang zu
einem DHCP-Server, um den Domanennamen tber die DHCP-Option 15 oder 12 abzurufen.

Wenn der DHCP-Server nur die DHCP-Option 12 unterstitzt, muss die Hostnamen-Zeichenfolge den
Doméanennamen enthalten.

So erstellen Sie DNS-Service-Aufzeichnungen:
1.  Offnen Sie die DNS-Konsole und wahlen Sie die Zone, die die PColP Zero Clients enthalt.

2. Klicken Sie mit der rechten Maustaste, um das Men(i anzuzeigen und wahlen Sie dann Other
New Records (Andere neue Aufzeichnungen), um das Dialogfeld ,Resource Record Type*®
(Ressourcenaufzeichnungs-Typ) anzuzeigen.

3. Wabhlen Sie Service Location (SRV) (Service-Ort (SRV)) und klicken Sie auf die Schaltflache
Create Record (Aufzeichnung erstellen), um das Dialogfeld ,New Resource Record “ (Neue
Ressourcenaufzeichnung) anzuzeigen.

4. Setzen Sie den Dienst-Wert auf _pcoip-broker (empfohlen) oder _pcoip-tool. Setzen Sie den
Wert bei ,Protocol” (Protokoll) auf _tcp, setzen Sie den Host, der diesen Dienst anbietet, auf den
vollstandig qualifizierten Domanennamen (FQDN) des HPDM Gateway und klicken Sie
anschlieRend auf OK. Klicken Sie auf Done (Fertig).

5. Starten Sie die PColP Zero Clients erneut. Diese melden automatisch an HPDM.

Wenn Sie einen oder mehrere Backup-HPDM Gateways einstellen mochten, fligen Sie weitere
Dienst-Aufzeichnungen (_pcoip-broker oder _pcoip-tool) mit unterschiedlichen Prioritatswerten hinzu.
Ein niedriger Wert bedeutet eine héhere Prioritat. Jede Aufzeichnung weist auf einen HPDM Gateway
hin.

Weitere Informationen zur Einstellung von multiplen DNS-Service-Aufzeichnungen fir einen Dienst
finden Sie unter http://en.wikipedia.org/wiki/SRV_record.

So l6sen Sie Probleme mit diesem Verfahren:

1. Uberpriifen Sie die Netzwerkinformationen, einschlieRlich der IPv4-Adressen und -Domanen der
PColP Zero Clients.

2. Die PColP Zero Clients haben ein integriertes Diagnosetool. Verwenden Sie das Diagnosetool,
um die HPDM Gateway-Adresse in der DNS-Service-Aufzeichnung anzupingen.

Verwenden einer DHCP Vendor-Klassen-Option

So erstellen Sie eine Vendor-Klasse:

18 Kapitel 3 Gerateerkennung


http://en.wikipedia.org/wiki/SRV_record

1.  Offnen Sie die DHCP-Konsole und wahlen Sie dann den DHCP-Server, in dem sich die PColP
Zero Clients befinden.

2. Klicken Sie mit der rechten Maustaste, um das Men( anzuzeigen und wahlen Sie dann Define
Vendor Classes (Vendor-Klassen definieren), um das Dialogfeld ,DHCP Vendor Classes*
(DHCP-Vendorklassen) anzuzeigen.

3. Klicken Sie auf die Schaltflache Hinzufiligen, um das Dialogfeld ,New Class* (Neue Klasse)
anzuzeigen.

4. Setzen Sie den Display-Namen auf PColP Endpoint (PColP Endpunkt), setzen Sie den Wert auf
PColP Endpoint (PColP Endpunkt) und klicken Sie anschlie’end auf OK.

So legen Sie eine Vendor-Klassen-Option fest:

1. Klicken Sie mit der rechten Maustaste auf den DHCP-Server, um das Menl anzuzeigen und
wahlen Sie dann Set Predefined Options (Vordefinierte Optionen einstellen) aus, um das
Dialogfeld ,Predefined Options and Values” (Vordefinierte Optionen und Werte) anzuzeigen.

2. Setzen Sie die Klasse ,Option“ auf PColP Endpoint (PColP Endpunkt) und klicken Sie auf Add
(Hinzufiigen), um das Dialogfeld ,Option Type* (Optionstyp) anzuzeigen.

3. Geben Sie in das Feld ,Name" MC Address (MC-Adresse) ein, setzen Sie den Datentyp auf
String (Zeichenfolge) und den Code auf 1 und klicken Sie anschlieend auf OK.

4. Setzen Sie den Wert von ,MC Address” (MC-Adresse) auf die IP-Adresse des HPDM Gateway
und klicken Sie anschlielend auf OK.

So aktivieren Sie die Vendor-Klassen-Option:

1. Wahlen Sie die Scope Options (Bereichsoptionen) des Bereichs, in dem sich die PColP Zero
Clients befinden.

2. Klicken Sie mit der rechten Maustaste, um das Menl anzuzeigen und wahlen Sie dann
Configure Options (Optionen konfigurieren), um das Dialogfeld ,Scope Options*
(Bereichsoptionen) anzuzeigen.

Wabhlen Sie die Registerkarte Advanced (Erweitert) aus.

4. Setzen Sie die Vendor-Klasse auf PColP Endpoint (PColP Endpunkt), aktivieren Sie die Option
MC Address (MC-Adresse) und klicken Sie anschlief’end auf OK.

5. Starten Sie die PColP Zero Clients erneut. Diese melden automatisch an HPDM.
So I6sen Sie Probleme mit diesem Verfahren:

1. Uberpriifen Sie die Netzwerkinformationen, einschlieRlich der IPv4-Adressen und -Doméanen der
PColP Zero Clients.

2. Die PColP Zero Clients haben ein integriertes Diagnosetool. Verwenden Sie das Diagnosetool,
um die HPDM Gateway-Adresse in der MC-Adresse anzupingen.

Suchen nach Geraten

HPDM kann einen Bereich von IP-Adressen nach HPDM Agents und HDPM Gateways durchsuchen.
Sie haben die folgenden beiden Optionen: Durchlauf mit IP-Bereich und Durchlauf mit IP-Liste. Beide
Suchverfahren beginnen auf dieselbe Weise:

1. Klicken Sie in der HPDM Console auf die Registerkarte HPDM Gateway.

2. Klicken Sie mit der rechten Maustaste auf den gewiinschten HPDM Gateway-Eintrag und
wahlen Sie im MenU Discover Device (Gerat erkennen) aus.
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3. Wabhlen Sie den Geratetyp (normaler Thin Client oder PColP Zero Client).

4. Fahren Sie mit Verwenden der Methode .Durchlauf mit IP-Bereich” auf Seite 20 oder
Verwenden der Methode ,Durchlauf mit IP-Liste” auf Seite 20 fort, je nachdem, welche
Methode Sie verwenden mdchten.

Verwenden der Methode ,Durchlauf mit IP-Bereich®
So suchen Sie unter Verwendung der Methode Walking With IP Range (Durchlauf mit IP-Bereich):

1. Wahlen Sie Durchlauf mit IP-Bereich aus, und klicken Sie auf Weiter>.

2. Sie kénnen den zu durchsuchenden Bereich von IP-Adressen festlegen, indem Sie einen
vordefinierten IP-Bereich auswahlen oder den gewtnschten IP-Bereich manuell eingeben. Ein
vordefinierter IP-Bereich ist ein Bereich von IP-Adressen, den Sie erstellt und fir zukilnftige
Durchlaufe gespeichert haben.

So suchen Sie mithilfe eines vordefinierten |IP-Bereichs:

A Aktivieren Sie das Kontrollkastchen Vordefinierten IP-Bereich verwenden, wahlen Sie einen
IP-Suchbereich aus, und klicken Sie auf OK.

So suchen Sie mithilfe eines manuell angegebenen IP-Bereichs:

A Deaktivieren Sie das Kontrollkastchen Vordefinierten IP-Bereich verwenden, geben Sie
eine Erste IP-Adresse und eine Letzte IP-Adresse ein, und klicken Sie auf OK.

Sie kdnnen den Fortschritt der Gerateerkennung beobachten, indem Sie die Registerkarte
HPDM-Gateways anzeigen und den Namen des HPDM Gateways auswahlen. Der
Erkennungsfortschritt wird dann im Task-Bereich unten im HPDM Console-Fenster angezeigt.

Konfigurieren eines vordefinierten IP-Bereichs
So konfigurieren Sie einen vordefinierten IP-Bereich:

1. Aktivieren Sie im Dialogfeld Erkennung nach Bereich das Kontrollkéstchen Vordefinierten IP-
Bereich verwenden, und wahlen Sie die Option Bearbeiten im Listenfeld IP-Suchbereich aus, um
das Dialogfeld IP-Durchlaufbereich bearbeiten anzuzeigen.

2. Wahlen Sie in der Liste IP-Durchlaufbereiche einen vorhandenen Durchlaufbereich aus, oder
klicken Sie auf Hinzufligen, um einen neuen Bereich zu erstellen.

3. Geben Sie einen von HPDM zu verwendenden Referenznamen fiir den neuen Durchlaufbereich
ein, und klicken Sie auf OK.

4. Legen Sie den Bereich von IP-Adressen fest, den HPDM nach Geraten durchsuchen soll, indem
Sie die Felder Starting IP Address (Erste IP-Adresse) und Ending IP Address (Letzte IP-
Adresse) ausfiillen. Klicken Sie auf Apply (Ubernehmen), um die Einstellungen zu speichern und
klicken Sie zum Beenden des Dialogfelds auf OK.

Verwenden der Methode ,Durchlauf mit |IP-Liste”
So suchen Sie unter Verwendung der Methode Walking With IP List (Durchlauf mit IP-Liste):
1. Wahlen Sie Durchlauf mit IP-Liste aus, und klicken Sie auf Weiter.
Das Dialogfeld Nach Liste erkennen wird angezeigt.

2. Sie konnen die IP-Adressen in der IP-Liste Ihren speziellen Anforderungen entsprechend
anpassen. Beschreibungen der Schaltflachen im Dialogfeld finden Sie in der folgenden Tabelle.
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3.

Schaltflache Funktion

Hinzufliigen Hinzufligen einer neuen IP-Adresse zur IP-Liste.
Léschen Entfernen einer vorhandenen IP-Adresse aus der Liste.
Importieren Importieren einer TXT- oder CSV-Datei in die IP-Liste.
Exportieren Exportieren der IP-Liste in eine TXT-Datei.

Kopieren Kopieren der aktuellen IP-Liste.

Einflgen Einfligen einer kopierten IP-Adresse.

Klicken Sie auf OK, um nach HPDM Agents oder HPDM Gateways zu suchen. Nach Abschluss
der Suche wird ein Bericht mit den von HPDM erkannten Geraten angezeigt. Gefundene Gerate
werden zur HPDM-Inventardatenbank hinzugefigt.

Manuelle Registrierung eines Gerats

So registrieren Sie ein Gerat manuell:

1.
2.

Klicken Sie in der HPDM Console auf die Registerkarte HPDM Gateway.

Klicken Sie mit der rechten Maustaste auf den gewlinschten HPDM Gateway und wahlen Sie im
Meni Device > Add (Gerat > Hinzufiigen) aus.

Geben Sie die Gerate-ID, MAC-Adresse und IP-Adresse des Gerats ein und klicken Sie
anschlielend auf OK.

Das manuell hinzugefiigte Gerat wird auf einer Registerkarte mit der Bezeichnung Unidentified
(Unerkannt) hinzugefugt. Sobald das Gerat Daten an HPDM sendet, wird es auf die Registerkarte
verschoben, die dem zugehdrigen Betriebssystem entspricht.

Manuelle Registrierung mehrerer Gerate

So registrieren Sie mehrere Gerate manuell:

1.
2.

Wahlen Sie in der HPDM Console File > Import Devices (Datei > Gerate importieren).

Klicken Sie auf Select (Auswahlen) und wahlen Sie dann ein Verzeichnis mit Textdateien aus,
die die zu importierenden Gerate beschreiben.

¢ TIPP: Weitere Informationen zur Konfiguration dieser Dateien finden Sie in der

Informationsschrift HP Device Manager 4.6 Aufomated Device Importer (Automatischer Gerate-
Importer des HP Device Manager 4.6).

Klicken Sie auf Import (Importieren), um alle Geréte aus allen Textdateien in diesem Verzeichnis
ZU importieren.

Die manuell hinzugefiigten Gerate werden zu der Registerkarte, die in den Dateien angegeben ist,
hinzugeflugt. Ist keine Registerkarte angegeben, werden die Geréte zu einer Registerkarte mit dem
Namen Unidentified (Unbekannt) hinzugefiigt. Sobald jedes Gerat Daten an HPDM sendet, wird es
auf die Registerkarte verschoben, die dem zugehdrigen Betriebssystem entspricht.

Manuelle Registrierung eines Gerats
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4 \Verwenden von Tasks

Task-Vorlagen

Task-Vorlagen werden in der Registerkarte ,Task Templates" (Task-Vorlagen) im Task-Bereich
angezeigt. Die Vorlagenliste besteht aus sechs sortierbaren Spalten:

Icon (Symbol) — Zeigt an, ob es sich um eine Basisvorlage, eine benutzerdefinierte Task-Vorlage
oder eine benutzerdefinierte Task-Vorlage aus den Favoriten handelt.

Template Name (Vorlagenname) — Zeigt den Namen der Vorlage an.

Description (Beschreibung) — Zeigt den Beschreibungstext der Vorlage an.

Base Template Name (Name der Basisvorlage) — Zeigt den Namen der Basisvorlage an

Category (Kategorie) — Zeigt an, zu welcher Kategorie die Vorlage gehort

Es gibt insgesamt sieben Kategorien bei HPDM:

o

File and Registry (Datei und Registrierung) — Eine generische Vorlage, die aus einer
veranderbaren Kombination aus Tasks zur Verwaltung von Geratebetriebssystemen
besteht (weitere Informationen finden Sie unter Verwalten von Dateien und Registry-
Einstellungen auf Seite 43)

Connections (Verbindungen) — Dient dem Festlegen oder Abrufen der
Verbindungseinstellungen eines Gerats

Agent — Dient der Konfiguration der HPDM Agent-Einstellungen und der Aktualisierung des
HPDM Agent

Imaging (Imageerstellung) — Dient dem Aufzeichnen oder Bereitstellen von Flashspeicher-
Images von Geraten

Operations (Vorgange) — Dient der Durchfiihrung verschiedener Operationen auf einem
Gerét, beispielsweise Neustart, Fernsteuerung, Herunterfahren und Aktivierung per LAN

Settings (Einstellungen) — Dient der Anderung verschiedener Einstellungen auf dem Gerét,
beispielsweise Bildschirm-, Netzwerk-, Uhrzeit- und Schreibfiltereinstellungen

Template Sequence (Vorlagensequenz) — Dient dem Definieren von Sequenzen fiir die
Ausfiihrung von Tasks

Status — Dient der Anzeige des Status jeder einzelnen Vorlage

Der Status kann folgendermal3en lauten:

o

Blank (leer, kein Text) — Zeigt an, dass diese Vorlage in einem normalen Status ist und zum
Bearbeiten und Versenden von Tasks bereit ist.

Transferring (Ubertragung) — Zeigt an, dass die Vorlage nur temporr ist. Die in dieser
Vorlage erforderliche Nutzlast wird immer noch ibertragen. Nachdem die Ubertragung
abgeschlossen ist, andert sich der Status entweder zu ,Normal“ oder ,Failed”
(Fehlgeschlagen).

Failed (Fehlgqschlagen) — Zeigt an, dass der Status der Vorlage ungiiltig ist. Ein Fehler ist
wahrend der Ubertragung der in dieser Vorlage erforderlichen Nutzlast aufgetreten. Fahren
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Sie mit der Maus Uber den Text, um sich die Details dazu anzeigen zu lassen, welcher
Fehler aufgetreten ist.

Auf der Basis dieser Kategorien kénnen angepasste Vorlagen erstellt, bearbeitet, geléscht, importiert
oder exportiert werden, um spezielle Tasks fur Gerate zu generieren.

Erstellen und Bearbeiten von Task-Vorlagen

Eine Liste der standardmaRig ,leeren” Task-Vorlagen, die verschiedenen Kategorien zugeordnet
werden kdnnen, sind in der Registerkarte Task Templates (Task-Vorlagen) aufgefiihrt. Die Namen
von Standardvorlagen beginnen mit einem _ (Unterstrich), zum Beispiel: _File and Registry.

So erstellen oder bearbeiten Sie eine Task-Vorlage:

1.

Doppelklicken Sie in der Registerkarte Task Templates (Task-Vorlagen) im Task-Bereich auf
eine vorhandene Vorlage oder klicken Sie mit der rechten Maustaste auf eine Vorlage und
wahlen Sie dann aus dem Kontextmenii Properties (Eigenschaften).

Legen Sie lhre Anforderungen fiir die Vorlage unter Verwendung der verfiigbaren Optionen fest.
Um einen Wert fiir das Zielgerat zu I6schen, lassen Sie das entsprechende Vorlagenfeld flir den
Wert leer.

Nachdem Sie eine neue Vorlagendefinition fertig gestellt haben, klicken Sie auf die Schaltflache
Save as (Speichern unter), und geben Sie einen Namen fiir die neue Vorlage ein.

Klicken Sie auf OK. Die neue Vorlage wird erstellt und ihr Name wird in der Registerkarte Task
Templates (Task-Vorlagen) im Task-Bereich angezeigt.

Hinzufligen einer Vorlage zu den Favoriten

Um das Auffinden von haufig verwendeten Vorlagen zu erleichtern, kdnnen Sie sie wie folgt zu
Favorites (Favoriten) hinzufiigen:

1.

2.

Klicken Sie mit der rechten Maustaste in der Registerkarte ,Task Templates“ (Task-Vorlagen) im
Task-Bereich auf den Namen der Vorlage.

Wabhlen Sie aus dem Kontextmenu den Befehl Add to Favorites (Zu Favoriten hinzufligen).

Das Symbol fir die ausgewahlte Vorlage andert sich in das Favoritensymbol -=1]. . Sie kénnen die

Spalten nach Symbol sortieren, so dass |hre bevorzugten Vorlagen Giber den anderen Vorlagen
aufgelistet sind.

Importieren und Exportieren von Task-Vorlagen

Task-Vorlagen lassen sich importieren und exportieren und auf diese Weise von mehreren HPDM-
Systemen gemeinsam nutzen.

So exportieren Sie Task-Vorlagen:

1.

Klicken Sie mit der rechten Maustaste auf die zu exportierende Vorlage, und wahlen Sie aus
dem Kontextmeni den Befehl Export (Exportieren).

Wenn eine oder mehrere der ausgewahlten Vorlagen Nutzlastdateien verwenden, werden Sie
gefragt, ob diese Nutzlastdateien ebenfalls exportiert werden sollen. Wenn Sie den Export der
Nutzlastdateien bestatigen, 1adt die HPDM Console die Dateien vom Master-Repository
herunter.

Geben Sie den Namen der Vorlage ein.
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4. Wahlen Sie das Ziel der exportierten Datei aus.

5. Klicken Sie auf Export (Exportieren), um die Vorlage(n) zu exportieren. Vorlagen mit
Nutzlastdateien werden als ZIP-Dateien exportiert, Vorlagen ohne Nutzlast als XML-Dateien.

So importieren Sie Task-Vorlagen:

1. Wahlen Sie im MenlU Template (Vorlage) > Import (Importieren) > Exported Templates
(Exportierte Vorlagen).

2. Wabhlen Sie die XML- bzw. ZIP-Dateien aus, die Sie importieren moéchten. Es werden nur XML-
und ZIP-Dateien akzeptiert, die von HPDM exportiert wurden. Mit HPDM 4.4 und HPDM 4.5
erstellte Vorlagen kénnen importiert werden. Vorlagen, die mit einer alteren Version als 4.4
erstellt wurden, werden mdglicherweise nicht erkannt oder sind mdglicherweise nicht
kompatibel.

3. Klicken Sie auf Importieren. Die Datei wird als neue Vorlage hinzugefiigt. Nutzlastdateien in
einer ZIP-Datei werden automatisch zum Master-Repository hochgeladen.

E/{ HINWE__IS: Der Import von Task-Vorlagen nach Freigabe des HPDM 4.5 Service Pack 1 weist
einige Anderungen und Beschrankungen auf:

a. Importieren einer ,Update Agent‘-Vorlage

Eine ,Update Agent“-Vorlage, die in einer Vorlagensequenz enthalten ist, kann
importiert werden. Da zur ,Update Agent“-Vorlage gehérige Nutzlasten nicht importiert
werden konnen, wird ein Dialogfeld zur Bestatigung des Vorlagenimports angezeigt.

Eine einzelne ,Update Agent“-Vorlage kann bei installietem HPDM 4.5 Service Pack 1
nicht importiert werden. Ein entsprechendes Bestatigungsdialogfeld wird angezeigt.

b. Importieren einer ,Take TPM Ownership“-Vorlage

Wenn durch ,Take TPM Ownership“ kein Kennwort in der Datenbank festgelegt
wurde, kann die ,Take TPM Ownership“-Vorlage importiert werden.

Wenn das ,Take TPM Ownership“-Kennwort in der Datenbank mit dem Kennwort in
der exportierten , Take TPM Ownership“-Vorlage identisch ist, kann letztere importiert
werden.

Unterscheidet sich das ,Take TPM Ownership“-Kennwort in der Datenbank von dem
Kennwort in der exportierten ,Take TPM Ownership“-Vorlage, wird ein
Bestatigungsdialogfeld bzgl der Ersetzung des Vorlagenkennworts angezeigt.

c. Wenn eine der folgenden Einzelvorlagen ohne Nutzlast ist, wird ein Dialogfeld mit einer
Warnung angezeigt.

vi.

vii.

.File and Registry“-Vorlage mit ,Copy Files“- oder ,Deploy Files“-Subtasks zum
Kopieren oder Bereitstellen von Dateien

~Apply Easy Tools Configurations“-Vorlage

~Apply Easy Tools Settings“-Vorlage

,PXE Imaging“-Vorlage mit Senden (,Push®) des PXE-Images an das Gerat
,Update Image“-Vorlage

.Deploy Image“-Vorlage

,PXE Deploy“-Vorlage
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d. Ein Dialogfeld mit einer Warnung wird angezeigt, wenn ein Subtask zur Bereitstellung von

Dateien in einer Sequenzvorlage, die keine ,Update Agent“-Vorlage ist, ohne Nutzdaten ist.

e. Bei mit HPDM 4.4 exportieren Vorlagen kann es notwendig sein, die Subtasks in neue

Subtasks zu konvertieren.

i.  Copy Files-Subtasks in einer ,File and Registry“-Vorlage werden je nach Richtung des
Kopiervorgangs in Capture Files- bzw. Deploy Files-Subtasks konvertiert.

ii. PXE Image-Subtasks werden je nach Aktion in PXE Capture- bzw. PXE Deploy-
Subtaks konvertiert.

iii. Clone Image-Subtasks werden in Capture Image-Subtasks konvertiert.
iv. Update Image-Subtasks werden in Deploy Image-Subtasks konvertiert.

v. Update Agent-, Apply ET Configurations- und Apply ET Settings-Subtasks werden
nicht konvertiert.

f.  Bei Vorlagen, die eine Nutzlast erfordern, werden von der HPDM Console folgende

Aktionen durchgefiihrt.

i.  Uberpriifung auf fehlende erforderliche Nutzlasten (auRer bei ,Update Agent“-
Vorlagen)

ii. Konvertierung von Subtasks in neue Subtasks, sofern notwendig

iii. Anleitung der Benutzer beim Generieren einer Paketbeschreibungsdatei, wenn die
neue Vorlage Nutzlast enthalt

iv. Hochladen von Nutzlast zum Master-Repository, wenn die neue Vorlage Nutzlast
enthalt

So erzeugen Sie eine Vorlage aus der Nutzlast:

1.

Wahlen Sie im Meni Template > Import (Vorlage > Importieren) aus und wahlen Sie dann eines
folgender Menlelemente:

e Image Files (Image-Dateien) (.ibr, .img, .hpimg, .dd, .dd.gz)
e PColP Firmware (.all)

e Easy Tools Configuration (Easy Tools-Konfiguration) (.hpcfg)
e Easy Tools Settings (Easy Tools-Einstellungen) (.hpset)
Wahlen Sie die Datei, die Sie importieren méchten.

Klicken Sie auf Import (Importieren). Fiigen Sie dann die Nutzlastinformation in dem Dialogfeld
Package Description Editor (Paketbeschreibungs-Editor) hinzu.

Klicken Sie auf Generieren. Die Datei wird als neue Vorlage hinzugefiigt. Nutzlastdateien
werden automatisch zum Master-Repository hochgeladen.

So kopieren Sie eine Imagedatei auf ein anderes Betriebssystem:

1.

Klicken Sie mit der rechten Maustaste in der Registerkarte ,Task Templates” (Task-Vorlagen) im
Task-Bereich auf eine Vorlage des Typs ,PXE Deploy Image“ (PXE-Image bereitstellen) oder
.Deploy Image“ (Image bereitstellen).

Wahlen Sie aus dem Meni Copy to other OS (auf ein anderes Betriebssystem kopieren).
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3. Wabhlen Sie das Betriebssystem aus, auf das Sie das Image kopieren mdchten und geben Sie
einen Namen fir die neue Vorlage ein.

4. Klicken Sie auf OK. Die Datei wird als neue Vorlage hinzugeflgt.

Verwenden von Vorlagensequenzen

Vorlagensequenzen werden verwendet, um einen Satz Vorlagen zu kombinieren und in einer Task
mit einer angegebenen Reihenfolge und angegebenen Konditionen auszufiihren. Eine
Vorlagensequenz-Vorlage kann maximal 50 Tasks umfassen.

Vor jeder Ausfuhrung einer Vorlage der Sequenz wird eine Bedingung ausgewertet. Diese Bedingung
steuert, ob die Vorlage ausgefihrt wird oder nicht. Folgende Bedingungen stehen dabei zur
Verfugung:

Tabelle 4-1 Bedingungen fiir Vorlagensequenzen

Symbol Bedingung Beschreibung
- anyway Vorlage wird unabhangig vom Erfolg oder Misserfolg einer vorherigen
Lt (Immer) Vorlagenausfiihrung ausgefiihrt.
* success Vorlage wird nur bei erfolgreich ausgefiihrter vorheriger Vorlage ausgefiihrt.
ru (erfolgreich)

- failure (Fehler)  Vorlage wird nur dann ausgefiihrt, wenn die vorherige Vorlage mit einem Fehler beendet
= wurde.

So definieren Sie eine neue Vorlagensequenz:
A Doppelklicken Sie auf die Standardvorlage _Template Sequence (Vorlagensequenz), um den
Template Editor zu 6ffnen.
_Template Sequence

HPDM unterstiitzt zwei Arten von Vorlagensequenzen: Basis und Erweitert. Eine
Basisvorlagensequenz ist eine Vorlagensequenz, welche dieselbe Bedingung fiir jede auszufiihrende
Vorlage verwendet. Bei einer erweiterten Vorlagensequenz kénnen Sie fir jede Vorlage in der
Sequenz eine separate Bedingung angeben, welche die Ausfihrung der Vorlage steuert.

Basisvorlagensequenzen

Basisvorlagensequenzen werden festgelegt, indem Sie die Registerkarte Content (Inhalt) auswahlen
und dort auf Basic (Basis) klicken.

Das Kontrollkastchen Sequenz bei Fehler stoppen dient zum Andern der Bedingung fiir die
Vorlagenausfihrung. Bei Aktivierung wird die Vorlagensequenz nur dann fortgesetzt, wenn jede
Vorlage erfolgreich ausgefihrt wird. Ist die Option deaktiviert, wird jede Vorlage unabhangig vom
vorherigen Ausflihrungsstatus ausgefiihrt.

Eine Basisvorlagensequenz kann maximal 50 Vorlagen umfassen.

Erweiterte Vorlagensequenzen

Erweiterte Vorlagensequenzen werden festgelegt, indem Sie die Registerkarte Content (Inhalt)
auswahlen und dort auf Advanced (Erweitert) klicken.
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Abbildung 4-1 Template Editor — Vorlagensequenz (Erweitert)

-
El---i.: __File and Registry in seguence

In diesem Beispiel sollen vier Vorlagen wie folgt ausgefiihrt werden:
e Unbedingte Ausfiihrung der Vorlage "_File and Registry".

e Wenn die vorherige Vorlage erfolgreich ausgefiihrt wurde, soll die erste "_Configure Agent"-
Vorlage ausgefihrt und die Sequenz beendet werden.

e Wenn die Ausfiihrung der ersten Vorlage fehlschlagt. soll die Vorlage "_Update Agent"
ausgefuhrt werden.

e Wenn die Vorlage "_Update Agent" erfolgreich ausgefiihrt wurde, soll die zweite "_Configure
Agent"-Vorlage ausgeflihrt und die Sequenz beendet werden.

Jede Ebene von Vorlagen in einer erweiterten Vorlagensequenz wird als Abhdngigkeitsebene
bezeichnet. Eine erweitere Vorlagensequenz kann eine maximale Tiefe von 50 Abhangigkeitsebenen
aufweisen. Jede Abhangigkeitsebene kann entweder eine anyway-Vorlage (unbedingte Ausflihrung)
oder eine success-Vorlage und eine failure-Vorlage enthalten.

Tasks

Alle gesendeten Tasks werden Gberwacht und ihre Ergebnisse im Task-Bereich angezeigt. Im Task-
Bereich sind alle Tasks aufgelistet, die an Gerate gesendet wurden.

Die Task-Liste besteht aus den folgenden Spalten:

e Task Name (Task-Name) — Enthalt den Namen der Task-Vorlage, die zum Senden dieses Tasks
verwendet wurde.

e Progress and Status (Fortschritt und Status) — Zeigt den Verarbeitungsfortschritt und Status des
Tasks an.

e Target Device Number (Anzahl der Zielgerate) — Zeigt die Anzahl der Gerate an, denen der Task
zugewiesen wurde.

e Create Time (Zeitpunkt der Erstellung) — Zeigt an, wann der Task erstellt wurde.
e Sender - Zeigt den Sender des Tasks an. Sie miissen Uiber die Berechtigung zur
Benutzerverwaltung verfigen, um diese Saule zu sehen.

Ausfliihren eines Tasks

Zum Ausflhren einer Task auf einem Remotegerat mussen Sie zuerst eine Vorlage definieren,
welche die auszufiihrenden Anweisungen oder neuen Einstellungen bereitstellt, und anschliefiend
diese Vorlage auf das Gerat anwenden.

1.  Um eine Vorlage zu definieren, doppelklicken Sie auf eine vorhandene Vorlage in der
Registerkarte Task Templates (Task-Vorlagen) im Vorlagen-Bereich oder Sie klicken mit der
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rechten Maustaste auf eine Vorlage und wahlen aus dem Kontextmenu den Befehl Properties
(Eigenschaften).

2. Legen Sie Ihre Anforderungen fir die Vorlage mithilfe der verfigbaren Optionen fest, klicken Sie
dann auf Save as (Speichern unter), und geben Sie einen Namen fiir die neue Vorlage ein.

3. Um die Vorlage auf ein Gerat oder eine Gruppe von Geraten anzuwenden, ziehen Sie die
Vorlage mit der Maus von der Registerkarte Task Templates (Task-Vorlagen) des Gerate-
Bereichs auf das Gerat oder die Gerategruppe.

- oder -

Klicken Sie mit der rechten Maustaste im Gerate-Bereich auf ,Devices® (Gerat) oder in der
Geréatestruktur auf Ordner und wahlen Sie im Kontextmeni Send Task (Task senden) aus, um
das Dialogfeld Template Chooser (Vorlagenauswahl) anzuzeigen. Wahlen Sie eine Kategorie
und dann eine Vorlage aus der Vorlagenliste und klicken Sie auf Next (Weiter).

4. Das Dialogfeld Task Editor (Task-Editor) wird angezeigt. Wahlen Sie die Registerkarte Schedule
& Batch Control (Zeitplan und Batchsteuerung) aus, und legen Sie fest, wann und wie die Task
ausgefiihrt werden soll. Wenn Sie die Option Schedule Task (Task planen) nicht auswahlen und
eine Zeit angeben, wird die Task auf das Gerat angewendet, sobald Sie auf OK klicken.

5. Klicken Sie auf OK, um die Task auf das Gerat anzuwenden.

Symbole fur den Task-Status
Die in der Device Task View (Geratetaskansicht) angezeigten Symbole haben folgende Bedeutung:

Tabelle 4-2 Symbole fiir den Task-Status

Success (Erfolgreich)

&

Die Task wurde vom Gerét erfolgreich ausgefihrt.

Sending (Wird gesendet)

£

Der Task wird gerade vom HPDM Server Uber das HPDM Gateway zum Gerat gesendet und das System
wartet auf eine Antwort.

Failed/Timeout (Fehlgeschlagen/Zeitliberschreitung)

E

Die Task ist fehlgeschlagen, oder sie wurde aufgrund einer Zeitliberschreitung abgebrochen. (Wenn die
Task nach endlicher Zeit nicht abgeschlossen ist, wird der Status der Task als Timeout
(Zeitliberschreitung) angezeigt. Der Fehlercode fiir diesen Status ist 0.)

Ready (Bereit)

B>

Die Task wird ausgefiihrt und wartet auf eine Interaktion des Benutzers.

Paused (Angehalten)

=

Die Task-Ausfiihrung wurde angehalten.

Cancelled (Abgebrochen)

N

Die Task wurde abgebrochen.

Waiting (Warten)

G

Die Task ist fur das Senden zu einem spateren Zeitpunkt verplant und wurde noch nicht gesendet.

Processing (In Bearbeitung)

L

Die Task wurde vom Geréat akzeptiert und wird momentan verarbeitet.
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Task-Parameter

In HPDM st ein Task eine Kombination aus Vorlage, Ausfiihrungszeitplan und einer Liste von
Zielgeraten. Die HPDM Console listet Tasks in zwei Gruppen auf: Manual Tasks (Manuelle Tasks)
und Rule Tasks (Regel-Tasks). Manuelle Tasks werden direkt mit der HDPM Console erstellt und
Regel-Tasks indirekt durch die Verwendung von Regeln.

Sie kdnnen Task-Parameter festlegen, indem Sie Uber die Meniileiste der HPDM Console die Befehle
Werkzeuge > Konfiguration auswahlen, um das Dialogfeld Konfigurations-Management anzuzeigen,
und dann in der links angezeigten Struktur das Element Taskparameter erweitern.

Das Element Task Parameter (Taskparameter) besteht aus zwei untergeordneten Elementen: Valid
Time and Timeout (Glltige Zeit und Zeitlimit) und Write Filter, WOL and Task Deferment
(Schreibfilter, WOL und Task-Verschiebung). Diese werden in den folgenden Abschnitten
beschrieben.

Manuelle Tasks

Jedes Mal, wenn Sie eine Vorlage auf eine Gruppe von Geraten anwenden, wird der , Task Editor*
(Task-Editor) gedffnet und Sie erstellen eine Aufgabe. Der Task-Editor umfasst die Registerkarte
Contents (Inhalte) des , Template Editor* (Vorlagen-Editor). AulRerdem enthalt er drei zusatzliche
Registerkarten: Valid Time, Timeout & WOL (Gltige Zeit, Zeitlimit und WOL), Target Device List
(Zielgerateliste) und Schedule & Batch Control (Zeitplan und Batchsteuerung).

Valid Time, Timeout & WOL (Glltige Zeit, Zeitiberschreitung und WOL)

Auf der Registerkarte Giiltige Zeit, Zeitiiberschreitung und WOL des Task-Editors kébnnen Sie das
Kontrollkastchen Gililtige Sendezeit verwenden aktivieren, um eine Ablaufzeit fir den Task
festzulegen. Der Task wird nicht mehr gestartet, wenn er bis zum angegebenen Zeitpunkt noch nicht
gestartet wurde.

Exclude Working Hours (Arbeitszeiten ausschliefien) dient zum Verzdgern des Tasks bis zu einem
Zeitpunkt, der auBerhalb der fiir die Zielgerate angegebenen Arbeitszeiten liegt.

Wenn die Verarbeitung eines Tasks langer als die Execution Timeout (Ausfihrungs-Zeitlimit) dauert,
wird ein Zeitiiberschreitungs-Status eingegeben und der HPDM Server versucht, zu bestimmen, ob
der Task auf dem Zielgerat nicht mehr existiert.

Die Option WOL before task (WOL vor dem Task) erméglicht es, ein Zielgerat zu aktivieren, bevor ein
Task an das Gerat gesendet wird.

Target Device List (Zielgerateliste)

Auf der Registerkarte Target Device List (Zielgerateliste) werden die Gerate aufgelistet, auf die der
Task angewendet werden soll. Uber die bereitgestellten Schaltflaichen kénnen Sie Gerate zur Liste
hinzufigen oder aus dieser entfernen.

Schedule & Batch Control (Zeitplan und Batchsteuerung)

Die Registerkarte Schedule & Batch Control (Zeitplan und Batchsteuerung) weist die folgenden
Abschnitte auf.
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Schedule (Zeitplan) — Dieser Abschnitt dient zum Angeben eines Datums und einer Uhrzeit fir
die Ausfihrung des Tasks.

Batch Control (Batch-Steuerung) — Dieser Abschnitt dient zum Angeben der Batch-GrofRRe. Er
wird verwendet, wenn eine Aufgabe an eine hohe Anzahl von Geréaten gesendet wird. Die Batch-
Einstellungen legen fest, an wie viele Gerate der Task gleichzeitig gesendet wird. Auf diese
Weise erhalten Sie eine gewisse Kontrolle dariber, wie hoch der von HPDM generierte
Netzwerkdatenverkehr ist.

Write Filter Policy Setting (Einstellung fir Schreibfilterrichtlinie) — Dieser Abschnitt dient dazu,
anzugeben, wie von HPDM der Schreibfilter auf Geraten angewendet wird, die unter einem
Windows Embedded-Betriebssystem laufen.

Task Deferment (Task verschieben) — Dieser Abschnitt dient dazu, dass der Endbenutzer am
Zielgerat einen Neustart oder ein Herunterfahren verschieben kann, so dass die Arbeit sicher
beendet werden kann. Weitere Informationen finden Sie unter Zurlckstellen von Tasks

auf Seite 30

Zuruckstellen von Tasks

Diese gerateseitige Funktion bietet die Moglichkeit, die Arbeit vor dem Neustarten/Herunterfahren
des Gerates erst zu speichern. Wenn der HPDM Agent das Gerat normalerweise neu starten bzw.
herunterfahren musste, wird eines der Dialogfelder Reboot Required (Neustart erforderlich) oder
Shutdown Required (Herunterfahren erforderlich) angezeigt.

Benutzer kdnnen die Verschiebungszeit einstellen, indem der Schieberegler entsprechend
bewegt wird und mit Driicken der Schaltflache Postpone (Spater durchfiihren) ein Neustart oder
Ausschalten des Computers verschoben wird. Der Benutzer kann den Neustart bzw. das
Herunterfahren bis zu dreimal verschieben.

Wenn kein Verschieben nétig ist, kann er stattdessen auf Reboot now (Jetzt neu starten) oder
Shutdown now (Jetzt herunterfahren) klicken.

Benutzer kdnnen den Titel und die Meldungsinformationen fir Neustart/Herunterfahren mittels
der Task _Configure TaskDeferment in der HPDM Console anpassen. Die maximale Lange der
Meldung betragt 255 Zeichen.

Die maximale Erinnerungszeit betragt 10 Minuten, standardmagig voreingestellt ist 1 Minute.

Die maximale Verschiebungszeit betragt 8 Minuten, standardmagig voreingestellt sind 4
Minuten.

Wenn der HPDM Agent das Gerat zwangslaufig neu starten muss, wird das Fenster
~Aufgabenzuriickstellung“ nicht angezeigt.

Anzeigen von Task-Eigenschaften

So zeigen Sie die Eigenschaften einer Task an: Klicken Sie mit der rechten Maustaste auf eine Task,
und wahlen Sie aus dem Kontextmenu den Befehl View Task Contents (Taskinhalt anzeigen). Im
anschlieBend gedffneten Fenster Task Contents (Taskinhalt) werden detaillierte Informationen zur
zugewiesenen Task angezeigt.

Konfigurieren von Task-Parametern

Wabhlen Sie tber die Menlleiste der HPDM Console die Befehle Werkzeuge > Konfiguration aus, um
das Dialogfeld Konfigurations-Management zu 6ffnen, und klicken Sie dann in der Optionenstruktur
auf die Option Taskparameter, um sie zu erweitern.
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Die Option Task Parameters (Taskparameter) besteht aus zwei untergeordneten Optionen: Valid
Time and Timeout (Glltige Zeit und Zeitlimit) und Write Filter Policy Setting (Einstellung fiir
Schreibfilterrichtlinie). Diese werden in den folgenden Abschnitten beschrieben.

Valid Time & Timeout (Gultige Zeit und Zeitlimit)

Die Optionen Gilltige Zeit und Zeitlimit ermdglichen es Ihnen festzulegen, wie lange HPDM maximal
auf die Ausflihrung von Tasks warten soll. Aulerdem kdnnen Sie Beginn und Ende der Arbeitszeiten
festlegen, wahrend derer HPDM keine Tasks ausfuhrt. Durch Klicken auf eine Optionsschaltflache
I&sst sich im Feld Beschreibung eine kurze Beschreibung der Option anzeigen.

1.  Wahlen Sie Valid Time and Timeout (Gliltige Zeit und Zeitlimit) in der Optionenstruktur des
Dialogfelds Configuration Management (Konfigurations-Management) aus.

2. Legen Sie die Intervalle in Minuten fiir jede Kategorie fest: Valid Time (Gultigkeitsdauer),
General Timeout (Allgemeines Zeitlimit), General Batch Interval (Allgemeines Batchintervall),
PXE Batch Interval (PXE-Batchintervall) und FTP Batch Interval (FTP-Batchintervall).

Legen Sie die Anzahl der Geréate firr jede Kategorie fest: General Batch Amount (Allgemeiner
Batchumfang, PXE Batch Amount (PXE-Batchumfang) und FTP Batch Amount (FTP-
Batchumfang).

Aktivieren Sie das Kontrollkastchen Exclude Working Hours (Arbeitszeiten ausschlieRen), um
Uhrzeiten fir Beginn und Ende der Arbeitszeit einzugeben.

Durch Klicken auf Restore defaults (Standardeinstellungen wiederherstellen) kénnen Sie die
Zeitiberschreitungseinstellungen auf ihre Standardwerte zurticksetzen und die Arbeitszeit auf
den Bereich zwischen 9:00 und 17:00 Uhr festlegen.

3. Klicken Sie auf Apply (Ubernehmen), um die neuen Einstellungen zu speichern.
4. Klicken Sie zum Schliel3en des Dialogfelds auf OK.
Schreibfilter und WOL

Die Optionen fur Write Filter and WOL (Schreibfilter und WOL) ermdglichen es Ihnen, die Auswirkung
des erweiterten Schreibfilters flir XPe-Gerate auf Tasks festzulegen.

1. Wahlen Sie Write Filter and WOL (Schreibfilter und WOL) in der Optionenstruktur des
Dialogfelds Configuration Management (Konfigurations-Management) aus.

2. Wahlen Sie eine der drei Richtlinienoptionen aus.
Klicken Sie auf Apply (Ubernehmen), um die neuen Einstellungen zu speichern.

4. Klicken Sie zum Schliel3en des Dialogfelds auf OK.

Anhalten von Tasks

So halten Sie eine wartende Task an:
1.  Wahlen Sie im Task-Bereich einen wartenden Task aus.

2. Klicken Sie mit der rechten Maustaste darauf, und wahlen Sie aus dem Kontextmeni den Befehl
Pause (Anhalten).

Der Status der wartenden Task andert sich in Paused (Angehalten).

E.%" HINWEIS: Diese Operation ist nur fiir wartende Tasks verfligbar.
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Fortsetzen von Tasks

So setzen Sie eine angehaltene Task fort:
1. Wahlen Sie im Task-Bereich einen angehaltenen Task aus.

2. Klicken Sie mit der rechten Maustaste darauf, und wahlen Sie aus dem Kontextmeni den Befehl
Continue (Fortsetzen).

Der Status der angehaltenen Task &ndert sich in Waiting (Wartend).

Ef HINWEIS: Es kénnen nur angehaltene Tasks (d. h. nicht gesendete Tasks) fortgesetzt werden.

Erneutes Senden von Tasks
Wenn eine Task beendet wurde, kdnnen Sie die Task erneut zum Gerét senden.

1. Wahlen Sie im Task-Bereich den beendeten Task aus.

2. Klicken Sie mit der rechten Maustaste darauf, und wahlen Sie aus dem Kontextmen( den Befehl
Resend (Erneut senden).

Abbrechen von Tasks

Um einen ausgewahlten laufenden Task zu I6schen, klicken Sie mit der rechten Maustaste auf den
Task und wahlen Sie aus dem Kontextmeni den Befehl Cancel (Abbrechen). Das System wird
versuchen, das Gerat zu benachrichtigen, um den Task abzubrechen. Der Status des angehaltenen

Tasks andert sich in ,Canceled” (Abgebrochen).

[%/]"’ HINWEIS: Es kénnen nur laufende Tasks (Tasks mit dem Status ,Sending” (Versenden) oder
.Processing” (In Bearbeitung....)) abgebrochen werden. Auf der Gerateseite kdnnen nicht alle Tasks
abgebrochen werden. Die Task ist méglicherweise schon beendet, bevor das System die
Abbruchsanfrage Ubermitteln konnte. Der Staus der Tasks wird durch die nachfolgenden Berichte
aktualisiert, wenn sie nicht erfolgreich abgebrochen werden.

Léschen von Tasks

Um einen ausgewahlten Task zu I8schen, klicken Sie mit der rechten Maustaste auf den Task und
wahlen Sie aus dem Kontextmenu den Befehl Delete (L&schen).

/\ VORSICHT! Das Léschen einer Task, die momentan verarbeitet wird, kann das Betriebssystem-
Image beschadigen! Dies gilt beispielsweise fir Aktualisierungs-Tasks, Abbildbereitstellungs-Tasks

usw.

Anzeigen von Task-Protokollen

So zeigen Sie das Protokoll einer Task an:

1. Klicken Sie mit der rechten Maustaste auf einen Task im Task-Bereich und wahlen Sie aus dem
Kontextmen( den Befehl View device tasks and logs (Geratetasks und -protokolle anzeigen)
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oder doppelklicken Sie auf einen Task im Task-Bereich. Das Fenster Device Task View
(Geratetaskansicht) wird angezeigt.

2. Wabhlen Sie das Zielgerat aus, und klicken Sie auf die Umschaltflache unten, um das Task-
Protokoll fir das ausgewahlte Geréat ein- und auszublenden. Doppelklicken auf das Gerat in der
Geratetaskansicht hat denselben Effekt wie das Klicken auf die Umschaltflachen.

99y

& HINWEIS: Zum Aktualisieren des Task-Protokolls fiir die ausgewéhlte Gerate-Task driicken
Sie F5.

3. Klicken Sie nach Beendigung des Vorgangs auf Close (Schlielen), um den Protokoll-Viewer zu
schlieflen.

4. Klicken Sie auf OK.

Anzeigen der Erfolgsrate eines Tasks

So zeigen Sie die Erfolgsrate eines Tasks an:

A Klicken Sie mit der rechten Maustaste auf einen Task im Taskbereich und wahlen Sie entweder
Success Rate > by Gateway (Erfolgsrate > nach Gateway) oder Success Rate > by Subnet
(Erfolgsrate > nach Subnetz), je nachdem, wie die Informationen angezeigt werden sollen.

Offnen von VNC Viewer fiir die Remotesteuerung

Sie kénnen einen VNC Viewer flur die Remotesteuerung eines Gerats 6ffnen, indem Sie mit der
rechten Maustaste auf eine ausflihrbereite oder beendete Remotesteuerungs-Task klicken und aus
dem Kontextmeni den Befehl Open VNC Viewer for Shadowing (VNC Viewer fir Remotesteuerung
offnen) wahlen.

Offnen einer Ergebnisvorlage

Klicken Sie mit der rechten Maustaste auf einen ausfihrbereiten Task und wahlen Sie aus dem Meni
den Befehl Open Results Template (Ergebnis-Vorlage 6ffnen), um die Ergebnisse einiger Tasks, zum
Beispiel von Tasks des Typs Get Registry (Registry abrufen), Get Connection Configuration
(Verbindungskonfiguration abrufen), Capture (Aufzeichnen) usw. zu 6ffnen.

Tasks aller Benutzer anzeigen

Wenn Sie die Berechtigung zur Benutzerverwaltung haben, kénnen Sie rechts unten im Task-Bereich
das Kontrollkastchen View tasks from all users (Tasks aller Benutzer anzeigen) auswahlen, so dass
alle von allen Benutzern gesendeten Tasks angezeigt werden. Sie kdbnnen ebenso jeden Task, der
von irgendeinem Benutzer gesendet wird, erneut senden, anhalten, fortfihren, abbrechen und
I6schen.

Task-Regeln

In HPDM koénnen Sie mithilfe von Regeln die Ausfiihrung von Tasks automatisieren und Sie kénnen
die Regeln der Reihe nach ausflihren lassen. Jede Regel besteht aus drei Teilen: einem Filter, Gber
den die Gerate definiert werden, auf die die Regel anzuwenden ist, einem Trigger, Uber den definiert
wird, wann die Regel auszufiihren ist, und einer Vorlage, Uiber die definiert wird, welche Operation
mithilfe der Regeln auf den Geraten ausgefiihrt wird.

Regeln werden im Fenster Rules Management (Regel-Management) definiert, auf das Sie iber das
Menu Tools (Extras) zugreifen kénnen.
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BY HINWEIS: Nur die Regeln First Contact (Erster Kontakt) und Startup (Systemstart) kénnen
umsortiert werden.

Hinzuflgen einer neuen Regel

1.

6.

Klicken Sie auf die Schaltflaiche Add ... (Hinzufiigen), um das Fenster Rule Editor (Regel-Editor)
zu 6ffnen.

Fir jede Regel muss ein eindeutiger Name angegeben werden.

AuRerdem muss fiir jede Regel ein Filter definiert werden. Klicken Sie rechts neben dem
Filterfeld auf die Schaltflache Choose ... (Auswahlen), um das Fenster Filter Chooser
(Filterauswahl) zu 6ffnen.

In diesem Fenster konnen Sie einen bereits vorhandenen Filter auswahlen oder einen neuen
erstellen, indem Sie auf Add ... (Hinzufligen) klicken.

Nachdem der Name und der Filter eingestellt sind, knnen Sie den Trigger auswahlen. Es
stehen drei Optionen zur Auswahl:

e  First Contact (Erster Kontakt) — Die Regel wird fir jedes Gerat ausgefiihrt, das ihren
Filterkriterien entspricht, sobald vom Geréat die erste Registrierung beim HPDM Server
erfolgt oder nach dem Abschluss eines Tasks des Typs ,Factory-Reset” (Zuriicksetzen auf
Werkseinstellungen).

e  Startup (Systemstart) — Die Regel wird fiir jedes Gerat ausgefiihrt, das ihren Filterkriterien
entspricht, sobald das jeweilige Gerat neu gestartet wird.

e Scheduled (Geplant) — Bei dieser Option wird das Fenster ,Rule Editor* (Regel-Editor)
erweitert, damit Sie die Mdglichkeit haben, die Uhrzeit und das Datum fiir die Ausfiihrung
der Regel anzugeben. AulRerdem kdnnen Sie die Frequenz festlegen, mit der die
Ausflhrung wiederholt wird.

Geben Sie die zu verwendende Vorlage an.

Bf HINWEIS: Vorlagen, die Aktionen beinhalten, um Images oder Dateien aufzuzeichnen, kénnen

in dieser Task-Regel nicht angewandt werden.

Klicken Sie auf OK, um die Regel zu erstellen.

Die neue Regel wird standardmaRig aktiviert. Sie kbnnen die Regel deaktivieren, indem Sie das
Kontrollkastchen im Fenster Regel-Managementdeaktivieren.
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5 Gerateverwaltung

e Anzeigen von Geraten

° Loschen von Geréaten

° Gruppieren von Geréaten

° Uberpriifen des Netzwerkverbindungsstatus

° Drucken von Informationen zu Geréten

° Remotesteuerung von Geraten

° Energieverwaltung

° Verwalten von normalen Thin Clients

° Verwalten von PColP Zero Clients

Anzeigen von Geraten

So zeigen Sie die zurzeit verwalteten Gerate im Gerate-Bereich an:
A Wahlen Sie ein Verzeichnis in der Geratestruktur.
So zeigen Sie ein Meni anwendbarer Befehle an:

A Wahlen Sie ein Verzeichnis in der Geratestruktur oder ein oder mehrere Geréte im Geréate-
Bereich aus und klicken Sie anschlieRend mit der rechten Maustaste.

¥ TIPP: Alle diese Befehle sind auch im Meni Device (Gerat) der HPDM Console verfiigbar.

Ein HPDM Agent kann in zwei verschiedenen Modi arbeiten:

e  Pull-Modus — Der HPDM Agent fordert in regelmafigen Zeitabstanden Tasks vom HPDM
Gateway an.

e  Push-Modus — Das HPDM Gateway sendet Tasks an den HPDM Agent, sobald sie vom HPDM
Server empfangen werden.

Im Geréate-Bereich der HPDM Console werden Gerate durch folgende Symbole dargestellt:

Repréasentiert eine zu einer Gruppe zusammengefasste Anzahl von Geraten

Zeigt an, dass der Status dieses Gerats nicht bestatigt werden kann, da das HPDM Gateway, welches das
Geréat verwaltet, zurzeit heruntergefahren oder nicht verbunden ist

Zeigt an, dass das Gerat zurzeit ausgeschaltet ist

Zeigt an, dass das Gerat zurzeit im Pull-Modus arbeitet

Zeigt an, dass das Geréate zurzeit im Pull-Sperrmodus arbeitet (der Schreibfilter ist aktiviert)

@ E s O
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1] Zeigt an, dass das Gerat zurzeit im Push-Modus arbeitet

@ Zeigt an, dass das Gerate zurzeit im Push-Sperrmodus arbeitet (der Schreibfilter ist aktiviert)

Folgende Symbole werden auf der Registerkarte HPDM-Gateway der HPDM Console verwendet:

@ Steht flr ein zurzeit aktives HPDM Gateway
(‘) Steht fur ein HPDM Gateway, das zurzeit heruntergefahren oder nicht verbunden ist

Loéschen von Geraten

So Ioschen Sie ein Gerat aus der Geratestruktur:
1. Klicken Sie mit der rechten Maustaste auf den Ordner in der Geratestruktur.
2.  Wahlen Sie aus dem Kontextmenu den Befehl Delete (Loschen).
Alle Geréate in diesem Ordner werden aus der Geratestruktur entfernt.
Und so I6schen Sie ein Gerat aus dem Geréate-Bereich:
1. Klicken Sie mit der rechten Maustaste auf das Gerat im Gerate-Bereich.
2. Wahlen Sie aus dem Kontextmeni den Befehl Delete (L&schen).

Das ausgewahlte Gerat wird aus dem Gerate-Bereich entfernt.

Gruppieren von Geraten

HPDM ermoglicht es lhnen, Gerate einzeln und in Gruppen zu verwalten. Sie kénnen lhre Grate auf
zwei verschiedene Arten gruppieren:

e  Manuell (unter Verwendung lhrer eigenen Definitionen fur die Gruppierung)
e Dynamisch (unter Verwendung der Inventardaten des Gerats)

Zusatzlich konnen Sie zum Filtern von Geraten die Inventardaten des Gerats verwenden. Dies
ermoglicht Ihnen, Ihre Gerate in Gruppen zu unterteilen und diesen Gruppen spezielle
Administratoren zuzuweisen.

Einstellen von Gruppendaten iber eine DHCP-Kennung

Sie kdnnen die Gruppierungsdaten angeben, die von einem neuen Gerat verwendet werden, indem
Sie das DHCP-Tag 203 einstellen.

Tag 203 ermdglicht es Ihnen, bis zu sechs Gruppierungsparameter zu konfigurieren, die dann als Teil
eines dynamischen Gruppierungsschemas verwendbar sind. Sie sind mit 27 — P6 gekennzeichnet.
Sie kdnnen die sechs Parameter in beliebiger Reihenfolge angeben. Darliber hinaus kénnen Sie
einen speziellen Parameter mit der Bezeichnung MG einschlieRen und auf einen Pfad einstellen, der
fur die manuelle Gruppierung verwendet wird. Dieser Pfad dient dazu, eine Substruktur in der
Geratestruktur der HPDM Console zu erstellen, wenn die manuelle Gruppierung ausgewahlt wird.
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Wenn der Pfad beispielsweise auf Company/Department/Group (Firma/Abteilung/Gruppe) eingestellt
wird, prasentiert sich die Geratestruktur wie folgt:

Abbildung 5-1 Einstellen von Gruppendaten Uber eine DHCP-Kennung
EHCd Company

EH Department

B2

Im Folgenden ist das Format dargestellt, das von HPDM fiir Kennung 203 verwendet wird. Alle
Parameter sind optional, aber jedem angegebenen Parameter muss ein Wert zugewiesen werden:

Pl=“valor”;P2=“valor”;P3=“valor”;P4="valor”;P5=“valor”;P6=“valor”;MG="
valor”

Beispiel:

Pl1="Asia”;P2="China”; P3="Shanghai”;MG="Empresa/Departamento/Grupo”

Wechseln zur manuellen Gruppierung
1. Klicken Sie auf die Schaltflache Group by (Gruppieren nach).
2. Wahlen Sie Manual Group (Manuelle Gruppe) und dann _global (system) aus.

3. Alle angegebenen Manual Groups (manuelle Gruppen), die mit dem DHCP-Tag angegeben
werden, erscheinen automatisch.

Hinzufligen einer neuen ,Manual Group* (Manuelle Gruppe)

1. Klicken Sie mit der rechten Maustaste in die Geratestruktur und wahlen Sie den Befehl Manual
Group > Add Folder (Manuelle Gruppe > Ordner hinzufligen)

2. Geben Sie einen Namen fiir den neuen Ordner ein.
3. Klicken Sie auf OK.
Gerate kdnnen per Drag-and-Drop zwischen manuellen Gruppen verschoben werden. Manuelle

Gruppen lassen sich auRerdem umbenennen und I6schen.

Dynamische Gruppierung

HPDM ermdoglicht es Ihnen, Schemata fiir die dynamische Gruppierung zu erstellen. Von jedem
Schema wird anhand der ausgewahlten Kriterien eine eigene Struktur erstellt.

Erstellen eines neuen ,Dynamic Grouping scheme® (Schema fiir die dynamische
Gruppierung)

1. Klicken Sie auf die Schaltflache Group by (Gruppieren nach).

2. Klicken Sie auf Schema bearbeiten, und stellen Sie sicher, das die Registerkarte Dynamisches
Schemaausgewahlt ist.

3. Klicken Sie auf Add (Hinzufligen), und geben Sie einen Namen flr das neue Schema ein.
Klicken Sie auf OK, um den neuen Namen zu Gbernehmen.

Gruppieren von Geraten
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4. Wahlen Sie die Kriterien aus, die flir das Schema definiert werden sollen und ordnen Sie diese.
Extension Properties 1-6 (Erweiterungs-Eigenschaften 1-6) entsprechen den
Gruppierungselementen P1 bis P6, die Sie Gber das DHCP-Tag 203 einstellen kénnen.

5. Klicken Sie auf OK, um das Fenster Edit Grouping Scheme (Gruppierungsschema bearbeiten)
zu schliel3en.

Wechseln zu einer dynamischen Gruppe

1. Klicken Sie auf die Schaltflache Group by (Gruppieren nach).
2. Wahlen Sie Dynamic Group (Dynamische Gruppe) aus.

3.  Wahlen Sie das zu verwendende Schema aus.

Filtern von Geréaten

Die Filterung gestattet es lhnen, mit einer Untergruppe lhrer Gerate zu arbeiten. Sie lasst sich mit den
Benutzerberechtigungen kombinieren, um die Verwaltung lhrer Gerate auf verschiedene
Administratoren zu verteilen.

Erstellen eines neuen Gerétefilters

1. Wahlen Sie im Hauptmenii die Option View (Ansicht) und dann Device Filter ... (Geratefilter...)
aus.

2. Klicken Sie im Fenster Device Filter Management (Geratefilter-Management) auf Add
(Hinzuflgen).

3. Geben Sie einen Namen fiir den neuen Filter ein. Klicken Sie auf OK, um den Namen zu
ubernehmen.

4. Klicken Sie auf Add... (Hinzufiigen ...) im Dialogfeld Edit Device Filter (Geratefilter bearbeiten),
um das Dialogfeld Choose Criteria Key (Kriterienschliissel auswahlen) zu 6ffnen.

5. Wabhlen Sie im Dialogfeld Choose Criteria Key List (Kriterienschllissel-Auswabhlliste) die
gewunschten Kriterien aus. Klicken Sie auf OK, um das Dialogfeld Criterion Editor (Kriterien-
Editor) fir das gewahlte Kriterium zu &ffnen.

6. Definieren Sie den Operator und den Wert flir das neue Kriterium.

7. Wiederholen Sie die Schritte 4 bis 6, um weitere Kriterien zu laden. Klicken Sie anschlie3end auf
Speichern und Schlielen.

8. Wahlen Sie den neuen Filter in der Dropdown-Liste Filter aus.

Der Filter kann als Sicherheitsfilter verwendet werden, um den Zugriff fir bestimmte Benutzer
oder Gruppen einzuschranken. Durch den Filter wird festgelegt, auf welche Gerate eine Regel
angewandt wird. Wenn Sie einen Task senden, konnen Sie dabei mithilfe von Filtern die
Zielgerate auswahlen. Ihre Geratestruktur-Ansicht lasst sich mithilfe eines Filters eingrenzen.

'L%’ HINWEIS: Der ,Device Filter* (Geratefilter) unterstitzt das Hinzufligen verschiedener Kriterien mit
demselben Namen.

Bearbeiten eines Geratefilters

So bearbeiten Sie den Geratefilter:
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Wabhlen Sie aus dem MenU View (Ansicht) den Befehl Device Filter (Geréatefilter).

Doppelklicken Sie auf einen vorhandenen Filter oder wéhlen Sie einen vorhandenen Filter aus
und klicken Sie anschlieRend auf Edit... (Bearbeiten ...), um das Dialogfeld Edit Device Filter
(Geratefilter bearbeiten) zu 6ffnen.

Klicken Sie auf Add... (Hinzuftugen ...) im Dialogfeld Edit Device Filter (Geratefilter bearbeiten),
um das Dialogfeld Choose Criteria Key (Kriterienschliissel auswahlen) zu 6ffnen.

Wabhlen Sie in der Liste Candidate Criteria Key List (Kandidat-Kriterienschlisselliste) die
gewlinschten Kriterien aus. Klicken Sie auf OK, um das Dialogfeld Criterion Editor (Kriterien-
Editor) fir das gewahlte Kriterium zu 6ffnen.

Klicken Sie auf die Pfeilschaltflachen im Bereich Edit Criteria (Kriterien bearbeiten), um
Bedingungen in den Dropdown-Menus auszuwahlen. Beispiel: OS Type = HP ThinPro.

Wenn die Liste Criteria List (Kriterienliste) mehrere Kriterieneintrage aufweist, kdbnnen Sie
zwischen den Optionen Satisfy all criteria (Alle Kriterien erfillt) und Satisfy any criteria
(Mindestens ein Kriterium erfullt) wahlen. Klicken Sie anschlielend auf Save (Speichern), um
zum Dialogfeld Device Filter Management (Geratefilter-Management) zurtickzukehren.

Im Dialogfeld Device Filter Management (Geréatefilter-Management) kdnnen Sie den
ausgewahlten Filter nach Bedarf bearbeiten oder 16schen.

Klicken Sie auf die Schaltflache Generate Device List (Gerateliste generieren), um die gefilterte
Gerateliste zu erstellen.

Der Administrator kann jetzt die Geréatefilter zur Verwaltung der Gerate im Netzwerk verwenden.

Filtersicherheit

Sie kdnnen die fir einen Benutzer sichtbaren Gerate begrenzen, indem Sie diesem Benutzer einen
Filter als Sicherheitsfilter zuweisen. Dies erreichen Sie wie folgt:

1.

Wabhlen Sie aus dem MenU Tools (Extras) den Befehl User Management (Benutzer-
Management).

Wahlen Sie den Namen des Benutzers auf der Registerkarte Users (Benutzer) aus, und klicken
Sie auf Edit (Bearbeiten).

Klicken Sie auf die Registerkarte Filter.

Wabhlen Sie den zu verwendenden Filter aus der Dropdown-Liste Security Filter
(Sicherheitsfilter).

Wenn Sie sich als jener Benutzer anmelden, werden Sie feststellen, dass lediglich die vom
ausgewahlten Filter zugelassenen Gerate angezeigt werden.

Uberpriifen des Netzwerkverbindungsstatus

Sie kdnnen den Netzwerkverbindungsstatus eines Geréats Uberprifen, d. h. ermitteln, ob es mit dem
Netzwerk verbunden ist oder nicht.

1.

Wahlen Sie im Gerate-Bereich eines oder mehrere Gerate aus, klicken Sie mit der rechten
Maustaste und wahlen Sie aus dem Kontextmeni den Befehl Check Connection Status
(Verbindungsstatus Uberpriifen).

Wahlen Sie das Dienstprogramm aus, mit dem Sie den Verbindungsstatus des Gerats
Uberprifen mochten. Folgende Optionen stehen zur Auswahl:

Uberpriifen des Netzwerkverbindungsstatus
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e Ping - Ein einfaches Internetprogramm, mit dem Sie ermitteln kénnen, ob eine bestimmte
Internetadresse existiert und auf Anforderungen reagieren kann. Ping wird zu
Diagnosezwecken eingesetzt, um sicherzustellen, dass ein Host-Computer, mit dem Sie
eine Verbindung herstellen méchten, auch tatsachlich betriebsbereit ist.

e Trace Route — Dieses Diagnosetool ermittelt den Pfad zu einem Ziel, indem es ICMP Echo
Request-Nachrichten mit unterschiedlichen TTL (Time to Live)-Werten an das Ziel sendet.
Jeder Router entlang des Pfades muss den TTL-Wert in einem IP-Paket um mindestens 1
vermindern, bevor er das Paket weiterleitet. Letztendlich ist der TTL-Wert ein Zahler fir die
maximale Anzahl der Teilstrecken einer Verbindung. Wenn der TTL-Wert eines Pakets auf
Null sinkt, sollte der Router eine ICMP Time Exceeded-Nachricht an den Quellcomputer
zurticksenden.

Ein Fenster mit dem Netzwerkverbindungsstatus des Geréats wird angezeigt.

3. Kilicken Sie auf Close (Schlief3en).

Drucken von Informationen zu Geraten

Drucken von Gerateinformationen

So drucken Sie Informationen zu Geraten, die in der HPDM Console aufgelistet sind:

1. Wahlen Sie im Gerate-Bereich die Gerate aus, zu denen Sie Informationen drucken mdchten
(die Auswahl kann durch Kombination der Strg-Taste bzw. Umschalttaste-Taste und Mausklick
erfolgen).

2. Klicken Sie in der Symbolleiste auf das Symbol Print (Drucken), um das Fenster Print Device
(Gerateinformationen drucken) zu 6ffnen. Es werden Informationen zu allen ausgewahlten
Geréten im Fenster angezeigt.

3. Klicken Sie auf Export (Exportieren), um die Liste in eine CSV-Datei zu exportieren. Geben Sie
einen Namen ein, und klicken Sie auf Save (Speichern).

- oder -

Klicken Sie auf Print Preview (Druckvorschau), um den Geratebericht zu drucken. Das Fenster
Print Preview (Druckvorschau) wird geéffnet.

4. Wenn die Vorschau lhren Wiinschen entspricht, klicken Sie auf das Druckersymbol oder wéahlen
Sie aus dem Men File (Datei) den Befehl Print (Drucken). Klicken Sie auf OK, um die neuen
Druckeinstellungen zu Gbernehmen.

Remotesteuerung von Geraten

40

Die Remotesteuerung ermoglicht es lhnen, sich mit einem Remote-Gerat zu verbinden und dieses
Gerat von der HPDM Console aus zu steuern. Dies kann entweder mithilfe der Vorlage _Shadow
Device erreicht werden, die in der Registerkarte Task Template (Task-Vorlage) verfiigbar ist, oder
(wie nachfolgend beschrieben) durch Auswahl im Kontextmen, das beim Klicken mit der rechten
Maustaste auf ein Gerat gedffnet wird.

299

& HINWEIS: Aktualisieren Sie den HPDM Agent auf die neueste Version, bevor Sie die
Remotesteuerung eines Geréts ibernehmen. Senden Sie einen Apply Settings-Task, um den VNC-
Server zu aktivieren.

So iibernehmen Sie die Remotesteuerung eines Geréts:
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1. Wahlen Sie im Gerate-Bereich eine Gruppe von Geraten oder in der Geratestruktur ein
einzelnes Gerat aus.

2. Klicken Sie mit der rechten Maustaste, und wéahlen Sie aus dem Kontextmenu den Befehl
Shadow (Remotesteuerung). Das Dialogfeld Task Editor (Task-Editor) wird angezeigt.

3. Klicken Sie auf OK. Wenn die Verarbeitung der Remotesteuerungs-Task abgeschlossen ist, wird
der Remotedesktop des Terminals in einem eigenen Fenster angezeigt.

So 6ffnen Sie den VNC-Viewer fiir die Remotesteuerung:

1. Wahlen Sie im Task-Bereich einen abgeschlossenen Task Shadow Device (Remotesteuerungs-
Gerat) aus.

2. Klicken Sie mit der rechten Maustaste, und wahlen Sie aus dem Kontextmeni den Befehl Open
VNC Viewer for Shadowing (VNC-Viewer fiir Remotesteuerung 6ffnen), oder wahlen Sie aus
dem Meniu Task den Befehl Open VNC Viewer for Shadowing (VNC-Viewer fiir
Remotesteuerung 6ffnen).

Der Remote-Desktop des Gerats wird in einem eigenen Fenster angezeigt, wo Sie direkt mit ihm
arbeiten kdénnen.

Energieverwaltung

Die HPDM Console ermdglicht es lhnen, ein Gerat per Remotezugriff neu zu starten,
herunterzufahren oder per LAN zu aktivieren. Dies kann entweder mithilfe der auf der Registerkarte
»1ask Templates® (Task-Vorlagen) im Task-Bereich vorhandenen Vorlagen oder (wie nachfolgend
beschrieben) durch Auswahl im Kontextmend, das beim Klicken mit der rechten Maustaste auf ein
Gerat gedffnet wird, erreicht werden.

[’_9'/1’ HINWEIS: Zum Aktivieren eines Clients per LAN muss die WOL (Wake On LAN)- Unterstiitzung im
Gerate-BIOS aktiviert sein.

So aktivieren Sie ein Gerat per LAN, fahren es herunter oder starten es neu:

1.  Klicken Sie im Gerate-Bereich mit der rechten Maustaste auf ein Gerat und wahlen Sie aus dem
Kontextmenu die Befehle Power Management > Reboot, Wake On LAN oder Shutdown
(Energie-Management > Neustart, Start per LAN oder Herunterfahren).

2. Das Dialogfeld Task Editor (Task-Editor) wird angezeigt. Klicken Sie auf OK, um die Task
auszufiihren.

Wenn das Gerat den Task empfangt, informiert eine Warnung auf dem Bildschirm des Gerats den
Benutzer dartiber, dass das Gerat heruntergefahren oder neu gestartet wird.

Verwalten von normalen Thin Clients

Andern des Hostnamens eines Geréts

So andern Sie den Hostnamen eines Geréts:

1. Klicken Sie in der HPDM Console mit der rechten Maustaste auf das gewtiinschte Gerat und
wahlen Sie dann Rename (Umbenennen).

2. Bearbeiten Sie den Wert fiir den Hostnamen und klicken Sie auf OK, damit automatisch ein
Task initialisiert wird.
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3. Passen Sie im ,Task Editor” (Task-Editor) die Task-Einstellungen nach Bedarf an (z B. ,Write
Filter Policy Setting®, Einstellung fur Schreibfilterrichtlinie).

4. Klicken Sie auf OK.

Erfassung und Bereitstellung von Verbindungen

So zeichnen Sie Verbindungen auf:

1. Doppelklicken Sie auf die Vorlage _Pull Connection Configuration, um den ,Template Editor"
(Vorlagen-Editor) zu 6ffnen.

2. Verwenden Sie die Kontrollkastchen, um anzugeben, welche Verbindungseinstellungen
aufgezeichnet werden sollen.

3. Geben Sie in das Feld Save result as template (Ergebnis als Vorlage speichern) einen Namen
fur die Ergebnis-Vorlage ein, die zum Speichern der erfassten Verbindungen erstellt wird.

4. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fiir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefiigt.

5. Ziehen Sie die Vorlage per Drag-and-Drop auf das gewUlinschte Geréat.
6. Klicken Sie auf OK, um den Task auf das Gerat anzuwenden.

Die Verbindungen werden erfasst und in einer neuen Vorlage unter dem Namen gespeichert, den Sie
im Feld Save result as template (Ergebnis als Vorlage speichern) angegeben haben.

So stellen Sie erfasste Verbindungen bereit:
A Ziehen Sie die Ergebnis-Vorlage eines Tasks des Typs _Pull Connection Configuration per
Drag-and-Drop auf die gewilinschten Gerate.

Klonen und Bereitstellen von Einstellungen

So klonen Sie Einstellungen:

1. Doppelklicken Sie auf die Vorlage _Clone Settings, um den ,Template Editor* (Vorlagen-Editor)
zu offnen.

2. Verwenden Sie die Kontrollkdstchen, um anzugeben, welche Einstellungen geklont werden
sollen.

3. Geben Sie in das Feld Save result as template (Ergebnis als Vorlage speichern) einen Namen
fiir die Ergebnis-Vorlage ein, die zum Speichern der geklonten Einstellungen erstellt wird.

4. Kilicken Sie auf Save as (Speichern unter), geben Sie einen Namen fiir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefigt.

5. Ziehen Sie die Vorlage per Drag-and-Drop auf das gewiinschte Gerat.
6. Klicken Sie auf OK, um den Task auf das Gerat anzuwenden.

Die Einstellungen werden geklont und in einer neuen Vorlage unter dem Namen gespeichert, den Sie
im Feld Save result as template (Ergebnis als Vorlage speichern) angegeben haben.

So stellen Sie geklonte Einstellungen bereit:

A Ziehen Sie die Ergebnis-Vorlage eines Tasks des Typs _Clone Setting per Drag-and-Drop auf
die gewilinschten Gerate.
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Anwenden von benutzerdefinierten Einstellungen

So wenden Sie benutzerdefinierte Einstellungen an:

1.

4,

8.
9.

zu 6ffnen.
Klicken Sie auf die Schaltflache Edit (Bearbeiten).

Verwenden Sie die Kontrollkastchen, um anzugeben, welche Einstellungen bearbeitet werden
sollen.

Konfigurieren Sie die gewinschten individuellen Einstellungen.

Doppelklicken Sie auf die Vorlage _Apply Settings, um den ,Template Editor (Vorlagen-Editor)

2993

& HINWEIS: Der Satz der konfigurierbaren Einstellungen kann je nach Typ und Version des
Betriebssystems variieren.

7 HINWEIS: Die bei der Konfiguration der ,Time Settings” (Zeiteinstellungen) fur die Gerate
WES 2009 und XPe verfugbaren Werte sind mit den fir WES 7-Geréte verfugbaren Werten
vereinheitlicht. Insgesamt gibt es 97 Werte. Einige werden von WES 2009- oder XPe-Geréten
unter Umstanden nicht unterstutzt. AuRerdem werden nicht alle Werte fir WES 2009 und XPe
von HPDM-Vorlagen und -Tasks unterstitzt.

7 HINWEIS: Einstellungen fur den Firefox-Browser stehen nur fiir HP ThinPro 4.1 und frihere
Versionen zur Verfiigung.

£ HINWEIS:  Druckereinstellungen stehen nur fir HP ThinPro zur Verfugung. Konfigurieren Sie
Druckereinstellungen erst nach dem Klonen.

Die Spalten ,,Adresse” und ,Port“ kénnen wie folgt bearbeitet werden:
e  Wenn Typ den Wert Netzwerk hat, kdnnen Adresse und Port bearbeitet werden.
e  Wenn Typ den Wert LPT oder COM hat, kann Port bearbeitet werden.

e  Wenn Typ den Wert USB hat, kann keines von beidem bearbeitet werden.

Nachdem die Einstellungen konfiguriert wurden, navigieren Sie zur Seite Summary
(Zusammenfassung). Hier sind alle Einstellungen aufgelistet, die von dieser Vorlage geandert
werden.

Wenn die Anderungen korrekt sind, klicken Sie auf Finish (Fertig stellen), um zum ,Template
Editor* (Vorlagen-Editor) zuriickzukehren.

klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefiigt

Ziehen Sie die Vorlage per Drag-and-Drop auf die gewlinschten Gerate.

Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Verwalten von Dateien und Registry-Einstellungen

Die Vorlage _File and Registry besteht aus einer individuell einstellbaren Kombination von Subtasks

zum Verwalten von Dateien und Registry-Einstellungen auf Geraten.

Folgende Subtasks sind verfugbar:

Capture Files (Dateien aufzeichnen) — Siehe Dateien erfassen auf Seite 44.

Deploy Files (Dateien bereitstellen) — Siehe Bereitstellen von Dateien auf Seite 45.

Verwalten von normalen Thin Clients

Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fir die neue Vorlage ein und
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e Delete Files (Dateien léschen) — Siehe Loschen von Dateien auf Seite 45.

e Registry — Siehe Verwalten der Registry-Einstellungen des Gerats auf Seite 46.

e Command (Befehlen) — Siehe Remotegesteuerte Ausfiihrung von Befehlen auf Seite 47.

e Pause (Unterbrechen) — Siehe Anhalten eines Tasks des Typs ,, File and Registry®
auf Seite 48.

e Program Record (Programmaufzeichnung) — Siehe Hinzufligen oder Entfernen von
Progammaufzeichnungen auf Seite 48.

e  Script (Skript erstellen) — Siehe Ausflihren eines Skripts auf Seite 49.

So passen Sie eine Vorlage des Typs _File and Registry individuell an:

1. Doppelklicken Sie auf die Vorlage _File and Registry, um den ,Template Editor* (Vorlagen-
Editor) zu 6ffnen.

2. Bei Bedarf kdnnen Sie Subtasks hinzufiigen (Add), bearbeiten (Edit) Idschen (Delete) und
kénnen diese nach oben (Up) und nach unten (Down) verschieben.

3. Klicken Sie auf Save as (Speichern unter), um die Vorlage fiir die spatere Verwendung zu
benennen und zu speichern.

Sie kénnen auch zwei oder mehr Vorlagen des Typs _File and Registry zusammenfiigen, um die
Subtasks dieser Vorlagen in einer Vorlage zu kombinieren.

Zusammenfugen von Vorlagen des Typs _File and Registry:

1. Klicken Sie mit der rechten Maustaste auf eine Vorlage des Typs _File and Registry und wahlen
Sie Merge (Zusammenfiigen) aus.

2. Klicken Sie auf eine weitere _File and Registry-Vorlage und klicken Sie anschliefiend auf OK.
3. Geben Sie einen Namen fur die zusammengefugte Vorlage ein, wenn Sie dazu aufgefordert
werden.
Dateien erfassen
So zeichnen Sie Dateien von Geraten auf und speichern diese im Master-Repository:

1. Doppelklicken Sie auf die Vorlage _File and Registry, um den ,Template Editor” (Vorlagen-
Editor) zu 6ffnen.

2. Klicken Sie auf Add (Hinzuftigen), wahlen Sie den Subtask Capture Files (Dateien aufzeichnen)
aus und klicken Sie anschlielend auf OK.

3. Geben Sie im Editor ,Capture Files* (Dateiaufzeichnungs-Editor) den Dateipfad der zu
Ubertragenden Datei oder des zu Ubertragenden Verzeichnisses an. Sie kdnnen zusatzliche
Zeilen hinzufugen, indem Sie auf Add (Hinzufiigen) klicken.

Die Platzhalter * und ? werden auf der untersten Ebene des Pfads oder Dateinamens
unterstuitzt. Siehe folgende Beispiele:

a* Erfasst alle Dateien, die mit dem Buchstaben ,a“ beginnen, gefolgt von einer beliebigen Anzahl
weiterer Zeichen.

a? Erfasst alle Dateien, die mit dem Buchstaben ,a“ beginnen, gefolgt von nur einem weiteren Zeichen.
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a Erfasst alle Dateien, die auf den Buchstaben ,a“ enden und mit einer beliebigen Anzahl Zeichen
beginnen.

?a Erfasst alle Dateien, die auf den Buchstaben ,a“ enden und mit nur einem weiteren Zeichen
beginnen.

4. Geben Sie den Zielpfad ein, unter dem Sie die erfassten Dateien im Master-Repository
speichern mochten.

¥* TIPP: In das Feld fiir den Zielpfad kénnen nur Parameter eingegeben werden, die Dateien, die
(wahrend eines einzelnen Tasks) von verschiedenen Geraten erfasst wurden, an verschiedene
Verzeichnisse senden.

5. Wahlen Sie die Option Overwrite if exists (Uberschreiben, falls vorhanden) aus.
6. Klicken Sie auf OK, wenn Sie die Angabe der Dateien abgeschlossen haben.

7. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefiigt.

Ziehen Sie die Vorlage per Drag-and-Drop auf die gewlinschten Gerate.

Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Bereitstellen von Dateien
So stellen Sie Dateien flir Gerate bereit:

1. Doppelklicken Sie auf die Vorlage _File and Registry, um den ,Template Editor* (Vorlagen-
Editor) zu &ffnen.

2. Klicken Sie auf Add (Hinzuftigen), wahlen Sie den Subtask Deploy Files (Dateien bereitstellen)
aus und klicken Sie anschlief3end auf OK.

3. Fugen Sie die Dateien, die tbertragen werden sollen, hinzu, in dem Sie auf Add from local (Von
lokalem Speicherort hinzufiigen) klicken oder auf Choose upload (Hochgeladene wahlen).

4. Klicken Sie auf OK, wenn Sie die Angabe der Dateien abgeschlossen haben.

5. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fiir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefugt.

6. Ziehen Sie die Vorlage per Drag-and-Drop auf die gewiinschten Geréate.

7. Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Léschen von Dateien
So I6schen Sie Dateien von Geraten:

1. Doppelklicken Sie auf die Vorlage _File and Registry, um den ,Template Editor* (Vorlagen-
Editor) zu &ffnen.

2. Klicken Sie auf Add (Hinzuftigen), wahlen Sie den Subtask Delete Files (Dateien I6schen) aus
und klicken Sie anschlielend auf OK.

3. Fugen Sie die Dateien oder Verzeichnisse hinzu, die geléscht werden sollen. Jede Zeile hat eine
der folgenden Optionen:

Verwalten von normalen Thin Clients 45



e File or Folder Name (Datei- oder Verzeichnisname) — Geben Sie den Datei- oder
Verzeichnisnamen an, der geldscht werden soll. Die Platzhalter * und ? werden auch
unterstatzt.

e Path On Device (Pfad auf dem Gerat) — Geben Sie den Pfad auf dem Gerat an, unter dem
sich die Datei oder das Verzeichnis befindet.

e Delete Recursively (Rekursiv 16schen) — Stellen Sie diese Option auf Yes (Ja) ein, wenn
Sie alle Dateien oder Verzeichnisse I6schen mdchten, die dem Muster entsprechen, das in
File or Folder Name (Datei- oder Verzeichnisname) in allen Unterverzeichnissen unter Path
On Device (Pfad auf dem Geréat) eingegeben wurde. Stellen Sie diese Option auf No
(Nein), sind keine Unterverzeichnisse betroffen.

4. Kilicken Sie auf OK, wenn Sie die Angabe der Dateien abgeschlossen haben.

Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fir die neue Vorlage ein und
klicken Sie anschlielfend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefiigt.

6. Ziehen Sie die Vorlage per Drag-and-Drop auf die gewlinschten Geréate.

7. Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Verwalten der Registry-Einstellungen des Gerats
Sie kdnnen die Registry-Einstellungen des Gerats auf folgende Arten verwalten:

° Klonen von Registry-Einstellungen auf Seite 46

° Hinzuflgen, Bearbeiten und Loschen von Registry-Einstellungen auf Seite 47

Klonen von Registry-Einstellungen
So klonen Sie Registry-Einstellungen eines Geréts:

1. Doppelklicken Sie auf die Vorlage _Get Registry, um den ,Template Editor* (Vorlagen-Editor) zu
offnen.

2. Klicken Sie auf Add (Hinzufiigen), geben Sie den Namen des Registry-Knotens ein, von dem Sie
Klon-Einstellungen abrufen méchten (zum Beispiel Desktop fiir Desktopeinstellungen) und
klicken Sie anschlieffend auf OK. Der Knoten wird auf der Registerkarte Registry im , Template
Editor* (Vorlagen-Editor) angezeigt.

3. Geben Sie in das Feld Save result as template (Ergebnis als Vorlage speichern) einen Namen
fur die Ergebnis-Vorlage ein, die zum Speichern der geklonten Registry-Einstellungen erstellt
wird.

4. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fiir die neue Vorlage ein und
klicken Sie anschlielfend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefiigt.

5. Ziehen Sie die Vorlage per Drag-and-Drop auf das gewuinschte Gerat.
6. Klicken Sie auf OK, um den Task auf das Gerat anzuwenden.

Die Registry-Einstellungen werden geklont und in einer neuen Vorlage unter dem Namen
gespeichert, den Sie im Feld Save result as template (Ergebnis als Vorlage speichern) angegeben
haben.

¥ TIPP: Sie konnen die geklonten Registry-Einstellungen anzeigen, indem Sie auf die neue Vorlage
doppelklicken, auf den Subtask Registry doppelklicken und den Registry-Knoten im Registry Tree
(Registry-Struktur) erweitern.
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Hinzufligen, Bearbeiten und L&schen von Registry-Einstellungen

So fugen Sie Registry-Einstellung hinzu, bearbeiten oder lI6schen diese:

1.

5.
6.

Wenn Sie eine bereits aus einem Task des Typs _Get Registry generierte Ergebnis-Vorlage
verwenden méchten, doppelklicken Sie auf diese Vorlage und doppelklicken Sie anschlieftend
auf den Subtask Registry.

Wenn Sie eine neue Vorlage erstellen méchten, doppelklicken Sie auf die Vorlage _File and
Registry, um den ,Template Editor* (Vorlagen-Editor) zu 6ffnen und klicken Sie anschlieRend auf
Add (Hinzufligen). Wahlen Sie den Subtask Registry und klicken Sie anschlieRend auf OK.

Konfigurieren Sie bei Bedarf die Registry-Einstellungen im Editor. Sie kdnnen hierbei die
folgenden Methoden anwenden:

e Verwenden Sie den Registry Tree (Registry-Struktur), um im Registry-Knoten zu navigieren
und Registry-Schlissel und Werte hinzuzufligen, umzubenennen oder zu léschen.

e Verwenden sie den Bereich Registry Settings (Registry-Einstellungen), um Werte zu dem
ausgewahlten Registry-Schlissel hinzuzufligen oder zu I6schen.

e Verwenden Sie den Bereich Action to Perform (Malinahme flr Durchfiihrung), um einen
Registry-Schlissel hinzuzufiigen oder zu 16schen. Wenn Sie einzelne Schlisselwerte im
Bereich ,Registry Settings” (Registry-Einstellungen) gedndert haben, werden die Optionen
in diesem Bereich ausgegraut.

e Kilicken Sie auf Import Registry File (Registry-Datei importieren), um Registry-Einstellungen
zu importieren.

Klicken Sie auf OK, wenn Sie die Bearbeitung der Registry-Einstellungen abgeschlossen haben.

Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefiigt.

Ziehen Sie die Vorlage per Drag-and-Drop auf die gewiinschten Geréate.

Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Remotegesteuerte Ausfiihrung von Befehlen

HPDM kann Befehle remotegesteuert auf einem Gerat mithilfe der Vorlage _File and Registry
ausflihren. In diesem Kontext bedeutet Befehl alles, was unter dem Betriebssystem des Gerats
ausflihrbar ist. Dazu zahlt Folgendes:

Anwendungen
DOS-Batch-Dateien
Windows-Skripts

[ WICHTIG: Sie kdénnen jeden Befehl eingeben. HP empfiehlt jedoch, dass diese Befehle zuerst auf
einem Gerat getestet werden.

So flhren Sie Befehle remotegesteuert auf einem Geréat aus:

1.

Doppelklicken Sie auf die Vorlage _File and Registry, um den ,Template Editor® (Vorlagen-
Editor) zu 6ffnen.

Klicken Sie auf Add (Hinzufiigen), wahlen Sie den Subtask Command (Befehl) aus und klicken
Sie anschlieflend auf OK.
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9.

Geben Sie im Editor in der Spalte Command (Befehl) den Befehl ein.

‘¢ TIPP: Die Windows-Umgebungsvariable PATH kann auf jedem Gert anders eingestellt sein.

Es ist daher wichtig, fir jeden Befehl den vollstandigen Pfad einzugeben, um sicherzustellen,
dass der Befehl auf dem Gerat gefunden werden kann. Beispiel: Um xxx . exe im Verzeichnis
C:\Program Files auszufiihren, geben Sie den Befehl in der Form C:\Program Files
\xxx.exe ein.

Wahlen Sie in der Spalte Execute After Reboot (Nach Neustart ausfiihren) die Option Yes (Ja),
wenn das Gerat vor Ausfiihrung des angegebenen Befehls neu gestartet werden soll.

Wahlen Sie in der Spalte Wait (Warten) Yes (Ja), wenn vor der Ausfihrung des Befehls erst der
vorige Befehl abgeschlossen werden soll.

Wenn Sie weitere Befehle hinzufigen mdchten, klicken Sie auf Add (Hinzufligen).
Klicken Sie auf OK, wenn Sie die Bearbeitung der Registry-Einstellungen abgeschlossen haben.

Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fiir die neue Vorlage ein und
klicken Sie anschliefend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugeflgt.

Ziehen Sie die Vorlage per Drag-and-Drop auf die gewiinschten Geréate.

10. Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Remotegesteuerte Ausfiihrung von Windows-Skripts

Windows Script Host ist eine umfassende Infrastruktur fiir die Skript-Erstellung, die die Scripting-
Engines Microsoft Visual Basic Scripting Edition und Microsoft Jscript zur Verfligung stellt. Diese
Engines kénnen in Windows-Anwendungen eingebettet werden, damit Windows-Anwendungsskripts
leichter erstellt werden kénnen.

Gehen Sie flir weitere Informationen zum Erstellen von Windows-Skripts auf die Seite
http://www.msdn.microsoft.com und suchen Sie nach Windows Script (Windows-Skript).

So fiihren Sie Windows-Skripts als Befehl unter Verwendung von HPDM aus:

A Figen Sie vor das auszufihrende Skript wscript ein.

[%,/r HINWEIS: wscript.exe befindet sich unter C: \Windows\system32.

Anhalten eines Tasks des Typs ,_File and Registry*

Sie kdnnen einen Task des Typs _File and Registry anhalten, um auf bestimmte Ereignisse wie einen
Systemneustart zu warten.

So figen Sie einen Subtask Pause (Anhalten) zu einem Task des Typs _File and Registry hinzu:

1.

2.

Klicken Sie im ,Template Editor* (Vorlagen-Editor) einer Vorlage des Typs _File and Registry auf
Add (Hinzufligen), wahlen Sie den Subtask Pause (Anhalten) aus und klicken Sie anschliel3end
auf OK.

Geben Sie die Dauer der Pause an und klicken Sie anschliefend auf OK.

Hinzufligen oder Entfernen von Progammaufzeichnungen

So fligen Sie Progammaufzeichnungen hinzu oder 16schen sie:
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1. Doppelklicken Sie auf die Vorlage _File and Registry, um den ,Template Editor* (Vorlagen-
Editor) zu 6ffnen.

2. Klicken Sie auf Add (Hinzuftigen), wahlen Sie den untergeordneten Task Program Record
(Programmaufzeichnung) und klicken Sie anschlieRend auf OK.

Klicken Sie im Editor ,Program Record“ (Programmaufzeichnung) auf Add (Hinzufligen).
Geben Sie den Aktionstyp an (Hinzufligen oder Entfernen).

Geben Sie, wenn nétig, den Herausgeber, die Version und Kommentare an.

o o &~ w

Klicken Sie auf OK, wenn Sie die Bearbeitung der Programmaufzeichnungen abgeschlossen
haben.

7. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefigt.

8. Ziehen Sie die Vorlage per Drag-and-Drop auf die gewtiinschten Geréate.

9. Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Ausflihren eines Skripts
So fuhren Sie auf einem Gerat ein Skript aus:

1. Doppelklicken Sie auf die Vorlage _File and Registry, um den ,Template Editor* (Vorlagen-
Editor) zu 6ffnen.

2. Klicken Sie auf Add (Hinzuftigen), wahlen Sie den Subtask Script (Skript erstellen) aus und
klicken Sie anschlieRend auf OK.

3. Geben Sie im Editor den Inhalt des Skripts an.

7 WICHTIG: HPDM unterstiitzt in Windows nur Batch-Skripts und in Linux nur Shell-Skripts.

4. Nur fir Windows-Plattformen: Geben Sie, wenn nétig, den Pfad an, in dem das Skript gestartet
werden soll.

5. Nur fur Windows-Plattformen: Geben Sie, wenn nétig, das Benutzerkonto an, fir das das Skript
ausgefihrt werden soll.

6. Klicken Sie auf OK, wenn Sie die Bearbeitung des Skripts abgeschlossen haben.

7. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fiir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefugt.

8. Ziehen Sie die Vorlage per Drag-and-Drop auf die gewlinschten Geréate.

9. Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Zertifikate mit SCEP registrieren

So registrieren Sie Zertifikate mit SCEP:

1. Doppelklicken Sie auf die Vorlage _Enroll Certificate with SCEP, um den ,Template Editor*
(Vorlagen-Editor) zu 6ffnen.

2. Geben Sie die URL fiir die Registrierung an und das Abfrage-Passwort.

Verwalten von normalen Thin Clients



3. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefigt.

4. Ziehen Sie die Vorlage per Drag-and-Drop auf das gewlinschte Gerat.

Klicken Sie auf OK, um den Task auf das Gerat anzuwenden.

Verwalten von PColP Zero Clients

Erfassen von Verbindungen

So zeichnen Sie Verbindungen von einem PColP Zero Client auf:

1. Doppelklicken Sie auf die Vorlage _Capture Connections, um den ,Template Editor (Vorlagen-
Editor) zu &ffnen.

2. Geben Sie in das Feld Save result as template (Ergebnis als Vorlage speichern) einen Namen
fur die Ergebnis-Vorlage ein, die zum Speichern der erfassten Verbindungen erstellt wird.

3. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen flr die neue Vorlage ein und
klicken Sie anschliefend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugeflgt.

4. Ziehen Sie die Vorlage per Drag-and-Drop auf das gewlinschte Gerat.

5.  Klicken Sie auf OK, um den Task auf das Gerat anzuwenden.

Die Verbindungen werden geklont und in einer neuen Vorlage unter dem Namen gespeichert, den
Sie im Feld Save result as template (Ergebnis als Vorlage speichern) angegeben haben.

Bereitstellen von Verbindungen

So stellen Sie Verbindungen fiir PColP Zero Clients bereit:

1. Doppelklicken Sie auf die Vorlage _Deploy Connections oder die Ergebnis-Vorlage eines Tasks
des Typs _Capture Connections, um den ,Template Editor* (Vorlagen-Editor) zu &ffnen.

2. Wahlen Sie, wenn nétig, den Verbindungstyp und stellen Sie die Werte ein.

3. Klicken Sie auf Save as (Speichern unter), geben Sie einen Namen fir die neue Vorlage ein und
klicken Sie anschlieRend auf OK. Die Vorlage wird zur Registerkarte Task Templates (Task-
Vorlagen) im Task-Bereich hinzugefigt.

4. Ziehen Sie die Vorlage per Drag-and-Drop auf die gewlinschten Geréate.

Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.
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Aktualisieren der Firmware

So aktualisieren Sie Firmware auf PColP Zero Clients:

1.

Wabhlen Sie aus dem HPDM Console-Menl Template > Import > PColP firmware (Vorlage >
Importieren > PColP-Firmware).

Klicken Sie auf Browse (Durchsuchen), wahlen Sie eine Firmware-Datei (.all) aus und klicken
Sie anschliefiend auf Import (Importieren).

Klicken Sie auf Generate (Erstellen) und warten Sie, bis die Vorlage erfolgreich generiert wurde.

Die Vorlage wird zur Registerkarte Task Templates (Task-Vorlagen) im Task-Bereich
hinzugefugt.

Ziehen Sie die Vorlage per Drag-and-Drop auf die gewtinschten Geréate.

Klicken Sie auf OK, um den Task auf die Gerate anzuwenden.

Verwalten von PColP Zero Clients
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6 Imageerstellungsvorgange

HPDM kann dazu verwendet werden, ein Image eines Gerats zu aufzuzeichnen und auf einer
beliebigen Anzahl ahnlicher Geréte bereitzustellen. Ein Image (IMG-Datei) ist eine binare Datei, die
alle Daten vom Flashspeicher eines Geréats enthalt.

7 WICHTIG: Von HPDM werden keine Images auf Geraten bereitgestellt, die fir das im Image
enthaltene Betriebssystem nicht lizenziert sind.

{} TIPP: Fir HP ThinPro oder HP Smart Zero Core findet keine Lizenzlberprifung statt, so dass diese
Betriebssysteme ausgetauscht werden kdnnen, solange gentigend Festplattenspeicher vorhanden
ist.

Weitere Informationen zur Imaging-Unterstitzung auf unterschiedlichen Betriebssystemen finden Sie
unter Imageerstellung Support Matrix auf Seite 52.

Weitere Informationen zu den verschiedenen Imageerstellung-Methoden, die mit HPDM mdéglich sind,
finden Sie in den folgenden Abschnitten:

e Imageerstellung ohne PXE auf Seite 53 (Empfohlen)

° Imageerstellung mit PXE auf Seite 56

Imageerstellung Support Matrix

Die folgende Tabelle beschreibt, welche Betriebssysteme und HP Thin Clients fiir jede
Imageerstellung-Methode unterstitzt werden.

Tabelle 6-1 Imageerstellung Support Matrix

Dateibasiertes Diskbasiertes Dateibasierte Diskbasierte PXE-
Erfassen Erfassen Bereitstellung Bereitstellung  Imageerstellung

WES 8
t610

WES 7

820, 1620, t610, t510, t505, N J J
t5740e, t5570e, 6360t, mt41,
mt40, 4320t

WES 2009

610, 510, t505, t5740, 15570, v v v v
gt7720

WES 2009
6360t, t5400, 4320t

Windows XPe
t5740, t5730, t5630

HP ThinPro 4

1620, 1610, t510, t505, t5745, v ) v
5565
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Tabelle 6-1 Imageerstellung Support Matrix (Fortsetzung)

Dateibasiertes Diskbasiertes Dateibasierte Diskbasierte PXE-
Erfassen Erfassen Bereitstellung Bereitstellung  Imageerstellung

HP ThinPro 3 (x86)
15745, 15735, t5565, 15545, v v v
t5145, gt7725
HP ThinPro 3 (ARM)
T5325
HP Smart Zero Core (x86)
1620, 1610, t510, t5565z ) )
HP Smart Zero Core (ARM)
t410, t5335z ) )
Windows Embedded CE 6.0

N N N

t510, 156550, t5540, t5530

i WICHTIG: Eine komplette Versionspriifung des Images ist bei der PXE-Imageerstellung nicht

ERk

£AK)

verflgbar (z. B. ist Windows XPe Version 5.1.502 kompatibel mit BIOS-Version 786A1 aber nicht mit
einer anderen BIOS-Version).

WICHTIG: Wenn ein WES 7- oder WES 8-Image von einem anderen HP Thin Client Modell erfasst
wurde, werden Treiber fehlen. Zum Beispiel wird ein Image, das von einem t610 erfasst wurde nicht
funktionieren, wenn es auf einem t5570e bereitgestellt wird.

WICHTIG: Eine PXE-Imageerstellung funktioniert aufgrund gewisser Anderungen bei den
Ordnernamen nicht mit dem standardmafiigen HPDM Agent in einem HP ThinPro 3-Image.
Aktualisieren Sie den HPDM Agent auf die neueste Version, bevor Sie einen PXE-Imageerstellung-
Versuch starten.

B HINWEIS: Dateibasierte Imageerstellung ist die von HPDM aktuell angewendete Methode fur WES

Imageerstellung. Die urspriingliche Imageerstellung-Methode, die von HPDM in der Version 4.4.2 und
davor verwendet wurde, war diskbasiertes Imageerstellung.

B HINWEIS: PXE-Imageerstellung wird auf 6360t, t5400 oder 4320t nicht unterstitzt, da die Tools zur

Veranderung der Boot-Reihenfolge nicht verfigbar sind.

Imageerstellung ohne PXE

2

Imageerstellung ohne PXE ist die empfohlene Imageerstellungs-Methode mit HPDM und sie
erfordert, dass der HPDM Agent auf dem Ziel-Gerat lauft, wenn der Imageerstellungs-Task gesendet
wird. Der Vorteil von Imageerstellung ohne PXE besteht darin, dass ein HPDM Gateway nicht in
demselben Subnetz wie die Zielgerate installiert sein muss.

TIPP: Fir WES muss sichergestellt sein, dass die Gerate auf den freigegebenen Ordner des
Master-Repositorys zugreifen kdnnen und Schreibberechtigung haben. Die Gruppenrichtlinie kann
sich auf Schreibberechtigungen auswirken, wenn sich der freigegebene Ordner, auf den zugegriffen
werden soll, in einer Domane befindet.
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Aufzeichnung eines Images ohne PXE

So erfassen Sie ein Image ohne PXE:

1. Wahlen Sie im Task-Bereich die Registerkarte Task Templates (Task-Vorlagen) aus und
doppelklicken Sie dann auf die Vorlage _Capture Image.

2. Geben Sie in dem Dialogfeld Template Editor - Imaging einen Namen fir das aufgenommene
Image in das Feld Image Name ein, der im Master-Repository gespeichert wird. Geben Sie dann
Informationen fir das aufgenommene Image in das Feld Description (Beschreibung) ein.

3. Verwendet das Gerat ein drahtloses Netzwerk, wahlen Sie Cached Imaging (Gecachte
Imageerstellung).

Ef HINWEIS: Wenn die Option Cached Imaging (Gecachte Imageerstellung) ausgewahlt wurde,
so wird ausreichend freier Speicherplatz auf dem Gerat bendétigt, um das erfasste Image zu
cachen.

4. Klicken Sie auf die Schaltflache Save as (Speichern unter), geben Sie einen Namen fir die
Vorlage ein und klicken Sie anschlieRend auf OK. Im Task-Bereich wird eine neue Vorlage
aufgelistet.

5. Ziehen Sie die Vorlage per Drag-and-Drop auf ein Gerat im Gerate-Bereich. Das Dialogfeld Task
Editor (Task-Editor) wird angezeigt.

6. Geben Sie in das Feld Save result as template (Ergebnis als Vorlage speichern) einen Namen
fur die Ergebnis-Vorlage ein, die automatisch erstellt wird, um es Ihnen zu erméglichen, das
erfasste Image auf anderen Geraten zu installieren.

7.  Klicken Sie auf OK, um den Task direkt auf das Gerat anzuwenden. Wenn der Task versendet
wurde, wird daraus eine Ergebnis-Vorlage mit dem von |hnen ausgewahlten Namen erstellt. Der
Anfangsstatus der Vorlage lautet ,Transferring® (Wird Ubertragen).

8. Wenn der HPDM Agent auf dem Gerat den Task empfangt, gibt das Gerat eine Warnmeldung
aus, die anzeigt, dass das Gerat in 30 Sekunden neu gestartet wird. Nachdem das Gerat neu
gestartet worden ist, kopiert ein Aufzeichnungs-Dienstprogramm den Inhalt des Flashspeichers
in das Master-Repository.

E,?’?" HINWEIS: Ein WES-Image wird als .ibr-Datei gespeichert, und ein HP ThinPro oder HP Smart
Zero Core Image wird als .dd.gz-Datei gespeichert.

9. Nach dem Abschluss der Erfassung wird das Gerat neu gestartet.
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[ WICHTIG: Schalten Sie das Gerat wahrend dieser Zeit NICHT aus!

AnschlielRend wird das Geréat erneut gestartet.

10. Der Task-Bereich in der HPDM Console zeigt wahrenddessen weiterhin an, dass der Task
verarbeitet wird. Das erfasste Image wird komprimiert. Nachdem der Task abgeschlossen ist
und die Prufsumme des erfassten Images Uberprift wurde, erscheint eine neue Vorlage mit dem
von lhnen angegebenen Namen in der Registerkarte Task Templates (Task-Vorlagen) im Task-
Bereich.

11. Sie kdnnen die Vorlage nun dazu benutzen, das erfasste Image bei anderen Geraten
anzuwenden, indem Sie sie mit der Maus auf die Gerate im ,Device Pane” (Gerate-Bereich)
oder Ordner in der Geratestruktur ziehen und ablegen.

AuBRerdem kénnen Sie Informationen zum mit der Vorlage verkniipftem Image anzeigen, indem Sie
auf den Namen der Vorlage doppelklicken, um das Dialogfeld mit dem Template Editor zu &ffnen.
Dadurch wird der Name und der Betriebssystemtyp des Image angezeigt. Klicken Sie auf die
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Schaltflache View Details (Details anzeigen), um sich detaillierte Informationen des Image anzeigen
zu lassen.

Beibehaltene Einstellungen wahrend einer Imageaufnahme ohne PXE

Tabelle 6-2 Beibehaltene Einstellungen wéhrend einer Imageaufnahme ohne PXE

Betriebssystem Beibehaltene Einstellungen

WES 8 Alle Einstellungen vom Quell-Geréat - ausgenommen Hostname, Netzwerkeinstellungen,
Domaneneinstellungen und Schreibfilter-Status - werden sowohl auf dem Quell-Geréat als

WES 7 auch dem aufgenommenen Image beibehalten.

WES 2009

HP ThinPro Alle Einstellungen vom Quell-Gerat werden ausgenommen von Hostname und
Netzwerkeinstellungen sowohl auf dem Quell-Geréat als auch dem aufgezeichneten Image

HP Smart Zero Core beibehalten.

TIPP: Wenn das Quell-Gerat bei WES 7 und WES 2009 vor der Aufnahme eines Images mit einer Domane verknupft
wurde, geht die Domanenmitgliedschaft nach Aufzeichnung des Images verloren. Es wird empfohlen, das Quell-Gerat vor
der Image-Aufzeichnung von jeder Doméane zu trennen. Es gibt auch ein bekanntes Problem, in der die Gruppenrichtlinie,
welche die Komplexitat des Domanenkennwortes steuert, lokale Benutzerkonten beeinflusst, wobei es zu einer
Benutzeraufforderung kommt, das Kennwort zu &ndern, um strengere Kriterien zu erftllen.

Bereitstellung eines Images ohne PXE

Es gibt keine Preset-Vorlage fur die Bereitstellung eines Images ohne PXE, aber sie Iasst sich durch
die Aufzeichnung eines Images oder das Importieren einer existierenden Image-Datei erstellen.

So stellen Sie ein Image ohne PXE bereit:

1. Erstellen Sie eine Bereitstellungsvorlage, indem Die ein Image ohne PXE aufzeichnen (siehe
Aufzeichnung eines Images ohne PXE auf Seite 54).

- oder -

Klicken Sie im Menu auf Vorlage > Importieren > Imagedateien > ohne PXE .... Daraufhin wird
der Assistent automatisch eine Bereitstellungsvorlage erstellen.

2. Doppelklicken Sie auf die Bereitstellungsvorlage, um den Template Editor zu 6ffnen.

3. Kiicken Sie auf die Schaltflache View Details (Details anzeigen), um sich detaillierte
Informationen Uber das Image-Paket anzeigen zu lassen.

4. Verwendet das Gerat ein drahtloses Netzwerk, wahlen Sie Cached Imaging (Gecachte
Imageerstellung).
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B HINWEIS: Wenn die Option Cached Imaging (Gecachte Imageerstellung) ausgewahlt wurde,
erfordert dies genug freien Speicherplatz auf der Seite des Gerats, um das Image zu cachen.

[%,2]9 HINWEIS: Im gecachten Modus unterstiitzt HPDM nur das Bereitstellen von Images im
Format .ibr fir WES-Geréate oder Images im Format .dd.gz fiir HP ThinPro-Geréate.

5.  Wenn Sie ein Image fir ein Gerat bereitstellen wollen, das zu einer anderen Hardware-Plattform
gehort als das Ursprungsgerat, dann wahlen Sie die Option Allow Cross Platform Imaging
(Image-Erstellung Gber verschiedene Plattformen) aus. Diese Option gilt nur fir WES, und Sie
missen sicherstellen, dass das Image auf dem Zielgerat gut funktioniert.

6. Klicken Sie auf Save as (Speichern unter), um die Vorlage unter einem neuen Namen zu
speichern.
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7. Ziehen Sie die Vorlage auf die Gerate, fir die Sie das Image bereitstellen mochten. Das
Dialogfeld von Task Editor wird angezeigt, in dem Sie dieselben Optionen wie im Template
Editor bearbeiten kénnen.

8. Klicken Sie auf OK, um das Image fir die Gerate bereitzustellen.
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[ HINWEIS: Es gibt ein automatisches BIOS-Update wahrend der Task ,Deploy Image* (Image

bereitstellen), um WES7 SP1 auf t5740 und t5740e zu installieren. Die standardmafige BIOS-
Version ist 1.03 bei t5740 und t5740e und WES7 SP1 bendtigt die Version 1.04.

Beibehaltene Einstellungen wahrend einer Imagebereitstellung ohne PXE

Tabelle 6-3 Beibehaltene Einstellungen wahrend einer Imagebereitstellung ohne PXE

Betriebssystem Beibehaltene Einstellungen
WES 8 e  Schreibfilter-Status
WES 7 e Hostname
WES 2009 e  Netzwerkeinstellungen
e  Terminaldienste-Lizenz
e  Aktivierung von Windows-Lizenz (nur WES 8)
HP ThinPro e Hostname
HP Smart Zero Core e  Netzwerkeinstellungen

Imageerstellung mit PXE

Die Imageerstellung mit PXE erfordert die Installation eines HPDM Gateway (wozu ein PXE-Server
gehdrt) in demselben Subnetz wie die Ziel-Gerate. Der Vorteil der Imageerstellung mit PXE besteht
darin, dass das Betriebssystem des Gerats wahrend einer Image-Bereitstellung nicht laufen muss,

d. h. Sie kdnnen ein Image auf einem Gerat mit einem beschadigten Betriebssystem bereitstellen.

¥ TIPP: Méglicherweise sind einige zusétzliche Konfigurationen fur eine PXE-Imageerstellung

erforderlich. Bei Problemen mit der Verwendung von PXE-Imageerstellung finden Sie weiterfihrende

Informationen unter Konfigurieren |hrer Umgebung fur eine PXE-Imageerstellung auf Seite 57.

Aufzeichnung eines Images mit PXE

56

So erfassen Sie ein Image mit PXE:

1. Wahlen Sie die Registerkarte Task Templates (Task-Vorlagen) aus, und doppelklicken Sie auf

die Vorlage _PXE Capture (PXE-Aufnahme).

2. Geben Sie unter ,Image Name* einen Image-Namen und unter ,Description” eine Beschreibung

ein.

3. Klicken Sie auf Save as (Speichern), um die Vorlage zu speichern.

Eine neue PXE-Aufnahmevorlage wird in der Liste ,Task Templates® (Task-Vorlagen)

aufgelistet.

4. Ziehen Sie die Vorlage auf ein Gerat und geben Sie dann einen passenden Namen fiir die
Ergebnis-Vorlage an. Klicken Sie auf OK, um den PXE-Aufzeichnungs-Task an ein Gerét zu

senden.
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5.  Wenn der Task versendet wurde, wird daraus eine Ergebnis-Vorlage mit dem von lhnen
ausgewahlten Namen erstellt. Der Anfangsstatus lautet ,Transferring® (Wird Gbertragen).

6. Nachdem der Task beendet wurde, ist die Ergebnis-Vorlage glltig und kann dazu verwendet
werden, Tasks zu senden.

[%f’ HINWEIS: Ein fur die PXE-Imageerstellung erfasstes Bild hat unabhéangig vom Betriebssystem
immer das Format .dd.gz.

Bereitstellung eines Images mit PXE

Es gibt keine Preset-Vorlage fir die Bereitstellung eines Images mit PXE, aber sie lasst sich durch
die Aufzeichnung eines Images oder das Importieren einer existierenden Image-Datei erstellen.

So stellen Sie ein Image mit PXE bereit:

1. Erstellen Sie eine Bereitstellungsvorlage, indem Die ein Image mit PXE aufzeichnen (siehe
Aufzeichnung eines Images mit PXE auf Seite 56).

- oder -

Klicken Sie im Menu auf Vorlage > Importieren > Imagedateien > Bereitstellung mit PXE ....
Daraufhin wird der Assistent automatisch eine Bereitstellungsvorlage erstellen.

2. Ziehen Sie die Bereitstellungsvorlage auf ein Gerat.

Ef HINWEIS: Bereitstellung durch PXE unterstiitzt das Bereitstellen von Images mit der
Dateiendung .dd.gz, .dd, .img oder .hpimg.

B HINWEIS: Wenn Sie ein Image einem heruntergefahrenen Gerét bereitstellen wollen, dann muss
dieses Gerét Starten per Fernsteuerung unterstitzen und im BIOS die Einstellung ,network boot first®
vorgenommen werden.

Konfigurieren lhrer Umgebung fir eine PXE-Imageerstellung

In den folgenden Abschnitten werden einige Konfigurationen aufgezeigt, die moglicherweise fur die
PXE-Imageerstellung erforderlich sind:

° Konfigurieren eines DHCP-Servers fir die PXE-Imageerstellung

° Konfigurieren von Routern fiir die PXE-Imageerstellung

° Konfigurieren von BIOS-Einstellungen auf vorhandene, altere Neoware-Geréte fir die PXE-
Imageerstellung

Konfigurieren eines DHCP-Servers fir die PXE-Imageerstellung

In diesem Abschnitt wird beschrieben, wie Sie einen DHCP-Server fiir die PXE-Imageerstellung
konfigurieren. Der DHCP-Server nutzt die PXE-Boot-ROM zum Abrufen grundlegender
Netzwerkinformationen.

DHCP-Server und HPDM-Server sind auf verschiedenen Computern installiert

Sollten Probleme bei der PXE-Imageerstellung auftreten, missen mdglicherweise gewisse
Einstellungen des DHCP-Servers auf Konflikte mit PXE Uberpruft werden. Allerdings sollten bei den
meisten Netzwerken diese Probleme nicht auftreten.

Imageerstellung mit PXE 57



So konfigurieren Sie den DHCP-Server:

1. Vergewissern Sie sich, dass der DHCP-Server vorher noch nicht fir einen PXE-Bootstrap
konfiguriert wurde.

2. Vergewissern Sie sich, dass die DHCP-Optionen 43 und 60 nicht eingestellt sind.

Der DHCP-Server sollte dann mit PXE verwendet werden kdnnen.

DHCP-Server und HPDM Server sind auf demselben Computer installiert

Wenn HDPM Server und DCHP-Server zusammen auf demselben Computer installiert sind, missen
einige Dinge manuell konfiguriert werden.

Fuahren Sie die folgenden Aktionen aus:

e Das Netzwerk ist bereits fiir die Verwendung von DHCP konfiguriert.

e  Der DHCP-Server wurde vorher noch nicht fur einen PXE-Bootstrap konfiguriert.
e Innerhalb des Netzwerks werden keine anderen TFTP-Server ausgefiihrt.

So konfigurieren Sie den DHCP-Server:

1. Vergewissern Sie sich, dass DHCP-Option 43 nicht eingestellt ist.

2. Fugen Sie DHCP-Option 60 folgendermafien hinzu:

a. Klicken Sie im Start-Meni von Windows auf Start > Ausfihren.

% TIPP: Klicken Sie im Windows Server 2012 mit der rechten Maustaste auf die linke untere
Ecke des Desktops und wahlen Sie Ausfiihren.

b. Geben Sie "cmd" ein und klicken Sie OK zum Offnen einer Eingabeaufforderung.
c. Geben Sie netsh ein, und driicken Sie die Eingabetaste.
d. Geben Sie dhcp ein, und driicken Sie die Eingabetaste.

e. Geben Sie server \\<server name> (unter Verwendung des UNC-Namens fir den
Server) ein:

- oder -
Geben Sie server <IP-Adresse> (unter Verwendung der IP-Adresse des Servers) ein.

Im Befehlszeilenfenster wird eine Eingabeaufforderung mit dem Préafix dhcp server >
angezeigt.

f. Geben Sie add optiondef 60 <frei gewidhlter Name> STRING O ein, und
driicken Sie die Eingabetaste.

g. Geben Sie set optionvalue 60 STRING "PXEClient" ein, und driicken Sie die
Eingabetaste.

h. Um die Korrektheit der Einstellungen zu Uberprifen, geben Sie show optionvalue all
ein, und driicken Sie die Eingabetaste.

3. Fugen Sie DHCP-Option 201 folgendermalfien hinzu:
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a. Geben Sie in die dhcp server > Eingabeaufforderung add optiondef 201 <frei
gewadhlter Name> STRING 0 ein und driicken Sie die Eingabetaste.

b. Geben Sie set optionvalue 201 STRING 'HPDM Gateway IP Address'
'40003" ein, und driicken Sie die Eingabetaste.

Bf HINWEIS: <HPDM Gateway IP Address> verweist auf die Adresse des Servers, auf
dem der HPDM Gateway-Dienst ausgefiihrt wird. Dieser Befehl muss genau wie oben
beschrieben eingegeben werden, einschliellich der einfachen Anflihrungszeichen und
einzelnen Leerzeichen, wie im folgenden Beispiel aufgezeigt:

set optionvalue 201 STRING '192.168.1.100" ‘40003’

c. Um die Korrektheit der Einstellungen zu tberprifen, geben Sie show optionvalue all
ein, und driicken Sie die Eingabetaste.

Der DHCP-Server sollte dann mit PXE verwendet werden konnen.

Konfigurieren eines Linux DHCP-Servers fiir die PXE-Imageerstellung

1. Bearbeiten Sie die Konfigurationsdatei fliir den DHCP-Server /etc/dhcpd.conf. Fligen Sie am
Anfang der Datei exakt die folgenden Zeilen hinzu::

ddns-update-style ad-hoc;

Authoritative;

Option NDM code 201 =string;

Option vendor-class-identifier “PXEClient”;
Option NDM "“‘<HPDM Gateway IP Address>’ '40003"";
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[ HINWEIS: <HPDM Gateway IP Address> verweist auf die Adresse des Servers, auf dem
der HPDM Gateway-Dienst ausgefiihrt wird. Dieser Befehl muss genau wie oben beschrieben
eingegeben werden, einschlielilich der doppelten Anfliihrungszeichen und einzelnen
Leerzeichen, wie im folgenden Beispiel aufgezeigt:

Option NDM “'192.168.1.100" ‘40003"";

2. Starten Sie dhcpd neu, um die gednderte Konfiguration zu verwenden.

Konfigurieren von Routern fiir die PXE-Imageerstellung

Damit die PXE-Imageerstellung ordnungsgemaf funktioniert, sollte jedes Netzwerk, das DHCP
verwendet und mehrere Subnetze aufweist, einen IP Helper im Router zwischen Geraten, die eine
dynamische IP-Adresse bendtigen, und dem DHCP-Server konfiguriert haben. Auf dem Router muss
eine zusatzliche IP Helper-Adresse konfiguriert sein, die auf das HPDM Gateway verweist.

Das folgende Beispiel verwendet einen Cisco Router:
1.  Gehen Sie auf den Modus Global Configuration.
2. Geben Sie ip forward-protocol udp 67 ein, und driicken Sie die Eingabetaste.
3. Geben Sie ip forward-protocol udp 68 ein, und driicken Sie die Eingabetaste.

4, Geben Sie ip helper-address <DHCP-Server-IP-Adresse> ein, und driicken Sie die
Eingabetaste.

5. Geben Sie ip helper-address <HPDM Gateway-IP-Adresse> ein, und driicken Sie die
Eingabetaste.

Ef HINWEIS: Die oben erwahnten IP-Adressen sollten ohne die spitzen Klammern < und >
eingegeben werden.
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Konfigurieren von BIOS-Einstellungen auf vorhandene, dltere Neoware-Geréte fiir die PXE-
Imageerstellung

Bevor Sie ein Image mit PXE auf vorhandenen, alteren Neoware-Geraten aufzeichnen oder
bereitstellen kénnen, missen Sie sicherstellen, dass die Quell- und Zielgerate tiber korrekt
konfigurierte BIOS-Einstellungen verfligen.

So konfigurieren Sie die BIOS-Einstellungen auf vorhandenen, alteren Neoware-Geraten fir PXE:

1. Schalten Sie das Gerat ein und halten Sie die Entf-Taste gedrlickt, um die Seite CMOS Setup
Utility (CMOS-Einrichtungs-Tool) anzuzeigen.

2. Wahlen Sie "Advanced BIOS Features", und nehmen Sie folgende Einstellungen vor:

First Boot Device [LAN]
Second Boot Device [HDD-0]

3. Drlcken Sie die Esc-Taste, um zur Hauptseite zurlickzukehren, und wahlen Sie Integrated
Peripherals> und dann VIA OnChip PCI Device.

4. Vergewissern Sie sich, dass Onboard Lan Boot ROM auf [Enabled] eingestellt ist.

5. Dricken Sie die F10 - Taste, driicken Sie die Taste Y , und driicken Sie dann die Eingabetaste,
um die Einstellungen speichern.
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7 Repository-Management

HPDM verwendetet ein Master-Repository und mindestens ein Kind-Repository, um die Dateien zu
speichern, die fir seine Aufgaben erforderlich sind. Das Master-Repository enthalt alle Dateien, die

von HPDM bereitgestellt wurden, wahrend ein Kind-Repository entweder alle Dateien oder ein Subset

von Dateien, die sich im Master-Repository befinden, enthalt. Bei jedem Repository handelt es sich
um einen Dateiserver, zu dem HPDM entweder Gber Standard-FTP, die verschliisselten Varianten
SFTP und FTPS oder durch einen ,Shared Folder* (freigegebenen Ordner) eine Verbindung herstellt.

Standardmafig synchronisiert das Master-Repository bei Beginn eines neuen Tasks automatisch die
relevanten Dateien mit den Kind-Repositorys.

Initialisierung ausgehend vom Assistenten

Sie werden von einem Assistenten dazu aufgefordert, das Repository-System zu initialisieren, wenn
Sie die HPDM Console zum ersten Mal verwenden.

Der Assistent setzt sich aus zwei Seiten zusammen:
e  Protocol Settings (Protokolleinstellungen)

e Master Repository Configuration (Konfiguration des Master-Repositorys)

Auswahl des zu verwendenden Dateiprotokolls

So wahlen Sie das von HPDM zu verwendende Dateiprotokoll aus:

1. Wahlen Sie aus dem Meni der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Kilicken Sie im Dialogfeld Repository Management (Repository-Verwaltung) auf Protocols
(Protokolle).

3. Im Dialogfeld Protocol Configuration (Protokollkonfiguration) konnen Sie Protokoll und Port, die
verwendet werden sollen, einrichten.

Die Protokolleinstellungen werden auf alle Repositorys angewandt, einschlie3lich Master- und Kind-
Repositorys. HPDM verwendet diese Protokolle nur, um auf die Repositorys zuzugreifen.

Konfigurieren des Master-Repositorys

1. Wahlen Sie aus dem Meni der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2.  Wabhlen Sie im Dialogfeld Repository Management (Repository-Verwaltung) das Master-
Repository aus und klicken Sie auf Edit (Bearbeiten).

3. Konfigurieren Sie im Dialogfeld Repository Editor den Repository-Namen unter der Option
Repository Name, die Serveradresse unter der Option Server Address, den Benutzernamen
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unter der Option Username, das Kennwort unter der Option Password und die Pfadeinstellungen
unterPath.

[’_9'/1’ HINWEIS: Oben angegebene Pfade missen auf denselben Speicherort verweisen, der auch
fur den Master-Repository-Controller wahrend der Installation festgelegt wurde. Wenn Sie
beispielsweise wahrend der Installation c: \ ftproot \HPDM angeben, dann greifen Sie Uber
FTP mit dem Pfad ftp://1P/HPDM und Uber den Dienst ,Freigegebene Ordner” mittels 1P\
\HPDM auf diesen Ordner zu, weswegen Sie hier HPDM als Pfadwert fiir FTP und den Dienst
~Freigegebene Ordner” angeben sollten.

4. Klicken Sie auf Test (Testen), wenn Sie die Verbindungen, die Sie konfiguriert haben, testen
mdchten

’L,?’f HINWEIS: Die Tests werden auf jeden Fall durchgefiihrt, bevor Veranderungen gespeichert
werden.

5. Klicken Sie auf OK.

Wenn die Adresse des Master-Repositorys geédndert wurde, bricht der HPDM Server die aktuelle
Verbindung ab und versucht, sich unter der neuen Adresse mit dem Master-Repository-Controller zu
verbinden.

2993

& HINWEIS: Der HPDM Server benétigt fur den Verbindungsaufbau zum Master-Repository-
Controller Zeit. Warten Sie eine Weile, ehe Sie Vorgange in Verbindung mit dem Repository, wie zum
Beispiel die Verwaltung von Inhalten, durchfiihren.

Konfigurieren der Kind-Repositorys

1. Wahlen Sie aus dem Menu der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Klicken Sie im Dialogfeld Repository Management (Repository-Verwaltung) auf Add
(Hinzuflgen).

3. Konfigurieren Sie in dem Dialogfeld Repository Editor den Repository-Namen unter der Option
Repository Name, die Serveradresse unter der Option Server Address, den Benutzernamen
unter der Option Username, das Kennwort unter der Option Password und die Pfadeinstellungen
unterPath.

4. Klicken Sie auf Test (Testen), wenn Sie vor dem Speichern die Verbindung zum FTP-Server
und/oder dem freigegebenen Ordner testen mdchten.

’L,?’f HINWEIS: Der Test wird auf jeden Fall durchgefiihrt, bevor Veranderungen gespeichert
werden.

5. Klicken Sie auf OK.

Loschen von Kind-Repositorys

1. Wahlen Sie aus dem Meni der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Wahlen Sie im Dialogfeld Repository Management (Repository-Verwaltung) ein Kind-Repository.

3. Klicken Sie auf Remove (Entfernen) und anschlielend zur Bestatigung auf Yes (Ja).
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Exportieren von Repositorys

1. Wahlen Sie aus dem Meni der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Klicken Sie im Dialogfeld Repository Management (Repository-Verwaltung) auf Export
(Exportieren).

3. Navigieren Sie zu dem gewiinschten Speicherort.

4. Kiicken Sie auf die Schaltflache Export (Exportieren).

Importieren von Repositorys

1. Wahlen Sie aus dem Meni der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Kilicken Sie im Dialogfeld Repository Management (Repository-Verwaltung) auf Import
(Importieren).

3. Navigieren Sie zu dem Speicherort, wo sich das zu importierende Repository befindet.

4. Klicken Sie auf die Schaltflache Import (Importieren).

Synchronisieren von Repositorys

‘0> TIPP: Es ist nicht erforderlich, Repositorys manuell zu synchronisieren oder eine automatische
Synchronisierung zu planen. Die relevanten Dateien im Master-Repository werden zu Beginn eines
Tasks automatisch mit den Kind-Repositorys synchronisiert.

So synchronisieren Sie manuell alle Inhalte mit allen Kind-Repositorys:

1.  Wahlen Sie aus dem Menu der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Klicken Sie im Dialogfeld Repository Management (Repository-Verwaltung) auf Sync
(Synchronisieren).

3. Klicken Sie im Dialogfeld Synchronization (Synchronisierung) auf Sync (Synchronisieren).
4. Klicken Sie zum Bestatigen auf Yes (Ja).
So planen Sie eine wiederkehrende automatisierte Synchronisierung:

1. Wahlen Sie aus dem Menu der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Klicken Sie im Dialogfeld Repository Management (Repository-Verwaltung) auf Sync
(Synchronisieren).

3. Wahlen Sie im Dialogfeld Synchronization (Synchronisierung) das Auswahlkastchen Enable
schedule synchronization (Geplante Synchronisation aktivieren) aus.

4. Konfigurieren Sie nach Bedarf die Optionen und den Zeitplan.
5. Klicken Sie auf Save (Speichern).

Die Synchronisierung erfolgt unabhangig davon, ob sie manuell oder automatisch durchgefihrt wird,
im Hintergrund. Nachdem der Vorgang beendet wurde, wird die Spalte Last Time Synchronized
(Zuletzt synchronisiert) im Dialogfeld Repository Management (Repository-Verwaltung) aktualisiert.
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Inhaltsverwaltung

So zeigen Sie den Inhalt des Master-Repositorys an:

1. Waéhlen Sie aus dem Menu der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Klicken Sie im Dialogfeld Repository Management (Repository-Verwaltung) auf Content (Inhalt).

Anzeigen detaillierter Nutzlastinformationen

So zeigen Sie detaillierte Nutzlastinformationen an:

A Wabhlen Sie im Dialogfeld ,Content Management® im linken Bereich eine Kategorie
(ausgenommen ,Dateien aufgenommen®) aus, und doppelklicken Sie dann auf ein Element im
rechten Bereich. Im angezeigten Dialogfeld wird eine detaillierte Ubersicht iber die Nutzlast
angezeigt.

Léschen von Inhalten im Master-Repository

So Iéschen Sie Inhalte im Master-Repository:

A Wahlen Sie im Dialogfeld ,Content Management® im rechten Bereich ein Element aus, und
klicken Sie auf die Schaltflache Léschen. Eine Bestatigungsmeldung wird angezeigt. Klicken Sie
auf Ja, damit die Nutzlast geldscht wird.

B HINWEIS: Integrierte Inhalte kénnen nicht geldscht werden.

Herunterladen von Inhalten der Kategorie ,Dateien aufgenommen®

So laden Sie Inhalte vom Master-Repository herunter:

1. Wahlen Sie im Dialogfeld ,Content Management® im rechten Bereich ein Element der Kategorie
Dateien aufgenommen aus, und klicken Sie auf die Schaltflache Herunterladen.

2. Navigieren Sie zu dem gewilinschten Speicherort. Der Inhalt wird auf den lokalen Computer
heruntergeladen.

Repository-Zuordnung

HPDM ordnet automatisch jedem Gerat das nachstliegende und am besten erreichbare Repository
zu. So kann der Administrator Tasks an eine grof3e Anzahl von HPDM Agents senden und den
Geraten ermdglichen, sich automatisch mit einem Repository zu verbinden, um die Informationen
oder Anwendungen zu finden, die sie zur Ausflihrung des Tasks benétigen. Die fir den Task
erforderliche Nutzlast wird automatisch, noch bevor der Task zu den Zielgeraten gesendet wird,
synchronisiert.

So greifen Sie auf das Dialogfeld ,Repository Mapping“ (Repository-Zuordnung) zu:

1. Wahlen Sie aus dem Menu der HPDM Console Tools > Repository Management (Tools >
Repository-Verwaltung) aus.

2. Klicken Sie auf Mapping (Zuordnen).
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Batchzuordnung

Sie kdnnen festlegen, ob Gerate in einem Batch nach ihrem Master-HPDM Gateway oder nach der
Subnetzadresse zugeordnet werden sollen, indem Sie auf die entsprechende Optionsschaltflache
auswahlen. Sie kdnnen sich alle Zuordnungsergebnisse anzeigen lassen, indem Sie das
Kontrollkdstchen Nur Ausnahmen anzeigen deaktivieren.

Um eine Zuordnung fiir ein HPDM Gateway oder eine Subnetzadresse zu dndern, klicken Sie mit der
rechten Maustaste auf das Element und wahlen Sie im Kontextmen eine der folgenden Optionen
aus:

e Automatische Zuordnung — Automatische Zuordnung (Werkseinstellung). Der HPDM Server
weist jedem HPDM Gateway oder jeder Subnetzadresse abhangig von der IP-Adresse ein
Repository zu.

e  Master verwenden — Das Master-Repository wird verwendet.

e Angegebene verwenden — Wahlen Sie ein Repository aus einer Popupliste fir das angegebene
HPDM Gateway oder die angegebene Subnetzadresse aus.

Ef HINWEIS: Die Zuordnungseinstellungen eines Gerats, eines HPDM Gateway oder einer
Subnetzadresse kénnen jederzeit von einem Administrator gedndert werden.

[%’/r’ HINWEIS: HPDM generiert automatisch fiir jedes neue Gerat, das zum Netzwerk hinzugefiigt wird,
eine Zuordnung.

Zuordnung pro Gerat

Sie kdnnen Ausnahmegerate festlegen, flir die ein anderes Repository verwendet werden soll, als
das, das fur Batchzuordnungen verwendet wird, indem Sie Geréte aus einem Filter hinzufiigen und
einem bestimmten Repository zuweisen.

Siehe Filtern von Geraten auf Seite 38 fir mehr Informationen zu Filtern.
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8 Sicherheits-Management

Es gibt zwei Formen des Sicherheits-Managements in HPDM: Benutzer-Management und
Authentifizierungs-Management.

Benutzer-Management

Jedes Benutzerkonto kann uber nach Bedarf angepasste Berechtigungen verfligen. Diese
Berechtigungen werden Uber das System der Benutzergruppen zugewiesen.

So 6ffnen Sie das Dialogfeld ,Benutzer-Management:

A Klicken Sie in der Mentuleiste der HPDM Console auf Werkzeuge > Benutzer-Management.

Hinzufligen von Benutzern

1.  Klicken Sie im Dialogfeld ,Benutzer-Management” auf Hinzufiigen, um einen neuen Benutzer
hinzuzufiigen. Das Dialogfeld Neuen Benutzer erstellen wird angezeigt.

2. Geben Sie fur den neuen Benutzer in das Feld Username (Benutzername) einen
Benutzernamen und in das Feld Password (Kennwort) ein Kennwort ein. Klicken Sie auf OK, um
den neuen Benutzer zu erstellen.

Der angegebene Benutzername kann fir die Anmeldung bei der HPDM Console beim nachsten Start
der HPDM Console verwendet werden.

Unter Zuweisen von Benutzern zu Gruppen auf Seite 66 erfahren Sie, wie Sie den neuen Benutzer
zu einer Benutzergruppe hinzufiigen.

[%/’/]"’ HINWEIS: Jeder Benutzer muss Mitglied einer Gruppe sein, um berechtigt zu sein, HPDM zu
verwenden.

7 HINWEIS: Mehrere HPDM Console-Instanzen kdnnen sich nicht gleichzeitig mit demselben
Benutzernamen beim HDPM Server anmelden.

Loéschen von Benutzern

1. Wahlen Sie im Dialogfeld ,Benutzer-Management® auf der Registerkarte Benutzer einen
Benutzer aus der Liste.

2. Klicken Sie auf Léschen und anschliefiend zur Bestatigung auf Ja.

Zuweisen von Benutzern zu Gruppen

1. Doppelklicken Sie im Dialogfeld ,Benutzer-Management® auf der Registerkarte Benutzer auf
einen Benutzernamen in der Liste.

2. Wahlen Sie die Registerkarte Member Of (Mitglied von) aus.

3. Klicken Sie auf Hinzufligen, um den Benutzer zu einer neuen Gruppe hinzuzufiigen, oder auf
Léschen, um ihn aus der ausgewahlten Gruppe zu entfernen.
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Andern des Passworts eines Benutzers

1.

4,

Klicken Sie mit der rechten Maustaste im Dialogfeld ,Benutzer-Management” auf der
Registerkarte Benutzer auf einen Benutzernamen in der Liste.

Wabhlen Sie aus dem Kontextmenu den Befehl Change Password (Kennwort &ndern).

Geben Sie das neue Kennwort fiir den Benutzer in das Feld Neues Kennwort und anschlie3end
erneut in das Feld Kennwort bestétigen ein.

Klicken Sie abschlieRend auf OK.

& HINWEIS: Es wird dringend empfohlen, bei der erstmaligen Anmeldung mit

Administratorrechten die Standardeinstellung des Kennworts zu andern.

Zuweisen von Sicherheitsfiltern zu Benutzern

1.

Doppelklicken Sie im Dialogfeld ,Benutzer-Management* auf der Registerkarte Benutzer auf
einen Benutzernamen in der Liste.

Wabhlen Sie die Registerkarte Filter aus.

Klicken Sie auf Hinzufligen, um den Filter zu diesem Benutzer hinzuzufiigen, oder auf
Entfernen, um den Sicherheitsfilter von diesem Benutzer zu entfernen.

Hinzufligen einer Gruppe

Gruppen kénnen zur Steuerung von Benutzerberechtigungen in HPDM verwendet werden.

1.
2.

Klicken Sie im Dialogfeld ,Benutzer-Management” auf die Registerkarte Gruppen.

Klicken Sie auf Add (Hinzufligen), um eine neue Gruppe hinzuzufligen. Dieser Gruppe kann jetzt

ein Satz von Berechtigungen zugewiesen werden, und anschlieend kénnen ihr Benutzer
zugewiesen werden.

Zuweisen von Berechtigungen an Gruppen

1.

o > 0o DN

Klicken Sie mit der rechten Maustaste im Dialogfeld ,Benutzer-Management” auf der
Registerkarte Gruppen auf eine Gruppe in der Liste.

Wahlen Sie aus dem Kontextmenl den Befehl Properties (Eigenschaften).
Wahlen Sie die Registerkarte Privileges (Berechtigungen) aus.
Wahlen Sie die Berechtigungen aus, die Sie der Gruppe zuweisen mdchten.

Klicken Sie abschliefend auf OK.

Zuweisen von Benutzern zu Gruppen

1.

Klicken Sie mit der rechten Maustaste im Dialogfeld ,Benutzer-Management” auf der
Registerkarte Gruppen auf eine Gruppe in der Liste.

Wahlen Sie aus dem Kontextmenl den Befehl Properties (Eigenschaften).
Wabhlen Sie die Registerkarte Users (Benutzer) aus.

Andern Sie die Mitgliederliste dieser Gruppe mithilfe der Schaltflichen Add (Hinzufiigen) und
Delete (Loschen).

Klicken Sie abschliefend auf OK.
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Zuweisen von Sicherheitsfiltern zu Gruppen

1.

Doppelklicken Sie im Dialogfeld ,Benutzer-Management“ auf der Registerkarte Gruppen auf eine
Gruppe in der Liste.

Wahlen Sie die Registerkarte Filter aus.

Klicken Sie auf Hinzufligen, um den Filter zu dieser Gruppe hinzuzufligen, oder auf Entfernen,
um den Sicherheitsfilter aus dieser Gruppe zu entfernen.

Léschen von Gruppen

1.

2.

Wahlen Sie im Dialogfeld ,Benutzer-Management” auf der Registerkarte Gruppen eine Gruppe
in der Liste aus.

Klicken Sie auf die Schaltflaiche Léschen und anschlie3end zur Bestatigung auf Ja.

Benutzerauthentifizierung mit LDAP und Active Directory

Es ist mdglich, zur Anmeldung bei HPDM auf einem Active Directory-Server oder auf anderen LDAP-
Servern konfigurierte Benutzer und Gruppen zu verwenden. Dies gestattet die erneute Verwendung
vorhandener Anmeldekonten und vereinfacht auerdem die Verwaltung der Benutzer, die Uber
Administratorrechte fir HPDM verfligen.

Konfiguration

So konfigurieren Sie eine Verbindung zu einem LDAP-Server:

1.
2.

Klicken Sie in der Mentlleiste der HPDM Console auf Werkzeuge > Konfiguration.

Wabhlen Sie im Dialogfeld ,Konfigurations-Management” im linken Bereich die
OptionBenutzerauthentifizierungaus.

Geben Sie in das Feld Host den Hostnamen oder die IP-Adresse des LDAP-Servers ein. Bei
Verwendung einer verschlisselten Verbindung muss der LDAP-Server tiber den Hostnamen
angegeben werden.

Passen Sie bei Bedarf den Port an. Port 389 ist der gebrauchliche Port bei TLS- oder nicht
verschlisselten LDAP-Verbindungen. Port 636 wird in der Regel fur eine SSL-LDAP-Verbindung
verwendet.

Wahlen Sie einen Typ fir die Verschlisselung (Encryption) aus.

Bei Verwendung einer TLS- oder SSL-Verschlisselung muss ein Host Key (Hostschlissel)
angegeben werden. Fiihren Sie einen der folgenden Schritte aus:

A Klicken Sie auf Get Key From Host (Schliissel von Host abrufen). Es wird eine Verbindung
zum LDAP-Server erstellt, und der Hostschllissel wird gespeichert.

- oder -

A Kilicken Sie auf Import From File (Aus Datei importieren). Suchen Sie nach einer Datei mit
dem Hostschlisselzertifikat in einem der folgenden Formate:

e Key Export File (Schlisselexportdatei): Hostschllssel lassen sich hdufig vom LDAP-
Server in eine Datei exportieren. Bei der Microsoft Active Directory/lIS-Plattform finden
Sie diese Exportdatei unter http://<Ihr LDAP-Server>/certsrv/
certcarc.asp

e Java Keystore: Es kann die Datei hpdmcert.key einer friiheren Installation von HPDM
oder eine andere Java Keystore-Datei importiert werden.

68 Kapitel 8 Sicherheits-Management



7. Wahlen Sie im Abschnitt Server Type (Servertyp) einen LDAP-Server-Typ aus der Dropdown-
Liste Type (Typ).

a. Active Directory: Geben Sie die Domane (Domain) fir Active Directory an. Es wird nur eine
einzige Doméane unterstitzt.

b. Generic LDAP (LDAP allgemein):

e Geben Sie den Base DN (Basis-DN) an. Ein Basis-DN (DN = Distinguished Name) ist
fur die Verbindung zum LDAP-Server erforderlich. Weitere Informationen zum Basis-
DN finden Sie in der Dokumentation zu Ihrem LDAP-Server.

Beispiele fir Basis-DNs:
° dc=testnet,dc=com
o o=company,c=US

e Geben Sie das RDN Attribute (RDN-Attribut) an. Das RDN-Attribut (Relative
Distinguished Name) ist das LDAP-Attribut, das den Anmeldenamen fur den Benutzer
angibt. Zu den Ublichen Werten zahlen sAMAccountName (Active Directory), UID und
CN.

8. Konfigurieren Sie einen Search User (Suchbenutzer). Der Suchbenutzer wird in zwei Situationen
verwendet: vom Dialogfeld Import Users and Groups (Benutzer und Gruppen importieren) zum
Durchsuchen des LDAP-Servers und um auf dynamische Weise die Mitglieder einer importierten
Gruppe zu ermitteln. Sofern der LDAP keine anonyme Suche unterstiitzt, muss ein
Suchbenutzer angegeben werden. Lassen Sie die Felder fiir den Benutzernamen und das
Kennwort leer, um den anonymen Benutzer zu verwenden.

Dieser Benutzername muss als Distinguished Name angegeben werden.

Hinweis zu Active Directory: Vom DN-Namen wird das LDAP CN-Attribut anstelle des normalen
Anmeldenamens verwendet. Offnen Sie zum Bestimmen des LDAP-CN auf dem
Domanencontroller Active Directory Users and Computers (Active Directory-Benutzer und -
Computer), und doppelklicken Sie auf den search user (Suchbenutzer). Im Fenster Properties
(Eigenschaften) wird auf der Registerkarte General (Allgemein) der Display Name
(Anzeigename) angezeigt. Bei diesem Display Name handelt es sich um den LDAP-CN.

Im Beispiel weiter oben wird fir den Anzeigenamen ,HPDM search user” im Verzeichnis ,Users*
der Domane ,testnet.com* folgender DN verwendet:

CN=hpdm search user,CN=Users,DC=testnet,DC=com

9. Testen Sie abschlielend die Konfiguration, indem Sie auf die Schaltflache Test (Testen) klicken.
Wurde die Konfiguration fiir den LDAP-Server erfolgreich abgeschlossen, wird dieser Test
bestanden.

Importieren von Benutzern und Gruppen

Nachdem der LDAP-Server konfiguriert wurde, missen jetzt Benutzer und Gruppen importiert
werden. Uber dieses Importverfahren wird HPDM mitgeteilt, welche LDAP-Benutzer sich anmelden
dirfen und Gber welche Berechtigungen sie in diesem Fall verfiigen.

So 6ffnen Sie das Importtool:
1. Klicken Sie in der Menuleiste der HPDM Console auf Werkzeuge > Benutzer-Management.
2. Klicken Sie auf die Schaltflache Import from LDAP (Aus LDAP importieren).

Uber das Dialogfeld Import Users and Groups (Benutzer und Gruppen importieren) lassen sich
Benutzer oder Gruppen so einrichten, dass sie tUiber Browse (Durchsuchen) und Search (Suchen)
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gefunden werden kénnen. Die Eigenschaften eines LDAP-Objekts lassen sich Gber die Schaltflache
Show Attributes (Attribute anzeigen) beurteilen. Benutzer und Gruppen kénnen hinzugefiigt und
anschlielend importiert werden.

So finden Sie einen Benutzer oder eine Gruppe mithilfe von "Durchsuchen™:

1. Das Dialogfeld Import Users and Groups (Benutzer und Gruppen importieren) wird im Modus
Browse (Durchsuchen) getffnet. Eine Struktur mit LDAP-Objekten wird auf der linken Seite des
Dialogfelds angezeigt.

2. Verzeichnisse lassen sich erweitern, indem Sie links neben einem Verzeichnis auf die
Schaltflache + klicken.

3. An einigen Stellen in der LDAP-Struktur sind ggf. zahlreiche Ergebnisse vorhanden. Sollte dies
der Fall sein, wird ein blauer Eintrag Show 20 more (Weitere 20 anzeigen) aufgelistet. Klicken
Sie auf Show 20 more (Weitere 20 anzeigen), um weiter Ergebnisse anzuzeigen.

So finden Sie einen Benutzer oder eine Gruppe mithilfe von "Suchen™:

1. Klicken Sie links oben im Dialogfeld Import Users and Groups (Benutzer und Gruppen
importieren) auf die Registerkarte Search (Suchen).

2. Der Base DN (Basis-DN) ist der Startpunkt, von dem aus die Suche ausgefihrt wird. Alle
Suchvorgange erfolgen rekursiv von diesem Ausgangspunkt aus.

3. Die Abfrage (Query) ermdglicht die Angabe der Suchkriterien. Sie umfasst drei Teile: das
Attribut, den Suchwert und den Vergleich zwischen beiden.

a. Das Feld Attribute (Attribute) auf der linken Seite der Abfrage bietet mehrere allgemeine
Attribute, nach denen gesucht werden kann, zur Auswahl. Wenn das gewiinschte
Suchattribut nicht vorhanden ist, geben Sie das Attribut in dieses Feld ein.

b. Das Feld Search Value (Suchwert) auf der rechten Seite der Abfrage enthalt den
Suchausdruck. Ein Sternchen (*) kann als Platzhalter im Search Value (Suchwert)
verwendet werden. Dies ermdglicht die Suche, wenn der vollstandige Suchwert nicht
bekannt ist. Beispiel: Die Suche nach dem Attribut UID mit der Vergleichsbedingung "=" fiir
den Wert * . smith@testnet.com findet alle Benutzer mit einer UID, die
auf .smith@testnet.com endet.

c. Das Feld Comparison (Vergleich) in der Mitte der Abfrage bietet mehrere Moglichkeiten fir
den Abgleich des Attributwerts mit dem Gesuchten.

e Beim Vergleich Equals ( =) werden alle LDAP-Objekte gefunden, die dem Suchwert
entsprechen.

e Beim Vergleich Greater than or Equals (>=) werden alle LDAP-Objekte mit einem
Attributwert gesucht, dessen Zahlenwert hoher oder gleich dem Suchwert ist.

e Beim Vergleich Less than or Equals (<=) werden alle LDAP-Objekte mit einem
Attributwert gesucht, dessen Zahlenwert kleiner oder gleich dem Suchwert ist.

e  Der Vergleich Similar to ( ~=) ermdglicht die Suche nach allen Attributwerten, die dem
Suchwert dhneln (ungefahr entsprechen).

e Der Vergleich Not equals ( !=) ermdglicht die Suche nach Attributwerten, die nicht dem
Suchwert entsprechen.

4. Klicken Sie abschlielend auf die Schalflaiche Search (Suchen). Die Ergebnisse werden in der
Struktur Search (Suchen) auf der linken Seite angezeigt. Informationen zum Durchsuchen der
Suchergebnisse finden Sie an friiherer Stelle in diesem Abschnitt unter So finden Sie einen
Benutzer oder eine Gruppe mithilfe von "Durchsuchen".
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Hinzufligen eines Benutzers oder einer Gruppe fir den Import:
1.  Finden Sie den Benutzer oder die Gruppe Uber Browse (Durchsuchen) oder Search (Suchen).

2. Flgen Sie den Benutzer oder die Gruppe hinzu, indem Sie eine der folgenden Methoden
verwenden:

e Doppelklicken Sie auf den Benutzer oder die Gruppe.
- oder -

e Klicken Sie auf den Benutzer oder die Gruppe, und klicken Sie dann links unten im
Dialogfeld auf die Schaltflache Add (Hinzuftgen).

3. Der Benutzer/die Gruppe sollte jetzt auf der rechten Seite aufgelistet sein.

E/{ HINWEIS: Die Benutzer und Gruppen werden erst dann importiert, wenn Sie rechts unten auf die
Schaltflache Import (Importieren) klicken. Achten Sie darauf, dass Sie auf die Schaltflache Import
(Importieren) klicken, wenn alle zu importierenden Benutzer und Gruppen ausgewahlt wurden.

Entfernen eines Benutzers oder einer Gruppe aus der Importliste:

1. Wahlen Sie einen Benutzer oder eine Gruppe auf der rechten Seite des Dialogfelds Import
Users and Groups (Benutzer und Gruppen importieren) aus.

2. Klicken Sie auf die Schaltflache Remove (Entfernen).

Uberpriifen eines Benutzers oder einer Gruppe:

1. Klicken Sie auf einen Benutzer oder eine Gruppe.

2. Klicken Sie auf die Schaltflache Show Attributes (Attribute anzeigen).

3. Auf Wunsch kann dieses Objekt zur Liste der zu importierenden Benutzer/Gruppen hinzugefugt
werden, indem Sie auf die Schaltflache Add (Hinzufligen) klicken.

Importieren von Benutzern und Gruppen:
1. Finden Sie die Benutzer oder Gruppen tber Browse (Durchsuchen) oder Search (Suchen).
2. Flgen Sie die Benutzer oder Gruppen hinzu.

3. Kilicken Sie unten rechts auf die Schaltflache Import (Importieren). Die importierten Benutzer und
Gruppen sind jetzt im Dialogfeld User Management (Benutzer-Management) sichtbar.

4. Wenn eine Gruppe importiert wurde, miissen die Berechtigungen der Gruppe zugewiesen
werden. Weitere Informationen erhalten Sie unter Zuweisen von Berechtigungen an Gruppen
auf Seite 67.

Authentifizierungs-Management

Da der HPDM Server samtliche HPDM Gateways und HPDM Agents im Netzwerk erkennen und
verwalten kann, ergibt sich ein mégliches Sicherheitsproblem aus der nicht ordnungsgemafien
Verwendung des HPDM Servers. Um dieses Probem auszuschlief3en, bietet HPDM eine
Authentifizierungsfunktion fir HPDM Gateways und HPDM Agent, mit der diese einen sicheren
HPDM Server erkennen kénnen.

Fir die Bereitstellung der Authentifizierungsfunktion sind zwei Tools verfiigbar: Schliissel-
Management und Zugriffssteuerung mit HPDM-Gateway. Der Zugriff auf diese Tools erfolgt tber die
Auswahl der Befehle Werkzeuge > Authentifizierungs-Management in der Menuleiste der HPDM
Console.
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Schliissel-Management

Ein Authentifizierungsschlissel ist ein Kennwort mit Klartext, das in der HPDM Console eingegeben
wird. Der Schliissel wird wahrend des Schliisselaktualisierungsvorgangs an die Gerate weitergeleitet.
Die Gerate Uberpriifen den vom HPDM Server weitergeleiteten Schllssel bei der Ausflihrung von
Tasks.

So aktualisieren Sie den aktuellen Authentifzierungsschliissel:

1. Wahlen Sie in der Menlleiste der HPDM Console die Befehle Werkzeuge > Authentifizierungs-
Management > Schliissel-Management aus, um das Dialogfeld Authentifizierung anzuzeigen.

2. Geben Sie das Password (Kennwort) ein, und klicken Sie auf OK. Das Fenster Key
Management (Schlissel-Management) wird gedffnet.

3. Kilicken Sie auf die Schaltflache Update Current Key (Aktuellen Schliissel aktualisieren), um das
Dialogfeld Update Key (Schliissel aktualisieren) anzuzeigen:

4. Geben Sie unter Password (Kennwort) das neue Kennwort (d. h. den
Authentifizierungsschlissel) ein, und geben Sie eine Wert (Anzahl der Tage) fur Expire Interval
(Ablaufintervall) ein.

5. Klicken Sie auf die Schaltflache OK.

E.%" HINWEIS: Ablaufintervall gibt an, wie lange das Kennwort (der Schliissel) giiltig bleibt. Wenn ein
HPDM Agent innerhalb des Ablaufintervalls keine Schlisselinformationen von einem HPDM Gateway
abrufen kann, wird der Schllssel ungultig und der HPDM Agent kehrt zum urspriinglichen Schlussel
zurick.

HP empfiehlt fir Benutzerkennworter die Verwendung von:

e Mindestens acht Zeichen

e  Grof3- und Kleinbuchstaben

e  Ziffern und Interpunktionszeichen ebenso wie Buchstaben
So exportieren Sie alle Authentifizierungsschlissel:

1. Klicken Sie im Fenster Key Management (Schllissel-Management) auf die Schaltfliche Export
All Key(s) (Alle Schliissel exportieren), um das Dialogfeld Export (Exportieren) anzuzeigen.

2. Navigieren Sie zu einem Ordner, in dem die aktuellen Authentifizierungsschlissel als KS-Datei
gespeichert werden sollen, und klicken Sie anschlieend auf die Schaltflache Export
(Exportieren).

3. Sie werden vom System aufgefordert, das Schlisselspeicher-Kennwort zu erstellen und zu
bestatigen.

4. Geben Sie im Dialogfeld Create KeyStore Password (Schliisselspeicher-Kennwort erstellen) ein
Schlisselspeicher-Kennwort in das Feld Password (Kennwort) ein, und bestatigen Sie das
Kennwort im Feld Re-enter Password (Kennwortwiederholung).

5. Klicken Sie auf die Schaltflache OK.
So importieren Sie Authentifizierungsschlissel:

1.  Klicken Sie im Fenster Key Management (Schlissel-Management) auf die Schaltflache Import
Key(s) (Schlissel importieren), um das Dialogfeld zum Importieren anzuzeigen.

2. Navigieren Sie zu der exportierten KS-Datei, und klicken Sie auf die Schaltflache Import
(Importieren).
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3. Sie werden vom System aufgefordert, das Schliisselspeicher-Kennwort einzugeben.
4. Geben Sie das Schlisselspeicher-Kennwort ein, und klicken Sie auf OK.
Anzeigen des Schllisselaktualisierungsprotokolls

Zum Anzeigen des Schlisselaktualisierungsprotokolls klicken Sie im Fenster Key Management
(Schlussel-Management) auf die Schaltfache View Update Log (Aktualisierungsprotokoll anzeigen).

In der Key Update Log List (Schliusselaktualisierungsprotokoll-Liste) finden Sie alle
Protokolleintragszeiten und -ereignisse. Sie kdnnen alle Protokolleintrage entfernen, indem Sie auf
die Schalflache Clear All Logs (Alle Protokolle leeren) klicken.

HPDM Gateway-Zugriffssteuerung

Der HPDM Server verwaltet den Bestatigungsstatus eines HPDM Gateways, das ein Benutzer Gber
die HPDM Console angibt. Erkennt der HPDM Server ein HPDM Gateway, wird dessen Status auf
L,Unbekannt® festgelegt. Der HPDM Server stellt keine Verbindung zu einem HPDM Gateway her und
empfangt von diesem auch keine Nachrichten, solange das HPDM Gateway gesperrt (also nicht
bestétigt) ist.

So steuern Sie den HPDM Gateway-Zugriff manuell:

1. Wahlen Sie Uber die Menuleiste in der Konsole die Befehle Werkzeuge > Authentifizierungs-
Management > Zugriffssteuerung mit HPDM Gateway aus, um das Dialogfeld Authentifizierung
anzuzeigen.

2. Geben Sie das Kennwort ein, und klicken Sie auf OK. Das Fenster Zugriffssteuerung fir Geréte-
Management-Gateway wird angezeigt.

3.  Wabhlen Sie ein HPDM Gateway aus der Zugriffssteuerungsliste fiir Device Management-
Gateway, und klicken Sie dann auf Bestétigen oder Sperren, um das ausgewahite HPDM
Gateway zu bestéatigen oder zu sperren.

E/{ HINWEIS: Bei deaktiviertem Kontrollkastchen Zugriff auf das Device Management-Gateway
manuell steuern wird das HPDM Gateway mit dem Status Unbekannt als Bestétigt behandelt. Ist das
Kontrollkastchen aktiviert, wird das HPDM Gateway mit dem Status Unbekannt als Gesperrt
behandelt, und Sie miissen den Status des HPDM Gateways manuell konfigurieren.
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9 Berichtverwaltung

Hinzufligen einer Berichtvorlage

So fligen Sie eine Berichtvorlage hinzu:

1. Wahlen Sie Uber die Menileiste in der Konsole die Befehle Werkzeuge > Bericht-Management,
um das Fenster Bericht-Management anzuzeigen.

2. Wahlen Sie einen Berichttyp aus der Liste Report Types (Berichttypen), und klicken Sie auf die
Schaltflache Add (Hinzufligen). Mit dem Dialogfeld Set New Report Template Name (Namen fir
neue Berichtvorlage festlegen) werden Sie aufgefordert, den Namen einer Berichtvorlage
einzugeben.

3. Klicken Sie auf OK, um das Fenster Edit Report Template (Berichtvorlage bearbeiten) zu &ffnen.
Klicken Sie im Feld Edit Criteria (Kriterien bearbeiten) auf die Schaltflache ..., um das Fenster
Choose Criteria Key (Kriterienschliissel auswahlen) zu 6ffnen. Wahlen Sie einen
Kriterienschllissel aus der Candidate Criteria Key List (Kandidat-Kriterienschliisselliste).

Klicken Sie nach erfolgter Auswahl auf OK, um zum Fenster Edit Report Template
(Berichtvorlage bearbeiten) zuriickzukehren.

4. Wahlen Sie im Feld Edit Criteria (Kriterien bearbeiten) die Kriterienbedingungen aus den beiden
Dropdown-Listen, oder geben Sie die Bedingungen dort ein.

5.  Klicken Sie auf Add (Hinzufligen), um die Kriterien zur Criteria List (Kriterienliste) hinzuzuftigen.
Sie kdnnen aber auch ein vorhandenes Kriterium auswahlen und auf Edit (Bearbeiten) klicken,
um die Beschrankungsbedingung zu erneuern.

6. Definieren Sie Operator und Wert fiir jedes Kriterium.

B HINWEIS: Die Berichtvorlage kann mehrere Kriterien enthalten, fiir die alternativ eine von zwei
Bedingungen gilt: Satisfy All Criteria (Alle Kriterien erfiillt) oder Satisfy Any Criteria (Mindestens
ein Kriterium erfillt). So kdnnen Sie jede von ihnen auswahlen, um Berichte zu generieren.

7. Klicken Sie auf Generate Reports (Berichte generieren), um einen Bericht den aktuellen
Kriterien entsprechend zu generieren, oder klicken Sie auf Save (Speichern), um diese Kriterien
zur benannten Vorlage hinzuzufiigen.

Bf HINWEIS: Die gednderten Kriterien werden nach Generierung eines Berichts nicht in der
Vorlage gespeichert. Um die gednderten Kriterien in der Vorlage zu speichern, missen Sie auf
die Schaltflache "Save" (Speichern) klicken.

Importieren einer Bericht-Plugin-Datei

So importieren Sie eine Bericht-Plugin-Datei:
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1. Klicken Sie im Fenster Report Management (Bericht-Management) auf Import (Importieren), und
wahlen Sie eine Plugin-Datei (mit Suffix *.jar) aus.

2. Klicken Sie zum Importieren der Datei auf Import Plug-in File (Plugin-Datei importieren), und
kehren Sie zum Fenster Report Management (Bericht-Management) zurtick. Ein neuer
Berichttyp wird zur Liste Report Types (Berichttypen) hinzugeflgt.

Sie kénnen einen Berichttyp aus der Liste entfernen, indem Sie auf die Schaltflache Delete
(L6schen) klicken. Sie werden aufgefordert, den Léschvorgang zu bestatigen.
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& HINWEIS: Die importierten Berichttypen kénnen nur geléscht werden, wenn sie nicht mit einer
Vorlage verknipft sind.

Generieren eines Berichts mithilfe einer Berichtvorlage

So generieren Sie einen Bericht mithilfe einer Berichtvorlage:

1.  Wahlen Sie im Fenster Report Management (Berichte-Management) einen Berichttyp aus der
Liste Report Types (Berichttypen). Anschlielend werden alle Berichtvorlagen fiir den
ausgewahlten Typ in der Liste Report Templates (Berichtvorlagen) angezeigt.

2. Wahlen Sie eine Vorlage aus der Liste, und klicken Sie auf Edit (Bearbeiten), oder doppelklicken
Sie auf die Vorlage, um ihren Inhalt anzuzeigen.

3. Klicken Sie auf Generate Report (Bericht generieren), um eine Vorschau des Berichts
anzuzeigen.

Erstellen von Berichten

HPDM ermdéglicht es Ihnen, Informationen zu Ihren Geraten und den an sie gesendeten Tasks zu
drucken. Es sind sechs Berichtstypen verfligbar: Gateway Information (Gateway-Informationen),
Device Information (Gerateinformationen), Device Task Report (Geratetaskbericht), 7ask Report
(Taskbericht), 7ask Status Report (Taskstatusbericht) und 7ask Status Log Report
(Taskstatusprotokollbericht).

HPDM Gateway-Bericht

Dieser Bericht listet die grundlegenden Inventardaten der ausgewahlten HPDM Gateways auf.

So erstellen Sie einen HPDM Gateway-Bericht:

1. Wabhlen Sie die HDPM Gateway-Systeme aus, fiir die Sie einen Bericht erstellen méchten.

2. Klicken Sie mit der rechten Maustaste auf die Auswahl, und wahlen Sie aus dem Kontextmeni

den Befehl Print Device Information ... (Gerateinformationen drucken).

Gerateinformationenbericht

In diesem Bericht werden die grundlegenden Inventardaten sowie der letzte bekannte Onlinestatus
fur die zurzeit ausgewahlten Gerate aufgelistet.

So erstellen Sie einen Geratebericht:
1. Wahlen Sie die Geratesysteme aus, fir die Sie einen Bericht erstellen mdéchten.

2. Wahlen Sie aus dem Meni der HPDM Console File > Print Device Information (Datei >
Geréteinformationen drucken).

Generieren eines Berichts mithilfe einer Berichtvorlage
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Geratetask-Bericht

Dieser Bericht ist nur dann verfiigbar, wenn ein einzelnes Gerat ausgewahlt ist. In diesem Bericht
sind alle Tasks aufgelistet, die an das Gerat gesendet wurden, sowie deren Status und das
zugehdrige Task-Protokoll. Zuvor geldschte Tasks sind nicht im Bericht enthalten.

Sie missen angeben, ob auch die von Administratoren erstellten Tasks oder nur die von lhnen
erstellten Tasks angezeigt werden sollen. Dariiber hinaus haben Sie die Option, den Bericht auf eine
bestimmte Zeitdauer zu beschranken.

So erstellen Sie einen Geréatetaskbericht:
1. Wahlen Sie das Geratesystem aus, fiir das Sie einen Bericht erstellen méchten.

2.  Wahlen Sie aus dem Menu der HPDM Console File > Print Device Task Report (Datei >
Geréatetaskbericht drucken).

3. Wahlen Sie die geeigneten Optionen im Dialogfeld Device Task Report (Geratetaskbericht) aus,
und klicken Sie auf Next > (Weiter).

Taskbericht

In diesem Bericht werden die Beschreibung und der Status aller nicht geléschten Tasks aufgelistet.
So erstellen Sie einen Taskbericht:

A Wahlen Sie im Meni File (Datei) die Option Print Task Report ... (Taskbericht drucken) aus.

Taskstatus-Bericht

In diesem Bericht werden Informationen zum Status einer Task aufgelistet.
So erstellen Sie einen Taskstatusbericht:

A Wahlen Sie eine Task im Dialogfeld Device Task View (Geratetaskansicht) aus, klicken Sie mit
der rechten Maustaste, und wahlen Sie aus dem Kontextmen die Befehle Print Preview >
Status ... (Druckvorschau > Status).

Taskprotokoll-Bericht
In diesem Bericht werden Informationen zum Statusprotokoll einer Task aufgelistet.
So erstellen Sie einen Taskstatusprotokoll-Bericht:

A Wahlen Sie eine Task im Dialogfeld Device Task View (Geréatetaskansicht) aus, klicken Sie mit
der rechten Maustaste, und wéhlen Sie aus dem KontextmenU die Befehle Print Preview > Log...
(Druckvorschau > Protokoll).

76 Kapitel 9 Berichtverwaltung



10 Statustberwachung

HPDM verfiigt (iber zwei integrierte Tools zur Uberwachung und Aufzeichnung der Leistung von
Geraten: Statusdurchlauf und Statussnapshot.

B HINWEIS: Status Walker ist veraltet und wird von HP nicht mehr unterstiitzt, jedoch weiterhin als
Tool flr Ihre Verwendung bereitgestellt.

Status Walker

Das Tool Status Walker (Statusdurchlauf) erstellt eine Liste aller verfligbaren IP-Adressen und ruft sie
auf. Dabei sammelt es Statusinformationen und zeigt diese an. Dieser Statusbericht wird in Echtzeit
erstellt. Die Informationen werden in einer Datenbank auf dem Server gespeichert.

E,?’f HINWEIS: Die Option Statusdurchlauf ist nur fiir Windows-basierte HPDM Gateways verfligbar.

Erstellen eines Status Walker-Berichts

1.

7.

Offnen Sie (iber die Meniileiste der HPDM Console das Menii Werkzeuge, und wahlen Sie
Statusdurchlauf aus. Das Dialogfeld ,Statusdurchlauf‘ wird angezeigt.

Klicken Sie auf Add (Hinzufiigen), um einen neuen Durchlaufplan zu erstellen, oder klicken Sie
auf Edit (Bearbeiten), um einem vorhandenen Durchlaufplan zu dndern. Das Dialogfeld
Schedule Editor (Zeitplan-Editor) wird angezeigt.

Wahlen Sie den Namen des zu verwendenden Durchlaufbereichs aus der Dropdown-Liste Walk
the Scope (Durchlaufbereich), oder wahlen Sie Edit (Bearbeiten) aus, um einen neuen
Durchlaufbereich zu definieren.

Bei Auswahl von Edit (Bearbeiten) wird das Dialogfeld Scope Management (Durchlaufbereich-
Management) angezeigt, in dem Sie Durchlaufbereiche hinzufligen, bearbeiten oder entfernen
kénnen.

Klicken Sie auf Add (Hinzufligen), und geben Sie einen Namen fiir den neuen Durchlaufbereich
ein.

Klicken Sie auf OK, um das Dialogfeld Scope Editor (Durchlaufbereich-Editor) anzuzeigen.

Geben Sie den IP-Adressbereich in die Felder unter Current ltem (Aktuelles Element) ein, und
klicken Sie auf Add (Hinzufuigen), um den Bereich zur Liste auf der linken Seite hinzufligen.
Klicken Sie auf OK, wenn Sie die Festlegung von Durchlaufbereichen abgeschlossen haben.

Klicken Sie im Dialogfeld Scope Manager (Durchlaufbereich-Manager) auf Close (Schlief3en),
um zum Dialogfeld Schedule Editor (Zeitplan-Editor) zuriickzukehren,. Die von Ihnen definierten
Durchlaufbereiche werden im Feld Walk the scope (Durchlaufbereich) zur Auswahl angezeigt.

Wabhlen Sie das zu verwendende Gateway aus.

Verwenden Sie die Schedule (Zeitplan)-Optionen, um Zeitpunkt und Haufigkeit der
Taskausfiihrung anzugeben.

Klicken Sie auf OK.

Die Ergebnisse der geplanten Uberwachungstasks werden im Bereich Walking Tasks
(Uberwachungstasks) unten im Dialogfeld Status Walker angezeigt.

Status Walker
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Wenn Sie eine Uberwachungstask mit dem Status Finished (Fertig) auswahlen und dann auf die
Schaltflache View (Anzeigen) klicken, werden die Statusinformationen zu den gefundenen Geraten
angezeigt.

Konfigurieren von Status Walker

Sie kdnnen Status Walker (Statusdurchlauf) wie folgt konfigurieren, um das Tool an lhre
Anforderungen anzupassen:

1. Wahlen Sie Uber die Menuleiste in der HPDM Console die Befehle Werkzeuge > Konfiguration
aus, um das Fenster Konfigurations-Management anzuzeigen.

2. Wahlen Sie in der links angezeigten Struktur das Element Status Walker Configuration
(Statusdurchlaufkonfiguration) aus.

E/{ HINWEIS: Sie kdnnen eine Kurzbeschreibung einzener Optionen anzeigen, indem Sie in das
Optionsfeld klicken.

Geben Sie einen Wert fir die Walking Group Size (GréRe der Durchlaufgruppe) ein.

3

4. Legen Sie einen Wert fur Walking Timeout (Zeitlimit fur Durchlauf) fest.
5. Klicken Sie auf Apply (Ubernehmen), um die Einstellungen zu speichern.
6

Klicken Sie auf OK.

Status Snapshot (Statusschnappschuss)

Das Tool Status Snapshot (Status-Snapshot) erstellt eine "Momentaufnahme" des Netzwerks, d.h.
einem Bericht zum Status der Geréate, und speichert diesen auf dem Server. Sie kénnen diesen
Bericht dann bei gedffnetem Tool anzeigen. Das Tool arbeitet nicht in Echtzeit. Die Einstellungen fiir
Status Snapshot (Status-Snapshot) ermdglichen es dem Administrator, die zeitliche Durchfiihrung
und Haufigkeit der Uberwachung zu planen und festzulegen.

1. Offnen Sie Uber die Meniileiste der HPDM Console das Menii Werkzeuge, und wahlen Sie
Statussnapshot aus. Das Dialogfeld Statussnapshot wird angezeigt.

2. Klicken Sie auf Add (Hinzufiigen), um einen neuen Status-Snapshot-Zeitplan zu erstellen, oder
klicken Sie auf Edit (Bearbeiten), um einem vorhandenen Plan zu dndern. Das Dialogfeld
Schedule Editor (Zeitplan-Editor) wird angezeigt.

3. Planen Sie die Status-Snapshot-Task, indem Sie die Frequency (Haufigkeit) und die Start Time
(Startzeit) festlegen.

4. Klicken Sie auf OK.
5. Klicken Sie auf Close (Schlief3en).

Die Ergebnisse der geplanten Status-Snapshot-Tasks werden im Bereich Status Snapshot Tasks
(Status-Snapshot-Tasks) unten im Dialogfeld Status Snapshot (Status-Snapshot) angezeigt.

Wenn Sie eine Status-Snapshot-Task mit dem Status Finished (Fertig) auswahlen und dann auf die
Schaltflache View (Anzeigen) klicken, werden die Informationen zu den gefundenen Geraten
angezeigt.
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11 HP FTP Softwarekomponenten-Browser

Der HP FPT Softwarekomponenten-Browser ermdglicht die Automatisierung des Prozesses der
Nutzung von Softwarekomponenten, die sich auf der 6ffentlichen FTP-Website von HP befinden.

i WICHTIG: Diese Funktionen erfordern einen Internetzugang. Wenn das System, unter dem die
HPDM Console oder der Master-Repository-Controller laufen, nicht direkt auf das Internet zugreifen
kénnen, missen Sie zuerst die Proxy-Einstellungen konfigurieren. Weitere Informationen hierzu
finden Sie unter Konfigurieren der HP FTP-Proxy-Einstellungen auf Seite 80.

Sie kdnnen den HP FTP Softwarekomponenten-Browser dazu verwenden, Task-Vorlagen durch
Herunterladen einer Komponente zu generieren. Die folgenden Komponententypen stehen zur
Verfligung:

e Betriebssystem-Images — Generieren von Vorlagen des Typs _Deploy Image

e Anwendungen — Generieren von Vorlagen des Typs _File and Registry

Generieren von Task-Vorlagen

So verwenden Sie den HP FTP Softwarekomponenten-Browser zum Generieren von Task-Vorlagen:

1. Starten Sie die HPDM Console und wahlen Sie aus dem MenU die Befehle Template > Import >
HP FTP Software Component -Browser (Vorlage > Importieren > HP FTP
Softwarekomponenten-Browser) aus.

2. Das Dialogfeld ruft Komponenteninformation Gber Image und Anwendung vom HP FTP-Server
ab. Nutzen Sie die Funktion Search (Suchen), um Komponenten zu filtern. Wahlen Sie ein
Element aus und klicken Sie dann auf die Schaltflache Generate Templates (Vorlagen
generieren).

B HINWEIS: Wenn die HPDM Console oder der Master-Repository-Controller keinen direkten
Zugriff auf die HP FTP-Seite haben, klicken Sie auf den Link Proxy Setting (Proxy-
Einstellungen), um die Proxy-Einstellungen zu konfigurieren, oder navigieren Sie zu Main >
Tools > Configurations (Hauptmeni > Tools > Konfigurationen).

Die konfigurierten Proxy-Einstellungen werden in der Datenbank gespeichert. Alle Konsolen und
der Master-Repository-Controller verwenden fir die Herstellung einer Verbindung zum HP FTP-
Server dieselben Proxy-Einstellungen.

3. Das Dialogfeld ,Package Description Editor* (Paketbeschreibungs-Editor) zeigt die
Standardinformation der Anwendung oder der Image-Komponente an. Nutzen Sie die
Standardinformation oder verandern Sie sie und klicken Sie dann auf die Schaltflache Generate
(Generieren).
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B HINWEIS: Wenn Sie auf das Textfeld Thin Client Models (Thin Client-Modelle) klicken, kénnen
Sie mithilfe eines Dialogfeldes die Thin-Client Modelle auswahlen. Dieser Wert beeinflusst die
Ubermittlung der Anwendung oder des Image.

4. Wahlen Sie das Betriebssystem, auf dem die Vorlagen generiert werden sollen und klicken Sie
dann auf OK. In dem angegebenen Betriebssystem wird eine Vorlage generiert.

993

& HINWEIS: Wenn Sie mehr als ein Betriebssystem auswahlen, wird unter jeder Registerkarte
mit einem Betriebssystem eine Vorlage generiert.
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5. Sie kdnnen die Vorlage im Task-Bereich in der Registerkarte Task Templates (Task-Vorlagen)
anzeigen. Der Vorlagenstatus lautet Transferring (Wird ubertragen). Die Komponente des HP
FTP-Servers wird im Hintergrund Ubertragen und im Master-Repository gespeichert, in dem
Dateien als Nutzlast von Vorlagen gespeichert werden. Die Vorlage ist ungultig, bis die
Ubertragung abgeschlossen ist.

6. Nachdem die Ubertragung erfolgreich abgeschlossen wurde, wird die Vorlage giiltig. Sie kénnen
die generierte Vorlage dann an das angegebene Gerat senden.

Konfigurieren der HP FTP-Proxy-Einstellungen

Far die Verwendung des HP FTP Softwarekomponenten-Browser missen Proxy-Einstellungen
konfiguriert werden, wenn das System, unter dem die HPDM Console oder der Master-Repository-
Controller laufen, nicht direkt auf das Internet zugreifen kénnen.

So konfigurieren Sie die HP FTP-Proxy-Einstellungen:

1. Wahlen Sie aus dem Meni der HPDM Console Tools > Configuration (Tools > Konfiguration)
aus.

2. Wahlen Sie im Fenster Configuration Management (Konfigurationsverwaltung) die Seite HP FTP
Proxy (HP FTP-Proxy) aus.

3. Wabhlen Sie eine der folgenden Optionen:

e Use automatic configuration script (Verwendung des automatischen Konfigurationsskripts)
— Verwenden Sie diese Option, um den Pfad zu einer Datei zur automatischen
Konfiguration der Proxy-Einstellungen anzugeben.

o Use manual configuration (Manuelle Konfiguration verwenden) — Verwenden Sie diese
Option, um die Proxy-Einstellungen manuell anzugeben.

4. Klicken Sie auf Test (Testen), wenn Sie die Proxy-Einstellungen testen méchten.

5. Klicken Sie auf OK.
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& HINWEIS: HPDM unterstiitzt nur HTTP/1.1 (Verbindungsmethode) und SOCKS5.
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12

HPDM Server Backup and Restore Tool

Das HPDM Server Backup and Restore Tool kann Dateien oder Datenbanken vom HPDM Server
sichern oder wiederherstellen, darunter die folgenden Elemente:

e Datenbankschema und Daten

° [HPDM Installation Root]\Server\task-Ordner

° [HPDM Installation Root]\Server\template-Ordner

° [HPDM Installation Root]\Server\template plugins-Ordner

Beachten Sie vor der Verwendung des HPDM Server Backup and Restore Tool Folgendes:

e Dieses Tool erfordert die Anmeldedaten eines Benutzerkontos mit Datenbankeigentimer-
Berechtigung.

e Der HPDM Server muss Version 4.5 oder héher sein.
So starten Sie das HPDM Server Backup and Restore Tool:

A Kilicken Sie auf Start > Allle Programme > Hewlett-Packard > HPDM > HPDM Server Backup
and Restore Tool.

%> TIPP: Klicken Sie im Windows Server 2012 auf die KachelHPDM Server Backup and Restore
Tool auf der Startseite.

Die folgende Tabelle beschreibt die Felder, die beim HPDM Server Backup and Restore Tool zur
Verfiigung stehen.

Tabelle 12-1 HPDM Server Backup and Restore Tool

Feld Beschreibung

Datenbank-Typ Zeigt den Datenbanken-Typ an, entweder PostgreSQL oder MS SQL Server (kann nicht
geandert werden)

Host Zeigt die HPDM Server-Hostnamen oder die IP-Adresse (kann nicht gedndert werden)

Anschluss Zeigt den Uberwachungsport der Datenbank an (kann nicht bearbeitet werden)

Datenbank Zeigt den Namen der Datenbank an (kann nicht bearbeitet werden)

Authentifizierung Ermdglicht dem Benutzer die Auswahl des Authentifizierungstyp, je nach Typ der Datenbank,

und zwar wie folgt:
e  PostgreSQL - Datenbank-Authentifizierung
e MS SQL Server - Datenbank-Authentifizierung oder Windows-Authentifizierung

Benutzername Ermdglicht dem Benutzer die Eingabe des Benutzernamens fiir ein Konto mit
Datenbankeigentiimer-Berechtigung.

Kennwort Ermdglicht dem Benutzer die Eingabe des Kennwortes flr ein Konto mit
Datenbankeigentimer-Berechtigung.
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Tabelle 12-1 HPDM Server Backup and Restore Tool (Fortsetzung)

Feld Beschreibung

Sicherungsordner Gibt dem Benutzer die Moglichkeit eine bereits vorhandenen Ordner anzugeben, in dem die
Backups (Sicherungen) gespeichert werden sollen

HINWEIS: Der Bereich Meldungen auf der rechten Seite des Tool zeigt den Fortschritt und die Ergebnisse wahrend einer
Sicherung oder Wiederherstellung an.

Sicherung des HPDM Servers

So sichern Sie den HPDM Server:

1. Wahlen Sie im der HPDM Server Backup and Restore Tool den Authentifizierungstyp aus und
geben Sie die Anmeldeinformationen eines Benutzers mit Datenbankeigentimer-Berechtigung
ein.

2. Geben Sie einen bereits vorhandenen Ordner an, in dem die Sicherung gespeichert wird.

¥ TIPP: Jede Sicherung erstellt einen neuen Unterordner, der alle Sicherungsinhalte enthalt. Sie
kénnen also zum Speichern samtlicher Sicherungen den gleichen tibergeordneten Ordner
nutzen.

3. Kilicken Sie auf die Schaltflache Sichern.

[%f’ HINWEIS: Wenn der Sicherungs-Ordnerpfad auf einen noch nicht vorhandenen Ordner oder
auf einen Unterordner mit einer vorhandenen Sicherungs verweist (wie z. B.
Dmbackup20121107145359), ist die Schaltflache Sichern deaktiviert.

4. Sie werden aufgefordert, den HPDM Server anzuhalten. Dies kénnen tun, indem Sie mit der
rechten Maustaste auf das Taskleistensymbol klicken und Gerate-Management-Server anhalten
auswahlen. Klicken Sie nachdem der HPDM Server angehalten wurde auf Ja, um fortzufahren.

/\ACHTUNG: Die Aufforderung wird nicht noch einmal angezeigt, wenn der HPDM Server nicht
ordnungsgemal gestoppt wurde. Wenn der HPDM Server nicht angehalten wird, kann das Tool
keine erfolgreiche Sicherung gewahrleisten, auch wenn der Vorgang mdoglicherweise fortlduft
und mit einer Erfolgsmeldung abschlieft.

5. Starten Sie nachdem die Sicherung abgeschlossen ist den HPDM-Server neu, indem Sie mit der
rechten Maustaste auf das Taskleistensymbol klicken und Geréate-Management-Server starten
auswahlen.

Wiederherstellen des HPDM Servers

So stellen Sie den HPDM Server wieder her:

1. Wahlen Sie im der HPDM Server Backup and Restore Tool den Authentifizierungstyp aus und
geben Sie die Anmeldeinformationen eines Benutzers mit Datenbankeigentiimer-Berechtigung
ein.

2. Geben Sie den Ordner mit einer bestehenden Sicherung an (z. B.
Dmbackup20121107145359).

3. Klicken Sie auf Wiederherstellen.

[%f’ HINWEIS: Wenn der Sicherungs-Ordnerpfad nicht auf eine vorhandene Sicherung verweist ist
die Schaltflache Wiederherstellen deaktiviert.
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4. Sie werden aufgefordert, den HPDM Server anzuhalten. Dies kénnen tun, indem Sie mit der
rechten Maustaste auf das Taskleistensymbol klicken und Gerate-Management-Server anhalten
auswabhlen. Klicken Sie nachdem der HPDM Server angehalten wurde auf Ja, um fortzufahren.

/\ACHTUNG: Die Aufforderung wird nicht noch einmal angezeigt, wenn der HPDM Server nicht
ordnungsgemalf gestoppt wurde. Wenn der HPDM Server nicht angehalten wird, kann das Tool
keine erfolgreiche Wiederherstellung gewahrleisten, auch wenn der Vorgang moglicherweise
fortlauft und mit einer Erfolgsmeldung abschlief3t.

5. Starten Sie nachdem die Wiederherstellung abgeschlossen ist den HPDM-Server neu, indem
Sie mit der rechten Maustaste auf das Taskleistensymbol klicken und Geréte-Management-
Server starten auswahlen.

% TIPP: Der HPDM Server wird nicht neu gestartet, falls die Wiederherstellung fehlgeschlagen ist
und innerhalb des Vorgangs abgebrochen wurde. Versuchen Sie es in diesem Fall eine erneute
Wiederherstellung mit derselben oder in einer anderen Sicherung.

Ef HINWEIS: Eine Datenbank-Sicherung kann nur in einer Datenbank des selben Typs
wiederhergestellt werden. Wenn Sie zum Beispiel eine Sicherung einer SQL Server-Datenbank
erstellt haben, kdnnen Sie diese nur in einer SQL Server-Datenbank wiederherstellen, nicht in einen
anderen Datenbanktyp.
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13 HPDM Port Check Tool

Das HPDM Port Check Tool ist ein Dienstprogramm zur Prifung des Netzwerks und der Konnektivitat
des Dienstes und Firewall-Port-Erlaubnis zwischen verschiedenen Komponenten des HPDM. Das
Tool ist unter folgendem Pfad zu finden:

<HPDM Installation Path>\Console\bin\HPDMPortCheck\

Kopieren Sie das Tool (das komplette Verzeichnis) zu einem Verbindungs-Initiator (ein Thin Client),
fihren Sie das Tool aus und verwenden Sie es, um eine Verbindung zur Zielkomponente
herzustellen. Die Syntax der Befehlszeile ist wie folgt:

HPDMPortCheck <target> [flags]
Der <ziel>-Computer wird Gberprift. Geben Sie eine IP-Adresse oder einen Hostnamen an.

Die [Flags] werden in unten stehender Tabelle beschrieben.

Flag Beschreibung

-a Uberpriifen Sie den HPDM Agent-Port (40001).

-g Uberpriifen Sie den HPDM Gateway-Port (40003).

-s Uberpriifen Sie die HPDM Server-Ports (1099, 40002, 40005).
-m Uberpriifen Sie den Master-Repository-Controller-Port (40012).
-n Uberpriifen Sie den HPDM VNC SSL Proxy-Port (40004).

[%’/]"’ HINWEIS: Ist keine Flag vorhanden, bedeutet dies, dass alle Ports Uberprift werden.

Siehe folgende Beispiele:

Verwenden Sie folgenden Befehl, um zu priifen, ob das HPDM Gateway vom HPDM Agent aus
erreichbar ist:

HPDMPortCheck.exe <Gateway IP address or hostname> —-g

Verwenden Sie folgenden Befehl fiir die Uberpriifung des HPDM Agent-Ports eines Computers mit
der IP-Adresse 192.168.1.100:

HPDMPortCheck 192.168.1.100 -a

Verwenden Sie folgenden Befehl fiir die Uberpriifung der Ports des HPDM Gateway, HPDM Server
und Master-Repository-Controller auf einem Computer mit dem Hostnamen ,,CorpServer*;

HPDMPortCheck CorpServer —-gsm

Weitere Informationen zu spezifischen Ports finden Sie unter ,Portverweis” auf Seite 92.
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14 Periodische HPDM Agent-Abfrage und
Fehlerprotokollierung

In diesem Kapitel werden die Mdglichkeiten zur periodischen Abfrage (Polling) von HPDM Agents
und Fehlerprotokollierung mit HPDM beschrieben.

Periodische HPDM Agent-Abfrage

Ein HPDM Gateway kann fir die periodische Kommunikation mit HPDM Agents (Agenten-Polling)
und die Aktualisierung des Geréatestatus (Ein/Aus) auf dem HDPM Server konfiguriert werden. Das
Standardintervall ist 0 und deaktiviert das Polling, um den Netzwerkverkehr nicht unnétig zu erhdhen.
Eine genaue Beschreibung der beiden Polling-Parameter kann in der grafischen Benutzeroberflache
der Konfigurationssoftware durch Positionierung des Mauszeigers Giber dem Text gefunden werden.

Sie kdnnen eine der folgenden Methoden verwenden, um die Einstellungen fur das HPDM Agent-
Polling zu andern:

e Verwenden Sie das Dialogfeld fir die Gateway-Konfiguration, das durch Klicken mit der rechten
Maustaste auf das HPDM Gateway-Symbol in der Taskleiste aufgerufen werden kann.

e Senden Sie einen Task zum Konfigurieren des HPDM Gateways von der HPDM Console.
Wahlen Sie auf der Registerkarte HPDM-Gateways ein HPDM Gateway aus, und klicken Sie auf
Konfigurieren, oder klicken Sie mit der rechten Maustaste auf das HPDM Gateway, und wahlen
Sie im Kontextmeni den Befehl HPDM Gateway konfigurieren aus.

Fehlerprotokollierung

HPDM implementiert eine Fehlerprotokollierung fiir jede der verschiedenen Komponenten. Fehler
werden nach Stufen protokolliert. Wenn Sie eine Protokollierungsstufe fiir eine Komponente
festlegen, werden Fehler dieser oder einer héheren Stufe protokolliert.

HPDM Agent-Protokollierung

Tabelle 14-1 HPDM Agent-Protokollierung

Stufe Beschreibung

INFORMATION Protokolle Giber Laufzeitinformationen, enthalt keine Fehler

WARNING Geringfligige Fehler

ERROR Signifikante Fehler

Um die Protokollierungsstufe fir den HPDM Agent zu &ndern, legen Sie diese entweder im Dialogfeld
fur das Konfigurieren des HPDM Agent auf dem Geréat fest, oder Sie senden einen ,,Configure Agent®-
Task an das Zielgerat.
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HPDM Gateway-Protokollierung

Tabelle 14-2 HPDM Gateway-Protokollierung

Stufe Beschreibung

TRACE Einige Ablaufprotokolle; Siehe beispielsweise Anzahl der HPDM Agents

DEBUG Interne Protokollierung fiir Debugging-Zwecke

INFO Protokolliert einige Berichtsinhalte

WARN Geringfligige Fehler; Beispiel: Keine Verbindung vom HPDM-Gateway zur Console oder zum Server
moglich, eventuell ist Server nicht betriebsbereit, HPDM Gateway wird es spater erneut versuchen

ERROR Signifikante Fehler

FATAL Schwerwiegende Fehler; dieser Fehler fuhrt dazu, dass HPDM Gateway nicht normal ausgefiihrt wird

Verwenden Sie eine der folgenden Methoden, um die Protokollierungsstufe fir ein HPDM Gateway
zu andern:

e Verwenden Sie das Dialogfeld fir die HPDM Gateway-Konfiguration, das durch Klicken mit der
rechten Maustaste auf das HPDM Gateway-Symbol in der Taskleiste aufgerufen werden kann.

e Senden Sie einen Task zum Konfigurieren des HPDM Gateways von der HPDM Console.
Wahlen Sie auf der Registerkarte HPDM-Gateways ein HPDM Gateway aus, und klicken Sie auf
Konfigurieren, oder klicken Sie mit der rechten Maustaste auf das HPDM Gateway, und wahlen
Sie im Kontextmenu den Befehl HPDM Gateway konfigurieren aus.

HPDM Server- und HPDM Console-Protokollierung

Tabelle 14-3 HPDM Server- und HPDM Console-Protokollierung

Stufe Beschreibung

DEBUG Untergeordnete Debugging-Informationen

INFO Protokolle tiber Laufzeitinformationen, enthélt keine Fehler

WARN Protokolliert Warnungen, also Hinweise darauf, dass etwas Unerwartetes geschehen ist
FATAL Schwerwiegende Fehler

So andern Sie die Log-Stufe des HDPM Servers:

A Andern Sie den Wert des hpdm. log. level in der Datei /Server/conf/server.conf.
Diese befindet sich im HPDM Installationsverzeichnis.

Log-Dateien des HPDM Server befinden sich unter /Server/logs/.
So andern Sie die Log-Stufe der HDPM Console:

A Andern Sie den Wert des hpdm. 1og. level in der Datei /Console/conf/server.conf.
Diese befindet sich unter $programdata%/Hewlett-Packard/HP Device Manager.

¥ TIPP: Auf das Verzeichnis $programdata% kann gemal der Windows UAC-Richtlinie
zugegriffen werden. Diese bezieht sich je nach Betriebssystem auf C: \ProgramData oder C:
\Documents und Settings\All Users\Application Data.
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Log-Dateien der HPDM Console befinden sich unter /Console/logs/.

Protokollierung fiir den Master-Repository-Controller

Stufe Beschreibung

INFORMATION Protokolle tiber Laufzeitinformationen, enthalt keine Fehler

WARNING Geringflgige Fehler

ERROR Signifikante Fehler

So andern Sie die Log-Stufe des Master-Repository-Controller:

A Andern Sie den Wert des LogLevel (Log-Stufe) in der Datei /
MasterRepositoryController/Controller.conf. Diese befindet sich im HPDM
Installationsverzeichnis.

Die Log-Datei des Master-Repository-Controller befindet sich unter /
MasterRepositoryController/log/.
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A Vorlagenreferenz

In HPDM werden die Vorlagen in die folgenden Kategorien unterteilt:

File and Registry (Dateien und Registry)

Agent

Connections (Verbindungen)

Imaging

Operations (Operationen)

Einstellungen

Template Sequence (Vorlagensequenz)

File and Registry (Dateien und Registry)

Tabelle A-1 Vorlagen fir Dateien und Registrierung

Vorlage

Beschreibung

_File and Registry

Diese Vorlage dient zum Erstellen einer Sequenz mithilfe der folgenden

untergeordneten Vorlagen:

Einstellen eines Registriy-Schllssels.

Zeichnen Sie eine Datei von einem Geréat auf.

Stellen Sie eine Datei fiir ein Gerat bereit.

Flhren Sie einen Befehl auf einem Geréat aus.

Léschen Sie Dateien auf einem Geréat.

Anhalten einer Sequenz.

Hinzufligen oder Entfernen eines Programmberichts an einem Gerat.

Fihren Sie ein Skript auf einem Gerat aus.

_Get Registry

Diese Vorlage dient zum Hochladen mindestens eines Schliissels aus einer Geréate-

Registry.

Agent

Tabelle A-2 HPDM Agent-Vorlagen

Vorlage

Beschreibung

_Configure Agent

Diese Vorlage dient zum Konfigurieren des HPDM Agent auf dem Zielgerat.

HINWEIS: Sie kénnen das aktuelle HPDM Gateway nicht mehr nach dem Typ 'cur-
gateway, back-gateway' im Feld Backup HPDM Gateway (HPDM-
Sicherungsgateway) festlegen.
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Tabelle A-2 HPDM Agent-Vorlagen (Fortsetzung)

Vorlage

Beschreibung

_Configure Task Deferment

Diese Vorlage dient zum Konfigurieren der Einstellungen der Aufgabenverschiebung
auf den Zielgeraten.

_Update Agent

Diese Vorlage dient zum Aktualisieren des HPDM Agent auf den Zielgeraten auf eine
Version, die in Ihrem Repository gespeichert ist. Die Nutzlast wird automatisch mit
den zugeordneten Repositorys synchronisiert, noch bevor der Task zu den
Zielgeraten gesendet wird.

Connections (Verbindungen)

Tabelle A-3 Verbindungsvorlagen

Vorlage

Beschreibung

_Pull Connection Configuration

Diese Vorlage dient zum Extrahieren der angegebenen Verbindungseinstellungen
von einem Gerat und Erstellen einer neuen Vorlage, um diese Verbindungen auf
andere Gerate zu Ubertragen.

_Capture Connections

Diese Vorlage dient zum Aufzeichnen von Verbindungen von PColP Zero Clients.

_Deploy Connections

Diese Vorlage dient zur Bereitstellung von Verbindungen zu PColP Zero Clients.

Imaging

Tabelle A-4 Vorlagen zur Erstellung von Images

Vorlage

Beschreibung

_Capture Image

Diese Vorlage dient zum Aufzeichnen eines Images auf dem Zielgerat und Hochladen
des Images in das Master-Repository. AuRerdem wird eine neue Vorlage vom Typ
.Deploy Image* (Image-Bereitstellung) erstellt, um das Image auf anderen Geraten zu
installieren. Diese Vorlage kann jeweils nur an ein einziges Gerat gesendet werden.

_PXE Capture

Diese Vorlage dient zum Aufzeichnen eines Images mithilfe des PXE-Dienstes auf
dem Gerat und Hochladen des Images in das Master-Repository. AuRerdem wird
eine neue Vorlage vom Typ ,PXE Deploy“ (PXE-Bereitstellung) erstellt, um das Image
auf anderen Geraten zu installieren. Diese Vorlage kann jeweils nur an ein einziges
Gerat gesendet werden.

HINWEIS: Diese Vorlage ist nicht fur Gerate verfligbar, auf denen HP Smart Zero
Core lauft.

_Update Firmware

Diese Vorlage dient zum Aktualisieren der Firmware von PColP Zero Clients. Sie
mussen zur Generierung diese Vorlage eine Firmware-Datei importieren.

Operations (Operationen)

Tabelle A-5 Vorgangsvorlagen

Vorlage

Beschreibung

_Factory Reset

Diese Vorlage dient zum Zuriicksetzen der Zielgerate auf ihre urspriingliche
Konfiguration. Die Auswirkungen dieser Vorlage variieren je nach Betriebssystem auf
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Tabelle A-5 Vorgangsvorlagen (Fortsetzung)

Vorlage

Beschreibung

dem jeweiligen Gerat. Die Option zum Zurlcksetzen auf Current Profile (Aktuelles
Profil) ist ausschlieBlich beim HP ThinPro Betriebssystem verfligbar.

_Get Asset Information

Diese Vorlage dient zum Extrahieren des vollstdndigen Inventarberichts von den
Zielgeraten.

_Reboot Device

Diese Vorlage dient zum Neustarten der Zielgerate. Auf den Bildschirmen der Gerate
wird fir 15 Sekunden eine Warnmeldung angezeigt, bevor der Neustart tatsachlich
durchgefiihrt wird.

_Reverse Shadow Device

Diese Vorlage bewirkt, dass vom HPDM Agent auf einem Zielgerat iiber SSL-Tunnel
eine Verbindung zum in die HPDM Console eingebundenen VNC-Viewer hergestellt
wird. Diese Vorlage ist fur die HPCE Thin Clients nicht verflgbar.

_Send Message

Diese Vorlage sendet eine benutzerdefinierte Nachricht an Zielgerate. Diese Vorlage
ist fur HP ThinPro-Thin Clients nicht verfugbar.

_Shadow Device

Diese Vorlage bewirkt, dass von dem in die HPDM Console eingebundenen VNC-
Viewer Uber SSL-Tunnel eine Verbindung zum VNC-Dienst auf einem Zielgerat
hergestellt wird.

_Shutdown Device

Uber diese Vorlage werden die Zielgerate heruntergefahren. Auf den Bildschirmen
der Gerate wird fur 15 Sekunden eine Warnmeldung angezeigt, bevor der Neustart
tatsachlich durchgefiihrt wird.

_Start Resource Monitor

Diese Vorlage startet den Ressourcenmonitor fiir das Zielgerat. Diese Vorlage kann
jeweils nur an ein einzelnes Gerat gesendet werden und ist nicht fir HP ThinPro Thin
Clients verflgbar.

Wenn diese Vorlage erfolgreich an ein Gerat gesendet wurde, wird ein Dialogfenster
,Resource Monitor* (Ressourcenmonitor) angezeigt. Sie kbnnen Prozesse, Leistung
und Netzwerkdisketten liberwachen.

_Wake Up Device

Diese Vorlage bewirkt, dass vom HPDM Gateway, das den Zielgeraten zugeordnet
ist, eine Wake-On-LAN-Nachricht an die Gerate gesendet wird. Das Wake-Gerat
funktioniert nicht nur bei Geraten, die sich im selben Subnetz befinden wie das HPDM
Gateway, sondern auch bei Geraten, die sich nicht im selben Subnetz wie das HPDM
Gateway befinden, sofern im Subnetz mindestens ein HPDM Agent verbunden ist.
Gerate hinter einer NAT kénnen aktiviert werden, wenn im Subnetz mindestens ein
HPDM Agent verbunden ist. Wahrend einer Zeitliberschreitung meldet das HPDM
Gateway den unvollendeten Teil als Fehler.

Einstellungen

Tabelle A-6 Einstellungsvorlagen

Vorlage

Beschreibung

_Apply Settings

Diese Vorlage dient zum Erstellen einer Gruppe benutzerdefinierter Einstellungen und
zum Bereitstellen der Einstellungen auf mindestens einem Gerét.

_Clone Settings

Diese Vorlage dient zum Kopieren einer Auswahl benutzerdefinierter Einstellungen
von einem Gerat und zum Bereitstellen dieser Einstellungen auf anderen Geraten.

_Deploy Profile

Diese Vorlage dient zur Konfiguration eines Profils und zur Bereitstellung dieses
Profils auf anderen Thin Clients, auf denen HP Smart Zero Core lauft.

_Enroll Certificate With SCEP

Diese Vorlage dient zum Registrieren von Zertifikaten mit SCEP auf normalen Thin
Clients.
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Tabelle A-6 Einstellungsvorlagen (Fortsetzung)

Vorlage

Beschreibung

_Hostname and IP

Diese Vorlage dient zum Andern von Hostname und IP-Adresse fiir einen oder
mehrere Geréte. Es sind zwei Optionen verflgbar:

e Modify specified devices (Angegebene Gerate andern)—Funktioniert nur, wenn
Sie sie zu einem oder mehreren Zielgeraten ziehen.

e  Set with pattern (Mit Muster einstellen)—Andert Hostname und IP-Adresse nach
demselben Muster.

_Set Domain

Die Vorlage ,_Set Domain® ermdglicht den Beitritt von Geraten zu einer Domane oder
Arbeitsgruppe.

_Set Password

Mit dieser Vorlage kdnnen Sie ein Kennwort fir Benutzer auf mindestens einem Gerat
festlegen. Sie kénnen das Kontrollkéstchen hide password (Kennwort ausblenden)
aktivieren, um das Kennwort auszublenden. Wenn Sie das Kontrollkéstchen
deaktivieren, wird das Kennwort hingegen eingeblendet.

HINWEIS: Diese Vorlage ist nicht fur Gerate verfligbar, auf denen HP Smart Zero
Core lauft.

_Take TPM Ownership

Diese Vorlage aktiviert TPM und legt das TPM-Besitzerkennwort und BIOS-Kennwort
fest, um in den TPM-Besitz der ausgewahlten Gerate zu gelangen.

_Write Filter Settings

Diese Vorlage dient zum Andern der Schreibfiltereinstellungen fiir ein Gerét.

Template Sequence (Vorlagensequenz)

Tabelle A-7 Vorlagensequenz-Vorlagen

Vorlage

Beschreibung

_Template Sequence

Vorlagensequenzen werden verwendet, um einen Satz Vorlagen zu kombinieren und
in einer Task mit einer angegebenen Reihenfolge und angegebenen Konditionen
auszufiihren.

Template Sequence (Vorlagensequenz)
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B Portverweis

In de

r folgenden Abschnitten sind die von HPDM verwendeten Ports aufgelistet:

HPDM Console-Anschliisse

HPDM Server-Anschlisse

HPDM Gateway Ports

HPDM Agent Ports

Repository-Ports

HPDM Console-Anschliisse

Tabelle B-1 HPDM Console-Ports (eingehender Datenverkehr)

Receiver- Sender Empfénger Protokoll Funktion

Port

5500 SSL-VNC-Proxy (im VNC-Viewer TCP VNC-Viewer im Uberwachungsmodus
Verbund mit HPDM (zusammen mit HPDM  (Loopback (Reverse VNC)
Console) Console) )

5900 VNC-Viewer (im SSL-VNC-Proxy (im TCP VNC-Viewer im Uberwachungsmodus
Verbund mit HPDM Verbund mit HPDM (Loopback (Reverse VNC)
Console) Console) )

40004 SSL-VNC-Proxy (im VNC-Proxy (im Verbund TCP SSL-VNC-Proxy im Uberwachungsmodus
Verbund mit HPDM mit HPDM Console) (Reverse VNC)
Agent)

Tabelle B-2 HPDM Console-Ports (ausgehender Datenverkehr)

Receiver- Sender Empfénger Protokoll ~ Funktion

Port

20 und 21 HPDM Console FTP-Server (Software TCP Dies sind die Standardports fur FTP (flr
anderer Anbieter) Repositorys genutzt). Port 20 dient dem

Datentransfer und Port 21 dem
Uberwachen von Befehlen. Die FTP-Ports
kénnen uber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fur den FTP-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall

entsprechend.
22 HPDM Console SFTP-Server (Software  TCP Dies ist der Standardport fir den SFTP-
eines Drittanbieters) Server (fur Repositorys genutzt). Der

SFTP-Port kann tber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fur den SFTP-Server nicht
den Standardport verwenden,
konfigurieren Sie die Firewall
entsprechend.
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Tabelle B-2 HPDM Console-Ports (ausgehender Datenverkehr) (Fortsetzung)

Receiver- Sender Empfénger Protokoll Funktion

Port

137 HPDM Console NetBIOS-Namensdienst UDP Ermaoglicht NetBIOS-Namensaufldsung

138 HPDM Console NetBIOS- UDP Erméglicht Ubertragung und Empfang von

Datagrammdienst NetBIOS-Datagrammen

139 HPDM Console NetBIOS-Sitzungsdienst TCP Ermoglicht NetBIOS-Sitzungsdienst-
Verbindungen

445 HPDM Console Microsoft- TCP Fur Datei- und Druckerfreigabe, um SMB-

Verzeichnisdienste Ubertragung und -Empfang tiber Named
Pipes zu ermdglichen

989 und 990 HPDM Console FTPS-Server (Software  TCP Dies sind die Standardports fiir FTPS (fur
eines Drittanbieters) Repositorys genutzt). Port 989 dient dem
Datentransfer und Port 990 dem
Uberwachen von Befehlen. Die FTPS-
Ports kénnen tber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fur den FTPS-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall
entsprechend.
1099 HPDM Console HPDM Server TCP Ermdglicht der HPDM Console, die RMI-
Registry abzufragen
5500 SSL-VNC-Proxy (im VNC-Viewer (im TCP VNC-Viewer im Uberwachungsmodus
Verbund mit HPDM Verbund mit HPDM (Loopback (Reverse VNC)
Console) Console) )

5900 VNC-Viewer (im VNC-Proxy (im Verbund TCP VNC-Remotesteuerung
Verbund mit HPDM mit HPDM Console) (Loopback
Console) )

40002 HPDM Console HPDM Server TCP Ermdglicht der HPDM Console,
Remoteobjekte auf dem HPDM Server
per RMI aufzurufen

40004 SSL-VNC-Proxy (im VNC-Proxy (im Verbund TCP Port fir SSL-VNC-Verbindung

Verbund mit HPDM
Console)

mit HPDM Agent)

HPDM Server-Anschlisse

Tabelle B-3 HPDM Server-Ports (eingehender Datenverkehr)

Receiver- Sender Empfénger Protokoll Funktion

Port

1099 HPDM Console HPDM Server TCP Ermaoglicht der HPDM Console, die RMI-
Registry abzufragen

40002 HPDM Console HPDM Server TCP Ermdoglicht der HPDM Console,
Remoteobjekte auf dem HPDM Server
per RMI aufzurufen

40005 HPDM Gateway HPDM Server TCP Ermdglicht dem HPDM Gateway, Berichte

an den HPDM Server zu senden
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Tabelle B-3 HPDM Server-Ports (eingehender Datenverkehr) (Fortsetzung)

Receiver- Sender Empfanger Protokoll Funktion
Port
40006 HPDM Server PostgreSQL TCP Der standardmaRige Datenbank-
(zusammen mit HPDM (Loopback Uberwachungsport fiir PostgreSQL (nur
Server) ) notwendig, wenn PostgreSQL verwendet
wird)
40009 HPDM Agent HPDM Server TCP Ermdglicht dem HPDM Agent,

Ressourceninformationen (CPU, RAM,
Festplatten- und Netzwerk-E/A, Prozesse
usw.) an den HPDM Server zu senden.
Der HPDM Server sendet einen ,stop
process“-Befehl an den HPDM Agent.

Tabelle B-4 HPDM Server-Ports (ausgehender Datenverkehr)

Receiver- Sender Empfénger Protokoll Funktion
Port
40000 HPDM Server HPDM Gateway UDP Ermdglicht dem HPDM Server die
perodische Abfrage des HPDM Gateways
40003 HPDM Server HPDM Server TCP Ermoglicht dem HPDM Server, Tasks an
das HPDM Gateway zu senden
40006 HPDM Server PostgreSQL (im TCP Der standardmaRige Datenbank-
Verbund mit HPDM (Loopback Uberwachungsport fiir PostgreSQL (nur
Server) ) notwendig, wenn PostgreSQL verwendet
wird)
40012 HPDM Server Master-Repository- TCP Ermdglicht dem HPDM Server, zur

Controller

Verwaltung des Master-Repositorys mit
dem Master-Repository-Controller zu
kommunizieren

HPDM Gateway Ports

Tabelle B-5 HPDM Gateway-Ports (eingehender Datenverkehr)

Receiver- Sender Empféanger Protokoll Funktion
Port
67 PXE Client (Thin-Client- HPDM PXE Server UDP PXE-Bootstrap
Seite) (zusammen mit HPDM
Gateway)
69 PXE Client (Thin-Client- HPDM PXE Server TFTP (Trivial File Transfer Protocol)
Seite) (zusammen mit HPDM UDP
Gateway)
4011 PXE Client (Thin-Client-  Proxy DHCP Service UDP Proxy DHCP Service (Alternative fur Port
Seite) (Software anderer 67, falls Port 67 nicht verfligbar ist)
Anbieter)
40000 HPDM Server HPDM Gateway UDP Ermdglicht dem HPDM Server und dem
HPDM Agent die periodische Abfrage des
HPDM Agent

HPDM Gateways
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Tabelle B-5

HPDM Gateway-Ports (eingehender Datenverkehr) (Fortsetzung)

Receiver- Sender Empfanger Protokoll Funktion
Port
40003 HPDM Server HPDM Gateway TCP Ermaoglicht dem HPDM Server, Tasks an
das HPDM Gateway zu senden
HPDM Agent
Ermdglicht dem HPDM Agent, Berichte
an das HPDM Gateway zu senden
40008 HPDM Gateway HPDM Gateway TCP Ermdglicht dem HPDM Gateway, den
Controller HPDM Gateway-Controller zu
benachrichtigen, wenn andere Gateways
im selben Subnetz aktiv sind
Tabelle B-6 HPDM Gateway-Ports (ausgehender Datenverkehr)
Receiver- Sender Empfénger Protokoll Funktion
Port
20 und 21 HPDM Gateway FTP-Server (Software TCP Dies sind die Standardports fiir FTP (fur
eines Drittanbieters) Repositorys genutzt). Port 20 dient dem
Datentransfer und Port 21 dem
Uberwachen von Befehlen. Die FTP-Ports
kénnen uber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fur den FTP-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall
entsprechend.
22 HPDM Gateway SFTP-Server (Software Dies ist der Standardport fir den SFTP-
eines Drittanbieters) Server (fiir Repositorys genutzt). Der
SFTP-Port kann tber die HPDM Console
TCP konfiguriert werden. Wenn Sie in den
Einstellungen fir den SFTP-Server nicht
den Standardport verwenden,
konfigurieren Sie die Firewall
entsprechend.
68 HPDM PXE Server (im HPDM Imaging Mini UDP PXE-Bootstrap
Verbund mit HPDM Linux Tool (Client-Seite)
Gateway)
137 HPDM Gateway NetBIOS-Namensdienst UDP Ermdglicht NetBIOS-Namensauflésung
138 HPDM Gateway NetBIOS- ubP Erméglicht Ubertragung und Empfang
Datagrammdienst von NetBIOS-Datagrammen
139 HPDM Gateway NetBIOS-Sitzungsdienst TCP Ermdglicht NetBIOS-Sitzungsdienst-
Verbindungen
445 HPDM Gateway Microsoft- TCP Fur Datei- und Druckerfreigabe, um SMB-
Verzeichnisdienste Ubertragung und -Empfang {iber Named
Pipes zu ermdglichen
989 und 990 HPDM Gateway FTPS-Server (Software ~ TCP Dies sind die Standardports fir FTPS (fir

eines Drittanbieters)

Repositorys genutzt). Port 989 dient dem
Datentransfer und Port 990 dem
Uberwachen von Befehlen. Die FTPS-
Ports kénnen tber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fur den FTPS-Server nicht
die Standardports verwenden,

HPDM Gateway Ports
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Tabelle B-6 HPDM Gateway-Ports (ausgehender Datenverkehr) (Fortsetzung)

Receiver- Sender Empfénger Protokoll Funktion

Port
konfigurieren Sie die Firewall
entsprechend.

40001 HPDM Gateway HPDM Agent TCP Ermdglicht dem HPDM Gateway, Tasks
an den HPDM Agent zu senden

40001 HPDM Gateway HPDM Agent UDP Ermdglicht dem HPDM Agent, per
Broadcast vom HPDM Gateway
versendete Antworten zu empfangen

40005 HPDM Gateway HPDM Server TCP Ermdoglicht dem HPDM Gateway, Berichte
an den HPDM Server zu senden

40008 HPDM Gateway HPDM Gateway- TCP Ermdglicht dem HPDM Gateway, den

Controller (Loopback HPDM Gateway-Controller zu
) benachrichtigen, wenn andere Gateways

im selben Subnetz aktiv sind

50000 HPDM Gateway PColP Zero Clients TCP Ermdglicht dem HPDM Gateway, Tasks

an PColP Zero Clients zu senden

HPDM Agent Ports

Tabelle B-7 HPDM Agent-Ports (eingehender Datenverkehr)

Receiver- Sender Empféanger Protokoll Funktion
Port
68 DHCP Server HPDM Agent UDP Antworten fiir DHCP-Optionen
empfangen
68 HPDM PXE Server HPDM Imaging Mini ubP PXE-Bootstrap
(zusammen mit HPDM Linux Tool (Client-Seite)
Gateway)
5500 Windows-Plattform: Windows-Plattform: TCP SSL-VNC-Proxy im Uberwachungsmodus
VNC-Server (Client- SSL-VNC-Proxy (im (Loopback (Reverse VNC)
Seite) Verbund mit HPDM )
Agent)
5900 SSL-VNC-Proxy (im VNC-Server (Client- TCP VNC-Remotesteuerung
Verbund mit HPDM Seite) (Loopback
Console) )
40001 HPDM Gateway HPDM Agent TCP Ermdoglicht dem HPDM Gateway, Tasks
an den HPDM Agent zu senden
40001 HPDM Gateway HPDM Agent UDP Ermdglicht dem HPDM Agent, per
Broadcast vom HPDM Gateway
versendete Antworten zu empfangen
40004 SSL-VNC-Proxy (im SSL-VNC-Proxy (im TCP SSL-VNC-Proxy im Uberwachungsmodus

Verbund mit HPDM
Console)

Verbund mit HPDM
Agent)

auf dem HPDM Agent
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Tabelle B-8 HPDM Agent-Ports (ausgehender Datenverkehr)

Receiver- Sender Empfanger Protokoll Funktion
Port
20 und 21 HPDM Agent FTP-Server (Software TCP Dies sind die Standardports fur FTP (fur
eines Drittanbieters) Repositorys genutzt). Port 20 dient dem
Datentransfer und Port 21 dem
Uberwachen von Befehlen. Die FTP-Ports
kénnen uber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fir den FTP-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall
entsprechend.
22 HPDM Agent SFTP-Server (Software Dies ist der Standardport fir den SFTP-
eines Drittanbieters) Server (fir Repositorys genutzt). Der
SFTP-Port kann tber die HPDM Console
TCP konfiguriert werden. Wenn Sie in den
Einstellungen fir den SFTP-Server nicht
den Standardport verwenden,
konfigurieren Sie die Firewall
entsprechend.
67 PXE-Client (Client- HPDM PXE Server (im UDP PXE-Bootstrap
Seite) Verbund mit HPDM
Gateway)
67 HPDM Agent DHCP-Server UDP Ermaoglicht dem HPDM Agent, DHCP-
Optionsanforderungen zu versenden
69 PXE-Client (Client- HPDM PXE Server (im TFTP (Trivial File Transfer Protocol)
Seite) Verbund mit HPDM UDP
Gateway)
137 HPDM Agent NetBIOS-Namensdienst UDP Ermdoglicht NetBIOS-Namensauflésung
138 HPDM Agent NetBIOS- UDP Erméglicht Ubertragung und Empfang
Datagrammdienst von NetBIOS-Datagrammen
139 HPDM Agent NetBIOS-Sitzungsdienst TCP Ermdoglicht NetBIOS-Sitzungsdienst-
Verbindungen
445 HPDM Agent Microsoft- TCP Fir Datei- und Druckerfreigabe, um SMB-
Verzeichnisdienste Ubertragung und -Empfang {iber Named
Pipes zu ermdglichen
5500 Windows-Plattform: Windows-Plattform: TCP SSL-VNC-Viewer im
VNC-Server (Client- SSL-VNC-Proxy (im (Loopback Uberwachungsmodus (Reverse VNC)
Seite) Verbund mit HPDM )
Agent)
5900 SSL-VNC-Viewer (im VNC-Proxy (Client- TCP VNC-Remotesteuerung
Verbund mit HPDM Seite) (Loopback
Console) )
989 und 990 HPDM Console FTPS-Server (Software  TCP Dies sind die Standardports fiir FTPS (fur

eines Drittanbieters)

Repositorys genutzt). Port 989 dient dem
Datentransfer und Port 990 dem
Uberwachen von Befehlen. Die FTPS-
Ports kénnen tber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fir den FTPS-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall
entsprechend.

HPDM Agent Ports
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Tabelle B-8 HPDM Agent-Ports (ausgehender Datenverkehr) (Fortsetzung)

Receiver- Sender Empfénger Protokoll Funktion
Port
4011 PXE-Client (Client- Proxy-DHCP-Dienst uUbP Proxy-DHCP-Dienst (Alternative fiir Port
Seite) (Software eines 67, falls Port 67 nicht verfligbar ist)
Drittanbieters)
40000 HPDM Agent HPDM Gateway ubP Ermdglicht dem HPDM Agent die
periodische Abfrage des HPDM
Gateways
40003 HPDM Agent HPDM Gateway TCP Ermdglicht dem HPDM Agent, Berichte
an das HPDM Gateway zu senden
40004 Windows: SSL-VNC- SSL-VNC-Proxy (im TCP SSL-VNC-Proxy im Uberwachungsmodus
Proxy (im Verbund mit Verbund mit HPDM (Reverse VNC)
HPDM Agent); HP Console)
ThinPro: X11VNC (im
Verbund mit Plattform)
40009 HPDM Agent HPDM Server TCP Ermdglicht dem HPDM Agent,
Ressourceninformationen (CPU, RAM,
Festplatten- und Netzwerk-E/A, Prozesse
usw.) an den HPDM Server zu senden.
Der HPDM Server sendet einen ,stop
process“-Befehl an den HPDM Agent.
Tabelle B-9 Repository-Ports (eingehender Datenverkehr)
Receiver- Sender Empfénger Protokoll Funktion
Port
20x21 mm  HPDM Console FTP-Server (Software TCP Dies sind die Standardports fur FTP (fur
eines Drittanbieters) Repositorys genutzt). Port 20 dient dem
HPDM Gateway Datentransfer und Port 21 dem
HPDM Agent Uberwgphen v"on Befehlen. Die FTP-
Ports kénnen lber die HPDM Console
Master-Repository- konfiguriert werden. Wenn Sie in den
Controller Einstellungen fur den FTP-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall
entsprechend.
22 HPDM Console SFTP-Server (Software  TCP Dies ist der Standardport fir den SFTP-
eines Drittanbieters) Server (fur Repositorys genutzt). Der
HPDM Gateway SFTP-Port kann iiber die HPDM Console
HPDM Agent kgnfiguriert wetden. Wenn Sie in den.
Einstellungen fir den SFTP-Server nicht
Master-Repository- den Standardport verwenden,
Controller konfigurieren Sie die Firewall
entsprechend.
137 HPDM Console NetBIOS-Namensdienst UDP Fur die Datei- und Druckerfreigabe, um

HPDM Gateway
HPDM Agent

Master-Repository-
Controller

die NetBIOS-Namensauflésung zu
ermdglichen
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Tabelle B-9 Repository-Ports (eingehender Datenverkehr) (Fortsetzung)

Receiver- Sender Empfanger Protokoll Funktion
Port
138 HPDM Console NetBIOS- UDP Fur die Datei- und Druckerfreigabe, um
Datagrammdienst Ubertragung und Empfang von NetBIOS-
HPDM Gateway Datagrammen zu erméglichen
HPDM Agent
Master-Repository-
Controller
139 HPDM Console NetBIOS-Sitzungsdienst TCP Fir die Datei- und Druckerfreigabe, um
NetBIOS-Sitzungsdienst-Verbindungen
HPDM Gateway zu erméglichen
HPDM Agent
Master-Repository-
Controller
445 HPDM Console Microsoft- TCP Fur die Datei- und Druckerfreigabe, um
Verzeichnisdienste SMB-Ubertragung und -Empfang (iber
HPDM Gateway Named Pipes zu erméglichen
HPDM Agent
Master-Repository-
Controller
989 und 990 HPDM Console FTPS-Server (Software ~ TCP Dies sind die Standardports fur FTPS (fir
eines Drittanbieters) Repositorys genutzt). Port 989 dient dem
HPDM Gateway Datentransfer und Port 990 dem
HPDM Agent Uberwzichen an Befehlen. Die FTPS-
Ports kénnen tber die HPDM Console
Master-Repository- konfiguriert werden. Wenn Sie in den
Controller Einstellungen fir den FTPS-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall
entsprechend.
40012 HPDM Server Master-Repository- TCP Ermoglicht dem HPDM Server, zur
Controller Verwaltung des Master-Repositorys mit
dem Master-Repository-Controller zu
kommunizieren (dieser Port ist nur fir das
Master-Repository bestimmt)
Tabelle B-10 Repository-Ports (ausgehender Datenverkehr)
Receiver- Sender Empfénger Protokoll Funktion
Port
20x 21 mm  Master-Repository- FTP-Server (Software TCP Dies sind die Standardports fur FTP (fur
Controller eines Drittanbieters) Repositorys genutzt). Port 20 dient dem
Datentransfer und Port 21 dem
Uberwachen von Befehlen. Die FTP-
Ports kénnen uber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fur den FTP-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall
entsprechend.
22 Master-Repository- SFTP-Server (Software ~ TCP Dies ist der Standardport fir den SFTP-

Controller

eines Drittanbieters)

Server (fiir Repositorys genutzt). Der

Repository-Ports
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Tabelle B-10 Repository-Ports (ausgehender Datenverkehr) (Fortsetzung)

Receiver- Sender Empfanger Protokoll Funktion
Port

SFTP-Port kann tber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fir den SFTP-Server nicht
den Standardport verwenden,
konfigurieren Sie die Firewall

entsprechend.
137 Master-Repository- NetBIOS-Namensdienst UDP Fir die Datei- und Druckerfreigabe, um
Controller die NetBIOS-Namensauflésung zu
ermoglichen
138 Master-Repository- NetBIOS- UbDP Fir die Datei- und Druckerfreigabe, um
Controller Datagrammdienst Ubertragung und Empfang von NetBIOS-
Datagrammen zu ermdglichen
139 Master-Repository- NetBIOS-Sitzungsdienst TCP Fir die Datei- und Druckerfreigabe, um
Controller NetBIOS-Sitzungsdienst-Verbindungen
zu ermdglichen
445 Master-Repository- Microsoft- TCP Fir die Datei- und Druckerfreigabe, um
Controller Verzeichnisdienste SMB-Ubertragung und -Empfang (iber

Named Pipes zu ermdglichen

989 und 990 Master-Repository- FTPS-Server (Software  TCP Dies sind die Standardports fur FTPS (fur
Controller eines Drittanbieters) Repositorys genutzt). Port 989 dient dem

Datentransfer und Port 990 dem
Uberwachen von Befehlen. Die FTPS-
Ports kénnen tber die HPDM Console
konfiguriert werden. Wenn Sie in den
Einstellungen fiir den FTPS-Server nicht
die Standardports verwenden,
konfigurieren Sie die Firewall
entsprechend.
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